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Un manuel FreeCAD

1-1 Introduction
FreeCAD est une application open source (gratuite) pour la modélisation 3D paramétrique. Il est 
principalement conçu pour modéliser des objets de la vie courante, allant des petits composants électroniques
aux bâtiments et aux projets de génie civil, en mettant l'accent sur les objets imprimables en 3D. FreeCAD est 
en téléchargement libre, ainsi que son utilisation, sa distribution et toute modification et son code source est 
ouvert et publié sous la licence LGPL très permissive. Les données que vous produisez avec FreeCAD sont 
entièrement à vous et peuvent être récupérées sans FreeCAD.

FreeCAD est également fondamentalement un projet social, car il est développé et maintenu par une 
communauté de développeurs et d'utilisateurs unis par leur passion pour FreeCAD.

Ce manuel est une expérience consistant à prendre la voie inverse du wiki officiel de la documentation 
FreeCAD (official FreeCAD documentation wiki). Le wiki est écrit en collaboration par des dizaines de 
membres de la communauté et, comme la plupart des wikis, il contient d'énormes quantités d'informations, 
mais il est très difficile d'accès et de navigation par les nouveaux arrivants. Cela en fait une ressource 
précieuse à titre de référence, mais pas un outil très pratique pour apprendre FreeCAD. Ce manuel vous 
guidera à travers les mêmes informations disponibles sur le wiki. Cependant, nous espérons que le rythme 
plus progressif, basé sur les exemples, et le ton plus unifié donné par un nombre plus restreint d'auteurs, le 
rendra plus approprié pour un premier contact avec FreeCAD et qu'il deviendra un parfait compagnon pour le 
wiki.

Ce manuel a été écrit pour la version stable actuelle de FreeCAD qui est la version 0.16.

Tout le contenu de ce manuel est publié sous la licence Creative Commons 4.0 et peut être utilisé, téléchargé, 
copié et modifié de manière libre. Les fichiers source de ce manuel sont hébergés sur ce wiki et sur le compte 
original du github utilisé pour écrirela première version de ce livre. Plus faciles à lire, les versions HTML, PDF, 
MOBI et EPUB sont disponibles sur GitBook. Une version imprimée est en préparation.

Ce livre a été écrit principalement par Yorik, mais en utilisant beaucoup d'informations construites par les 
utilisateurs de FreeCAD, principalement du wiki FreeCAD. Le véritable auteur de ce livre est en fait toute la 
communauté FreeCAD !
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1-2 Découverte de FreeCad

1-2-1 Qu'est-ce que FreeCAD?

FreeCAD est une application open source de modélisation 3D paramétrique, conçue principalement pour 
concevoir des objets de la vie courante. La modélisation paramétrique décrit un certain type de modélisation, 
où la forme des objets 3D que vous concevez est contrôlée par des paramètres. Par exemple, la forme d'une 
brique peut être contrôlée par trois paramètres: hauteur, largeur et longueur. Dans FreeCAD, comme dans 
d'autres modeleurs paramétriques, ces paramètres font partie de l'objet et restent modifiables à tout moment 
après la création de l'objet. Certains objets peuvent avoir d'autres objets comme paramètres, par exemple, 
vous pourriez avoir un objet qui prend notre brique comme entrée et crée une colonne à partir de celle-ci. 
Vous pouvez voir un objet paramétrique comme un petit programme qui crée les géométries voulues à partir 
de paramètres.

FreeCAD n'est pas conçu pour un type de travail particulier ou pour créer un certain type d'objets. Au lieu de 
cela, il permet une large gamme d'utilisations, et permet aux utilisateurs de produire des modèles de toutes les
tailles et de tous les objets, depuis les petits composants électroniques jusqu'aux pièces imprimables en 3D et
jusqu'aux bâtiments. Chacune de ces tâches comporte différents ensembles dédiés d'outils et de flux de 
travail disponibles.

FreeCAD est également multiplateforme (il fonctionne exactement de la même manière sur les plates-formes 
Windows, Mac OS et Linux) et open-source. Étant open-source, FreeCAD bénéficie des contributions et des 
efforts d'une grande communauté de programmeurs, amateurs et utilisateurs du monde entier. FreeCAD est 
essentiellement une application créée par les personnes qui l'utilisent, au lieu d'être créée par une entreprise 
qui tente de vous vendre un produit. Et bien sûr, cela signifie également que FreeCAD est gratuit, non 
seulement pour l'utilisation, mais aussi pour distribuer, copier, modifier ou même vendre.
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FreeCAD bénéficie également de l'expérience énorme accumulée par le monde open-source. Dans ses 
entrailles, plusieurs autres composants du monde open-source sont utilisés, car FreeCAD lui-même peut être 
utilisé comme composant dans d'autres applications. Il possède également toutes sortes de fonctionnalités qui
sont devenues une norme dans le monde open-source, telles que le support d'une large gamme de formats de
fichiers, extrêmement scriptables, personnalisables et modifiables. Tout est possible grâce à une communauté
d'utilisateurs dynamique et enthousiaste.

Le site officiel de FreeCAD se trouve à http://www.freecadweb.org 

Lire plus d'informations:

• À propos de FreeCAD: http://www.freecadweb.org/wiki/index.php?title=About_FreeCAD 

• Liste des fonctionnalités: http://www.freecadweb.org/wiki/index.php?title=Feature_list 

• Captures d'écran et exemples d'utilisateurs: http://forum.freecadweb.org/viewforum.php?f=24
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1-2-2 Installation
FreeCAD utilise la licence LGPL, ce qui vous permet de télécharger, installer, redistribuer et utiliser FreeCAD 
comme vous le souhaitez, quel que soit le type de travail que vous allez faire avec (commercial ou non 
commercial). Vous n'êtes lié à aucune clause ou restriction, et les fichiers que vous produirez avec sont 
entièrement à vous. La seule chose que la licence interdit, en réalité, est de prétendre que vous avez 
programmé FreeCAD vous-même !

FreeCAD fonctionne sans aucune différence sur Windows, Mac OS et Linux. Cependant, les méthodes 
d'installation diffèrent légèrement selon votre plate-forme. Sur Windows et Mac, la communauté FreeCAD 
fournit des paquets précompilés (installeurs) prêts à télécharger, alors que sous Linux, le code source est mis 
à la disposition des responsables de distribution de Linux, qui sont responsables de l'emballage de FreeCAD 
pour leur distribution spécifique. Par conséquent, sur Linux, vous pouvez généralement installer FreeCAD 
directement à partir de l'application du gestionnaire de logiciels.

La page de téléchargement officielle de FreeCAD pour Windows et Mac OS est  
https://github.com/FreeCAD/FreeCAD/releases 

Versions de FreeCAD

Les versions officielles de FreeCAD, que vous pouvez trouver sur la page ci-dessus et dans le gestionnaire de
logiciels de votre distribution, sont des versions stables. Cependant, le développement de FreeCAD est 
rapide! Les nouvelles fonctionnalités et les corrections de bogues sont ajoutées presque tous les jours. 
Puisque cela peut parfois prendre beaucoup de temps entre les versions stables, vous pourriez être intéressé 
par essayer une version plus efficace de FreeCAD. Ces versions de développement, ou pré-versions, sont 
mises à disposition de temps en temps vers la page de téléchargement mentionnée ci-dessus (download page
) ou, si vous utilisez Ubuntu, la communauté FreeCAD gère également PPA (Personal Package Archives) ou 
«builds quotidiens» régulièrement mis à jour avec les changements les plus récents.

Si vous installez FreeCAD dans une machine virtuelle, sachez que la performance peut être faible ou, dans 
certains cas, inutilisable en raison des limites du support OpenGL sur la plupart des machines virtuelles.

1-2-2-1 Installation sur Windows
1.  Téléchargez un package d'installation (.exe) correspondant à votre version de Windows (32 bits ou 64 

bits) à partir de la page de téléchargement (download page). Les installeurs FreeCAD devraient 
fonctionner sur n'importe quelle version à partir de Windows 7.

2.  Double-cliquez sur le programme d'installation téléchargé.

3.  Acceptez les termes de la licence LGPL (ce sera l'un des rares cas où vous pouvez vraiment cliquer 
sur le bouton "accepter" sans lire le texte. Pas de clauses cachées) :
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4. Vous pouvez laisser ici le chemin par défaut ou le modifier si vous le souhaitez:

06/06/17 Manuel_Freecad.odt Page 8 / 166



5. Il n'est pas nécessaire de définir la variable PYTHONPATH, sauf si vous prévoyez faire des 
améliorations en programmation Python, dans ce cas, vous savez probablement déjà pourquoi :

6. Pendant l'installation, un certain nombre de composants supplémentaires, qui sont regroupés à 
l'intérieur de l’installeur, sera installé aussi :
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7. Ça y est, FreeCAD est installé. Vous le trouverez dans votre menu de démarrage.
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Installation d'une version de développement

La réalisation du package FreeCAD et la création d'un installeur prend du temps et du dévouement, de sorte 
que les versions de développement (également appelées pré-versions) sont fournies sous forme d'archives 
.zip (ou .7z). Celles-ci n'ont pas besoin d'être installées, il suffit de les décompresser et de lancer FreeCAD en 
double-cliquant sur le fichier FreeCAD.exe que vous trouverez à l'intérieur. Cela vous permet également de 
conserver à la fois les versions stable et "instable" sur le même ordinateur.

1-2-2-2 Installation sur Linux
Sur la plupart des distributions Linux modernes (Ubuntu, Fedora, OpenSUSE, Debian, Mint, Elementary, etc.), 
FreeCAD peut être installé en un bouton, directement à partir de l'application de gestion de logiciels fournie 
par votre distribution (l'aspect peut différer des images ci-dessous, chaque distribution utilise son propre outil).

1. Ouvrez le gestionnaire de logiciels et recherchez "freecad":

2. Cliquez sur le bouton "installer" et c'est tout, FreeCAD s’installe. N'oubliez pas de noter ensuite!
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Modes alternatifs

L'une des grandes joies de l'utilisation de Linux est la multitude de possibilités d'adapter votre logiciel, ne vous
en privez donc pas. Sur Ubuntu et les dérivés, FreeCAD peut également être installé à partir d'un PPA 
maintenu par la communauté FreeCAD (il contient des versions stables et de développement) et, comme il 
s'agit de logiciels open-source, vous pouvez également compiler FreeCAD vous-même (compile FreeCAD 
yourself).

1-2-2-3 Installation sur Mac OS
L'installation de FreeCAD sur Mac OSX est aujourd'hui aussi simple que sur d'autres plates-formes. 
Cependant, étant donné qu'il y a moins de gens dans la communauté qui possèdent un Mac, les paquets 
disponibles sont souvent en retrait de quelques versions derrière les autres plates-formes.

1. Téléchargez un package compressé correspondant à votre version à partir de la page de 
téléchargement (download page).

2. Ouvrez le dossier Téléchargements et développez le fichier zip téléchargé:
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3. Faites glisser l'application FreeCAD de l'intérieur du zip vers le dossier Applications :

4. Ça y est, FreeCAD est installé !
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5. Si le système empêche FreeCAD de se lancer, en raison des autorisations restreintes pour les 
applications ne provenant pas de l'App Store, vous devrez l'activer dans les paramètres du système :
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1-2-2-4 Désinstallation
J'espère que vous ne voudrez pas le faire, mais il est bon de le savoir de toute façon. Sur Windows et Linux, 
la désinstallation de FreeCAD est très simple. Utilisez l'option "supprimer logiciel" standard qui se trouve dans 
le panneau de contrôle sur Windows, ou supprimez-le avec le même gestionnaire de logiciels que vous avez 
utilisé pour installer FreeCAD sur Linux. Sur Mac, tout ce que vous devez faire est de l'enlever du dossier 
Applications.

1-2-2-5 Définir les préférences de base
Une fois que FreeCAD est installé, vous voudrez peut-être l'ouvrir et définir quelques préférences.

Les paramètres de préférences dans FreeCAD se trouvent sous menu Edit -> Preferences. Vous pouvez 
parcourir les différentes pages pour voir s'il y a autre chose que vous voudriez changer, mais voici quelques 
éléments fondamentaux :

1. Langue : FreeCAD choisira automatiquement la langue de votre système d'exploitation, mais vous 
pourriez vouloir changer cela. FreeCAD est presque entièrement traduit en 5 ou 6 langues, plus 
beaucoup d'autres qui ne sont actuellement traduites que partiellement. Vous pouvez facilement aider 
à traduire FreeCAD (help to translate FreeCAD).
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2. Module de chargement automatique : Normalement, FreeCAD commencera en vous montrant la 
page centrale de démarrage. Vous pouvez la sauter et commencer une session FreeCAD directement 
dans l'atelier de votre choix. Les ateliers (Workbenches) seront expliqués en détail dans le chapitre 
suivant.

3. Créer un document au démarrage : combiné à l'option ci-dessus, cela démarre FreeCAD prêt à 
travailler.
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4. Options de stockage : en tant qu'application complexe, FreeCAD risque d'être interrompu de temps à 
autre. Ici, vous pouvez configurer quelques options qui vous aideront à récupérer votre travail en cas 
de crash.

5. Autorisation et licence : vous pouvez définir les paramètres par défaut qui seront utilisés pour votre 
nouveau dossiers. Envisagez de rendre vos fichiers partageables directement depuis le début, en 
utilisant une licence plus amicale de copyleft comme Creative Commons.

6. Rediriger les messages Python vers la sortie : ces deux options sont toujours bonnes à cocher, car 
elles vous permettront de voir ce qui ne va pas dans le rapport de fonctionnement quand il y a un 
problème avec l'exécution d'un script python particulier.
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7. Unités : Ici, vous pouvez définir le système d'unités par défaut que vous souhaitez utiliser.
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1-2-2-6 Installation de contenu supplémentaire
À mesure que le projet FreeCAD et sa communauté augmentent rapidement, et aussi parce qu'il est facile à 
étendre, les contributions externes et les projets parallèles réalisés par les membres de la communauté et les 
autres amateurs commencent à apparaître partout sur Internet. Cela demande un effort pour rassembler tous 
ces ajouts intéressants dans un seul endroit, sur la FreeCAD github page. Là, entre autres choses, vous 
trouverez :

1. Une bibliothèque de pièces (Parts library), qui contient toutes sortes de modèles utiles, ou des 
modèles créés par des utilisateurs FreeCAD qui peuvent être utilisés gratuitement dans vos projets. La
bibliothèque peut être utilisée et est accessible directement depuis votre installation FreeCAD.

2. Une collection de greffons (collection of addons), la plupart des ateliers supplémentaires, qui étendent 
la fonctionnalité de FreeCAD pour certaines tâches. Les instructions d'installation sont fournies sur 
chaque page complémentaire.

3. Une collection de macros (collection of macros), qui sont également disponibles sur le wiki FreeCAD 
(the FreeCAD wiki) ainsi que des informations sur la façon de les utiliser. Le wiki contient beaucoup 
plus de macros.

Si vous utilisez Ubuntu ou l'un de ses dérivés, le PPA FreeCAD-extras contient la plupart de ces addons. Sur 
d'autres plates-formes, n’importe quel addon, y compris la bibliothèque de pièces, peut être facilement installé 
à l'aide d'une macro addon-installer fournie dans le dépôt addons. La procédure suivante montre comment 
installer l'addon-installer (d'autres macros peuvent être installées de la même manière) :

1. Téléchargez le fichier addons-installer.FCMacro à partir de https://github.com/FreeCAD/FreeCAD-
addons en cliquant dessus, puis en cliquant avec le bouton droit sur le bouton "RAW" et en choisissant
"Enregistrer sous".

2. Placez la macro dans votre dossier de destination FreeCAD Macros. Le chemin de destination de 
FreeCAD Macros est indiqué au bas de la boîte de dialogue de Exécuter macro dans FreeCAD :
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3. Fermez et réouvrez la boîte de dialogue Exécuter macro, puis démarrez Addons_installer.FCMacro.
Le programme d'installation démarrera, d'où vous pourrez installer, mettre à jour et désinstaller tous les
addons :
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Lire plus d'informations

• Plus d'options de téléchargement: http://www.freecadweb.org/wiki/index.php?title=Download 

• Instructions détaillées d'installation: http://www.freecadweb.org/wiki/index.php?Title=Installation 

• FreeCAD PPA pour Ubuntu: https://launchpad.net/~freecad-maintainers 

• FreeCAD addons PPA pour Ubuntu: https://launchpad.net/freecad-extras 

• Compilez FreeCAD vous-même: http://www.freecadweb.org/wiki/index.php?title=Compiling 

• Traductions FreeCAD: https://crowdin.com/project/freecad 

• Page du github FreeCAD: https://github.com/FreeCAD 
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1-2-3 L'interface FreeCAD
FreeCAD utilise le framework Qt (Qt framework) pour dessiner et gérer son interface. Ce cadre est utilisé dans
un large éventail d'applications, et l'interface FreeCAD est alors très classique et ne présente pas de difficulté 
particulière à comprendre. La plupart des boutons sont standard et vous les trouverez où vous les attendez 
(Fichier -> Ouvrir, Modifier -> Coller, etc.). Voici l'apparence de FreeCAD lorsque vous l’ouvrez pour la 
première fois, juste après l'installation, qui vous montrera le centre de démarrage :

Le centre de démarrage est un «écran de bienvenue» pratique, qui présente des informations utiles pour les 
nouveaux arrivants, comme les derniers fichiers sur lesquels vous avez travaillé, les nouveautés du Monde 
FreeCAD, ou des informations rapides sur les ateliers les plus courants. Il vous informera également si une 
nouvelle version stable de FreeCAD est disponible.

Mais après un certain temps, ou après avoir fait quelques changements dans les préférences, vous allez 
beaucoup plus probablement vous trouver directement dans l'un des autres ateliers, avec un nouveau 
document ouvert. Ou tout simplement, fermez l'onglet de la page de démarrage et créez un nouveau 
document :
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1-2-3-1 Les ateliers.
Notez que certaines des icônes ont changé entre les deux captures d'écran ci-dessus. C'est là où le concept 
le plus important utilisé dans l'interface FreeCAD entre en jeu : les  ateliers.

Les ateliers sont un groupe d'outils (boutons de barre d'outils, menus et autres contrôles d'interface) qui sont 
regroupés par spécialité. Pensez à un atelier où vous avez différentes personnes travaillant ensemble : une 
personne qui travaille avec du métal, une autre avec du bois. Chacun d'eux a, en son atelier, une table 
séparée avec des outils spécifiques pour son travail. Cependant, ils peuvent tous travailler sur les mêmes 
objets. Il en va de même dans FreeCAD.

Le contrôle le plus important de l'interface FreeCAD est le sélecteur d’atelier (Workbench), que vous utilisez 
pour passer d'un atelier à l'autre :

Les ateliers perturbent souvent les nouveaux utilisateurs, car il n'est pas toujours facile de savoir dans lequel 
rechercher un outil spécifique. Mais ils apprennent rapidement, et après peu de temps, ressentent le contexte 
- en réalisant un moyen pratique d'organiser la multitude d'outils que FreeCAD offre, et ils sont également 
entièrement personnalisables (voir ci-dessous).

Plus loin dans ce manuel, vous trouverez également un tableau montrant le contenu de tous les ateliers.
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1-2-3-2 L'interface
Regardons mieux les différentes parties de l'interface :

• La vue 3D est le composant principal de l'interface. Il peut être désactivé hors de la fenêtre principale, 
vous pouvez avoir plusieurs vues du même document (ou des mêmes objets), ou plusieurs documents
ouverts en même temps. Vous pouvez sélectionner des objets ou des parties d'objets en cliquant 
dessus, et vous pouvez obtenir une vue panoramique, zoomer et faire pivoter la vue avec les boutons 
de la souris. Cela sera expliqué plus avant dans le prochain chapitre.

• La vue combinée comporte deux onglets :

◦ L'onglet Modèle vous montre le contenu et la structure de votre document ci-dessus et les 
propriétés (ou les paramètres) des objets sélectionnés ci-dessous. Ces propriétés sont séparées 
en deux catégories :

▪ Données (propriétés qui concernent la géométrie elle-même)

▪ Affichage (propriétés qui affectent la façon dont la géométrie ressemble à l'écran).

◦ L'onglet Tâches est l'endroit où FreeCAD vous demandera des valeurs spécifiques à l'outil que 
vous utilisez à cet instant, par exemple, en entrant une valeur «longueur» lorsque l'outil Ligne est 
utilisé. Il se ferme automatiquement après avoir appuyé sur le bouton OK (ou Annuler). De plus, en 
double-cliquant sur l'objet associé dans la vue combinée, la plupart des outils vous permettront de 
rouvrir ce panneau de tâches afin de modifier les paramètres.
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• L'affichage du rapport est normalement caché, mais il est judicieux de le laisser ouvert, car il 
énumérera toute information, avertissement ou erreur pour vous aider à déchiffrer (ou à déboguer) ce 
que vous avez mal fait.

• La console Python est également cachée par défaut. C'est là que vous pouvez interagir avec le 
contenu du document à l'aide du langage Python (Python language). Étant donné que chaque action 
que vous faites sur l'interface FreeCAD exécute effectivement un morceau de code Python, l'ouverture 
de cette console vous permet de regarder le code se déployer en temps réel, ce qui vous permet de 
découvrir un peu Python sur votre chemin, presque sans le remarquer.

N’importe lequel des panneaux ci-dessus peut être activé / désactivé à partir du menu Affichage -> Panneaux.
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1-2-3-3 Personnalisation de l'interface
L'interface de FreeCAD est profondément personnalisable. Tous les panneaux et barres d'outils peuvent être 
déplacés vers différents endroits ou empilés l'un sur l'autre. Ils peuvent également être fermés et rouverts 
quand c’est nécessaire dans le menu Affichage ou en cliquant avec le bouton droit de la souris sur une zone 
vide de l'interface. Il y a, cependant, beaucoup d'autres options disponibles, telles que la création de barres 
d'outils personnalisées avec des outils à partir de n'importe quel atelier, ou l’affectation et la modification des 
raccourcis clavier.

Ces options de personnalisation avancées sont disponibles à partir du menu Outils -> Personnaliser :

Lire plus d'informations

• Pour commencer avec FreeCAD: http://www.freecadweb.org/wiki/index.php?Title=Getting_started 

• Personnalisation de l'interface: http://www.freecadweb.org/wiki/index.php?
Title=Interface_Customization 

• Ateliers: http://www.freecadweb.org/wiki/index.php?title=ateliers 

• En savoir plus sur Python: https://www.python.org
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1-2-4 Navigation dans la vue 3D

1-2-4-1 Un mot sur l'espace 3D
Si c'est votre premier contact avec une application 3D, vous devrez d'abord saisir certains concepts. Sinon, 
vous pouvez ignorer cette section en toute sécurité.

L'espace FreeCAD 3D est un espace euclidien (euclidian space). Il a un point d'origine et trois axes: X, Y et Z. 
Si vous regardez votre scène d'en haut, de manière conventionnelle, l'axe X pointe vers la droite, l’axe Y vers 
l'arrière, et l'axe Z vers le haut. Dans le coin inférieur droit de la vue FreeCAD, vous pouvez toujours voir d'où 
vous regardez la scène : 

Chaque point de chaque objet qui existe dans cet espace peut être situé par ses coordonnées (x, y, z).

Par exemple, un point avec des coordonnées (2, 3, 1) se situera à 2 unités sur l'axe X, 3 unités sur l'axe Y et 1
unité sur l'axe Z :

Vous pouvez regarder cette scène sous n'importe quel angle, comme si vous teniez une caméra. Cette 
caméra peut être déplacée à gauche, à droite, en haut et en bas (pan), tourné autour de ce que vous regardez
(tourner) et vous rapprocher ou plus loin de la scène (zoom).

1-2-4-2 La vue 3D FreeCAD 
La navigation dans la vue FreeCAD 3D peut se faire avec une souris, un périphérique Navigateur Spacial, le 
clavier, un pavé tactile ou une combinaison de ceux-ci. FreeCAD propose plusieurs modes de navigation 
(navigation modes), qui déterminent comment les trois opérations de manipulation de la vue de base (pan, 
rotation et zoom) sont effectuées, ainsi que la façon de sélectionner des objets sur l'écran. Les modes de 
navigation sont accessibles à partir de l'écran Préférences, ou directement en cliquant avec le bouton droit 
n'importe où sur la vue en 3D :
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Chacun de ces modes attribue différents boutons de souris, ou souris + combinaison de clavier, ou des gestes
de souris, à ces quatre opérations. Le tableau suivant montre les principaux modes disponibles :

Mode Panoramique Rotation Zoom Sélection

Inventor
1

2

CTRL + 

CAD (default)
1

2

Blender

SHIFT + 

Touchpad

SHIFT + ALT + 

PGUP / PGDOWN

Geste

+ DRAG + DRAG
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Alternativement, certaines commandes de clavier sont toujours disponibles, quel que soit le mode de 
navigation :

• CTRL + et CTRL - pour zoom avant et zoom arrière

• Les touches fléchées pour déplacer la vue vers la gauche / vers la droite et vers le haut / vers le bas

• SHIFT + flèche gauche et SHIFT + flèche droite pour faire pivoter la vue de 90 degrés

• Les touches numériques, 1 à 6, pour les six vues standard, haut, avant, droite, bas, arrière et gauche

• O mettra la caméra en mode orthographique,

• Tandis que P mettra la caméra en mode en perspective.

• CTRL vous permettra de sélectionner plus d'un objet ou élément

Ces contrôles sont également disponibles dans le menu Affichage et certains dans la barre d'outils Affichage.

1-2-4-3 Sélection d'objets
Les objets dans la vue 3D peuvent être sélectionnés en cliquant dessus avec le bouton de la souris 
correspondant, en fonction du mode de navigation. Un seul clic sélectionnera l'objet, et l'un de ses sous-
composantes (arête, face, sommet). Double-cliquer sélectionnera l'objet, et tout ses sous-composants. Vous 
pouvez sélectionner plus d'un sous-composant, voire différents sous-composants de différents objets, en 
appuyant sur la touche CTRL. Cliquer avec le bouton de sélection sur une partie vide de la vue 3D 
désélectionnera tout.

Un panneau appelé "Sélection de Vue", disponible dans le menu Affichage, peut également être activé, ce qui 
vous montre ce qui est actuellement sélectionné :

Vous pouvez également utiliser la sélection de vue pour sélectionner des objets en recherchant un objet 
particulier.

Lire plus d'informations

• Les modes de navigation FreeCAD: http://www.freecadweb.org/wiki/index.php?Title=Mouse_Model 
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1-2-5 Le document FreeCAD
Un document FreeCAD contient tous les objets de votre scène. Il peut contenir des groupes et des objets 
construits avec n'importe quel atelier. Vous pouvez donc basculer entre les ateliers et travailler toujours sur le 
même document et / ou objets dans ce document. Le document est ce qui est enregistré sur le disque lorsque 
vous enregistrez votre travail. Vous pouvez également ouvrir plusieurs documents en même temps dans 
FreeCAD et ouvrir plusieurs vues du même document.

À l'intérieur du document, les objets peuvent être déplacés en groupes et ont un nom unique. La gestion des 
groupes, des objets et des noms d'objets se fait principalement à partir de l'arborescence. Là, vous pouvez 
créer des groupes, déplacer des objets vers des groupes, supprimer des objets ou des groupes. En cliquant 
avec le bouton droit de la souris dans la vue arborescente ou sur un objet, vous pouvez renommer des objets, 
modifier leur couleur, les cacher ou les afficher, ou éventuellement réaliser d'autres opérations, selon l'atelier 
du moment.
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Les objets dans un document FreeCAD peuvent être de différents types. Chaque atelier peut ajouter ses 
propres types d'objets, par exemple, l'atelier Mesh (Mesh Workbench) ajoute des objets maillés, l’atelier Part 
(Part Workbench) ajoute des objets pièces, etc.

S'il y a au moins un document ouvert dans FreeCAD, il existe toujours un seul et unique document. C'est le 
document qui apparaît dans la vue en 3D du moment, le document sur lequel vous êtes actuellement en train 
de travailler. Si vous changez d'onglet sur un autre document, celui-ci devient le document actif. La plupart des
opérations fonctionnent toujours sur le document actif.

Les documents FreeCAD sont enregistrés avec l'extension .FcStd, qui est un composé à base de format zip, 
similaire à LibreOffice. Si quelque chose va très mal, il est souvent possible de le décompresser et de 
résoudre le problème ou de sauver les données.

Lire plus d'informations

• Le document FreeCAD: http://www.freecadweb.org/wiki/index.php?Title=Document_structure 

• Le format de fichier FcStd: http://www.freecadweb.org/wiki/index.php?Title=File_Format_FCStd
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1-2-6 Objets paramétriques
FreeCAD est conçu pour la modélisation paramétrique. Cela signifie que la géométrie que vous créez, au lieu 
d'être librement constructible, est produite par des règles et des paramètres. Par exemple, un cylindre pourrait
être produit à partir d'un rayon et d'une hauteur. Avec ces deux paramètres, le programme contient 
suffisamment d'informations pour construire le cylindre.

Les objets paramétriques, dans FreeCAD, sont en réalité de petits morceaux d'un programme qui fonctionnent
chaque fois que l'un des paramètres a changé. Les objets peuvent avoir beaucoup de types de paramètres 
différents  : des nombres (nombres entiers comme 1, 2, 3 ou à virgule flottante comme 3.1416), des tailles 
réelles (1m m, 2.4m, 4.5ft), des coordonnées (x, y, z), des chaînes de texte ("hello!") ou même d’autres objets.

Ce dernier type permet de créer rapidement des chaînes d'opérations complexes, chaque nouvel objet étant 
basé sur un précédent, et en ajoutant de nouvelles fonctionnalités.

Dans l'exemple ci-dessous, un objet parallélipipédique solide (Pad) est basé sur une forme 2D rectangulaire 
(Sketch ou esquisse) et a une longueur d'extrusion. Avec ces deux propriétés, il produit une forme solide en 
extrudant la forme de base par la distance donnée. Vous pouvez alors utiliser cet objet comme base pour 
d'autres opérations, comme le dessin d'une nouvelle forme 2D sur l'une de ses faces (Sketch001) et puis faire 
une soustraction (Pocket), jusqu'à ce que vous arriviez à votre objet final.

Toutes les opérations intermédiaires (formes 2D, pad, poche, etc.) sont toujours là, et vous pouvez toujours 
modifier n'importe lequel de leurs paramètres à tout moment. Toute la chaîne sera reconstruite (recalculée) 
chaque fois que cela s'avère nécessaire.
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Il est nécessaire de savoir deux choses importantes :

1.  Le recalcul n'est pas toujours automatique. Les opérations lourdes, qui pourraient modifier une grande
partie de votre document, et donc prendre un certain temps, ne sont pas exécutées automatiquement. 
Au lieu de cela, l'objet (et tous les objets qui en dépendent) seront marqués pour le recalcul (une petite
icône bleue apparaît sur eux dans l'arborescence). Vous devez alors appuyer sur le bouton de recalcul 
pour que tous les objets marqués soient recalculés.

2.  L'arbre de dépendance doit toujours circuler dans la même direction. Les boucles sont interdites. Vous
pouvez avoir l'objet A qui dépend de l'objet B qui dépend de l'objet C. Mais vous ne pouvez pas avoir 
l'objet A qui dépend de l'objet B qui dépend de l'objet A. Cela serait une dépendance circulaire. 
Cependant, vous pouvez avoir beaucoup d'objets qui dépendent du même objet, par exemple, les 
objets B et C dépendent tous deux de A. Le menu outil → graphique de dépendance vous montre un
diagramme de dépendance comme sur l'image ci-dessus. Ça peut être utile pour détecter les 
problèmes.

Tous les objets ne sont pas paramétriques dans FreeCAD. Souvent, les géométries que vous importez 
d'autres fichiers ne contiennent aucun paramètre et seront des objets simples et non paramétriques. 
Cependant, ceux-ci peuvent souvent être utilisés comme base ou point de départ pour les objets 
paramétriques nouvellement créés, en fonction, bien sûr, de ce que requiert l'objet paramétrique, et de la 
qualité de la géométrie importée.

Tous les objets, cependant, paramétriques ou non, auront quelques paramètres de base, comme un Nom, qui 
est unique dans le document et ne peut pas être édité, un label, qui est un nom défini par l’utilisateur et qui 
peut être édité, et un emplacement (placement) qui définit sa position dans l'espace 3D.

Enfin, il convient de noter que les objets paramétriques personnalisés sont faciles à programmer en python 
(easy to program in python).

Lire plus d'informations

• L'éditeur de propriétés: http://www.freecadweb.org/wiki/index.php?title=Property_editor 

• Comment programmer des objets paramétriques: http://www.freecadweb.org/wiki/index.php?
Title=Scripted_objects 

• Positionner les objets dans FreeCAD: http://www.freecadweb.org/wiki/index.php?Title=Placement 

• Activation du graphe de dépendance: http://www.freecadweb.org/wiki/index.php?
Title=Std_DependencyGraph 
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1-2-7 Importer et exporter vers d'autres types de fichiers
FreeCAD peut importer et exporter vers plusieurs types de fichiers. Voici une liste des plus importants avec 
une brève description des caractéristiques disponibles :

Format Import Export Notes

STEP Oui Oui
C'est le format d'importation / exportation le plus fidèle disponible, car il
supporte la géométrie solide et NURBS. Utilisez le chaque fois que 
cela est possible.

IGES Oui Oui
Un format solide ancien, également très bien pris en charge. Certaines
anciennes applications ne supportent pas STEP mais supportent 
IGES.

BREP Oui Oui Le format natif d'OpenCasCade, le noyau de géométrie FreeCAD.

DXF Oui Oui

Un format ouvert maintenu par Autodesk. Depuis la 3D les données 
contenues dans un fichier DXF sont encodées dans un format 
propriétaire, FreeCAD ne peut importer / exporter que des données 2D
à partir de ce format.

DWG Oui Oui
La version propriétaire de DXF. Nécessite l’installation de l'utilitaire 

Teigha File Converter. Ce format souffre des mêmes limitations que 
DXF.

OBJ Oui Oui

Un format basé sur un maillage. Ne peut contenir que des mailles 
triangulaires. Tous les objets solides et basés sur NURBS de FreeCAD
seront convertis en maillage à l'exportation. Un exportateur alternatif 
est fourni par l'atelier Arch, plus adapté à l'exportation des modèles 
d'architecture.

DAE Oui Oui

Le format principal d'importation / exportation de Sketchup. Peut 
seulement contenir des mailles triangulaires. Tous les objets solides et 
basés sur NURBS de FreeCAD seront convertis en maillage à 
l'exportation.

STL Oui Oui

Un format basé sur un maillage, couramment utilisé pour l'impression 
en 3D. Peut seulement contenir des mailles triangulaires. Tous les 
objets solides et basés sur NURBS de FreeCAD seront convertis en 
maillage à l'exportation.

PLY Oui Oui
Un ancien format de maillage. Peut seulement contenir des mailles 
triangulaires. Tous les objets solides et basés sur NURBS de FreeCAD
seront convertis en maillage à l'exportation.

IFC Oui Oui
Industry Foundation Classes. Nécessite l'installation de IfcOpenShell-
python. Le format IFC et sa compatibilité avec d'autres applications est
une affaire complexe, à utiliser avec précaution.

SVG Oui Oui Un excellent format graphique 2D

VRML Oui Oui Un format Web assez ancien.
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GCODE Oui Oui
FreeCAD peut déjà importer et exporter vers / depuis plusieurs 
variantes de GCode, mais seulement un petit nombre de machines 
sont actuellement prises en charge.

CSG Oui Non Format CSG d'OpenSCAD (géométrie constructive de solides).

Certains de ces formats de fichiers ont des options. Celles-ci peuvent être configurées à partir du menu 
Édition ->Préférences -> Importer / exporter :

Lire plus d'informations

• Tous les formats de fichiers pris en charge par FreeCAD: http://www.freecadweb.org/wiki/index.php?
Title=Import_Export 

• Travailler avec des fichiers DXF dans FreeCAD: http://www.freecadweb.org/wiki/index.php?
Title=Draft_DXF 

• Activation du support DXF et DWG: http://www.freecadweb.org/wiki/index.php?
Title=Dxf_Importer_Install 

• Travailler avec des fichiers SVG dans FreeCAD: http://www.freecadweb.org/wiki/index.php?
Title=Draft_SVG 

• Importation et exportation vers IFC: http://www.freecadweb.org/wiki/index.php?Title=Arch_IFC 
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• OpenCasCade: http://www.opencascade.com 

• Teigha File Converter: https://www.opendesign.com/guestfiles 

• Le format IFC: http://www.buildingsmart-tech.org/ifc/IFC4/final/html/index.htm 

• IfcOpenShell: http://ifcopenshell.org/ 
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1-3 Travailler avec FreeCAD

1-3-1 Un coup d'œil sur les différents ateliers de travail
L'une des plus grandes difficultés pour les nouveaux utilisateurs de FreeCAD est de savoir dans quel atelier 
trouver un outil spécifique. Le tableau ci-dessous vous donnera un aperçu des ateliers les plus importants et 
leurs outils. Reportez-vous à chaque page atelier dans la documentation FreeCAD pour une liste complète 
d'informations.

Quatre ateliers sont également conçus pour travailler par paires, et l'un d'entre eux est entièrement inclus 
dans l'autre : Arch contient tous les outils Draft, et PartDesign tous les outils Sketcher. Cependant, pour plus 
de clarté, ils sont séparés ci-dessous.

Part

L’atelier Part fournit des outils de base pour travailler avec des pièces solides : primitives, telles que cube et 
sphère, des opérations géométriques simples et des opérations booléennes. Êtant le principal point d'ancrage 
avec OpenCasCade, l’atelier Part fournit la base du système de géométrie de FreeCAD, et presque tous les 
autres ateliers produisent une géométrie partielle.

Outil Description Outil Description

Boîte

Dessine une boîte en spécifiant ses 
dimensions

Cône

Dessine un cône en spécifiant ses 
dimensions

Cylindre

Dessine un cylindre en spécifiant ses 
dimensions

Sphère

Dessine une sphère en spécifiant ses 
dimensions

Tore

Dessine un tore (anneau) en spécifiant 
ses dimensions Créer

primitives

Outil pour créer différentes primitives 
géométriques paramétriques

Créer formes

Outil pour créer des formes complexes,
à partir de plusieurs primitives 
géométriques paramétriques Union

Fusionne (additionne) deux objets

Intersection

Extrait la partie commune (Intersection)
de deux solides

Soustraction

Soustrait un objet à un autre

Raccord avec
connexion

Crée un raccord avec connexion 
interne d’objets creux Raccord

avec
insertion

Intègre un objet creux dans un autre 
objet creux

Découpe
raccord

Crée une découpe dans la paroi d'un 
objet creux pour ajouter un autre objet 
creux Extrusion

Extrude les faces planes d'un objet

Congé

Crée un congé (arrondi) sur une ou 
plusieurs arêtes d'un objet Révolution

Crée un objet par révolution d'un autre 
objet autour d'un axe

Coupe

Crée une coupe par l'intersection d'un 
objet avec un plan de coupe

Coupe à
plans

multiples

Crée une coupe par l'intersection d'un 
objet avec plusieurs plans de coupe
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Outil Description Outil Description

Chanfrein

Crée un chanfrein sur une ou plusieurs
arêtes d'un objet Symétrie

Crée la symétrie de l'objet sélectionné 
par rapport à un plan donné

Surface
Réglée

Crée une surface réglée entre deux 
courbes données Balayage

Balayage d'un ou plusieurs profils le 
long d'un chemin (ligne fermée ou non)

Lissage

Crée un lissage d'un profil jusqu'à un 
autre profil ou d'une série de profils Décalage

Crée une copie décalée de l'objet 
sélectionné

Epaisseur

Affecte une épaisseur aux faces d'une 
forme

Draft (Planche à dessin) 

L’atelier Planche à dessin (Draft) fournit des outils pour effectuer des tâches de dessin de base en 2D : lignes, 
cercles, etc. et une série d'outils génériques utiles tels que le déplacement, la rotation ou le changement 
d'échelle. Il fournit également plusieurs aides au dessin, telles que la grille et l'accrochage. Il s'agit 
principalement de dessiner les lignes directrices pour des objets Arch, mais sert également de «couteau 
suisse» de FreeCAD.

Outil Description Outil Description

Segment

Trace un segment de droite à partir de 
2 points

Polyligne

Trace une ligne composée de plusieurs 
segments de droites

Cercle

Trace un cercle à partir du centre et du 
rayon

Arc

Trace un segment d'arc à partir du 
centre, rayon, angle de départ et angle 
d'arrivée

Ellipse

Dessine une ellipse à partir de deux 
points opposés (coins)

Polygone

Dessine un polygone régulier à partir du 
centre et du rayon du cercle circonscrit

Rectangle

Trace un rectangle à partir de 2 points 
opposés

Texte

Dessine une note en texte multiligne

Dimension

Trace une cote
BSpline

Dessine une courbe B-Spline à partir 
d'une série de points

Point

Insère un objet point Forme
composée

texte

Insère une forme composée, qui 
représente une chaîne de texte

Objet sur face

Crée un nouvel objet sur la face de 
l'objet sélectionné Courbe de

Bezier

Dessine une courbe de Bezier à partir 
d'une série de points

Déplacer

Déplace l'objet (ou les objets) d'un 
emplacement à un autre par translation Pivoter

Déplace l'objet (ou les objets) par 
rotation autour d'un point
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Outil Description Outil Description

Décalage

Décale les segments d'un objet à une 
certaine distance Ajuster

Découpe ou prolonge un objet

Upgrade

Renvoie ou joint des objets dans un 
objet de niveau supérieur Downgrade

Renvoie ou sépare des objets en objets 
de niveau inférieur

Homothétie

Redimensionne par homothétie l'objet 
(ou les objets) sélectionné(s) à partir 
d'un point de base

Projection
2D

Génère une projection 2D à partir d'un 
objet 3D

Dessin vers
esquisse

Convertit un objet Draft en esquisse
(Sketcher) et vice versa Copies en

Réseau

Crée une matrice de copie polaire ou 
rectangulaire de l'objet sélectionné

Réseau
complexe de

copies 

Crée une série de copies d'objets le 
long d'un profil (chemin)

Clone

Crée un clone lié (dépendant) de l’objet 
sélectionné

Symétrie

Copie d'objets par symétrie par rapport
à une droite

Atelier Sketcher (esquisses)

L’atelier Sketcher contient des outils pour créer et modifier des objets 2D complexes, appelés des esquisses. 
La géométrie à l'intérieur de ces esquisses peut être positionnée avec précision et reliée par l'utilisation de 
contraintes. Elles sont principalement destinées à être les éléments constitutifs de la géométrie PartDesign, 
mais sont utiles partout dans FreeCAD.

Outil Description Outil Description

Point
dessine un point.

Segment

dessine un segment de droite entre 2 
points.

Arc

dessine un segment d'arc à partir du 
centre, rayon, angle de départ et angle 
d'arrivée. 

Arc par 3
points

dessine un arc de cercle sur deux points
et un troisième point pour la 
circonférence.

Cercle

dessine un cercle à partir de son 
centre et du rayon.

Cercle par 3
points

dessine un cercle à partir de trois points.

Ellipse

dessine une ellipse à partir du centre, 
d'un point sur le grand rayon et d'un 
point sur le petit rayon.

Ellipse par 3
points

dessine une ellipse à partir du grand 
diametre (2 points) et d'un point sur le 
petit rayon.

Arc d'ellipse

dessine une ellipse à partir du centre, 
d'un point sur le grand rayon, avec un 
point de départ et un point d'arrivée.

Arc
d'hyperbole

dessine un arc d'hyperbole. (v0.17)

Arc de
parabole

dessine un arc de parabole. (v0.17)
Polyligne

dessine une ligne composée de 
plusieurs segments connectés entre 
eux.
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Outil Description Outil Description

Rectangle

dessine un rectangle à partir de 2 
points opposés. Triangle

dessine un triangle équilatéral inscrit 
dans un cercle.

Carré
dessine un carré inscrit dans un cercle.

Pentagone

dessine un pentagone régulier inscrit 
dans un cercle.

Hexagone

dessine un hexagone régulier inscrit 
dans un cercle. Heptagone

dessine un heptagone régulier inscrit 
dans un cercle.

Octogone

dessine un octogone régulier inscrit 
dans un cercle. Lumière

dessine une lumière oblongue en 
entrant le centre du demi-cercle, le point
pour le rayon et le point final du 
deuxième demi-cercle.

Congé

crée un congé entre deux lignes 
connectées en un point. (sélectionnez 
les deux lignes, ou cliquez sur le 
sommet commun, puis activez l'outil).

Ajuster

ajuste une ligne, un cercle ou un arc par
rapport à l'emplacement du clic.

Géométrie
externe

crée une arête liée à une géométrie 
externe. Mode

Construction

bascule un élément vers / depuis le 
mode construction. 

Remarque : dans une esquisse, les éléments de construction (en bleu) sont ignorés lors d'une opération de 
géométrie 3D et sont seulement visibles quand l’esquisse qui les contient est en mode édition.
Dans FreeCAD v0.16, il a été ajouté la possibilité de créer une géométrie directement dans le Mode 
Construction, et l'icone a été changée. Le fait de sélectionner une géométrie existante et de cliquer sur cet 
outil bascule la géométrie en mode Construction. Dans FreeCAD v0.16, quand on clique sur cet outil alors 
qu'aucune géométrie n'est sélectionnée, cela change le mode pour les prochains objets à créer (Normal / 
Construction).

Contraintes d'esquisse

Les contraintes sont utilisées pour définir des règles entre les éléments d'esquisse et pour verrouiller 
l'esquisse le long des axes vertical et horizontal.

Contraintes non associées à des données numériques :

Outil Description Outil Description

Coïncident

crée une contrainte de coïncidence 
(point sur point) entre deux sommets 
sélectionnés.

Point sur
objet

crée une contrainte d’appartenance 
(point-sur-objet) entre un sommet et un 
autre objet (ligne, arc, cercle, axe ...).

Vertical

crée une contrainte de verticalité sur la 
ou les lignes ou segments de 
polylignes sélectionnés. Horizontal

crée une contrainte d'horizontalité sur la 
ou les lignes ou segments de polylignes 
sélectionnés.

Parallèle

crée une contrainte de parallélisme 
entre deux lignes sélectionnées. Perpendicula

ire

crée une contrainte de perpendicularité 
entre deux entités sélectionnées 
(droite/droite ou droite/extrémité d’arc).
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Tangent

crée une contrainte de tangence entre 
deux éléments sélectionnés, ou de 
colinéarité entre deux segments de 
droites.

Égalité

crée une contrainte d'égalité entre au 
moins deux éléments sélectionnés. 
Contraindra la longueur pour des lignes 
et le rayon pour des cercles et des arcs.

Symétrie

crée une contrainte de symétrie entre 
deux points par rapport à une ligne ou 
un troisième point sélectionné en 
dernier.

Contraintes associées à des données numériques :

Pour ces contraintes vous pouvez utiliser une expression. Les données peuvent prendre la forme d'une feuille 
de calcul de l'atelier Spreadsheet. 

Outil Description Outil Description

Fixe

crée une contrainte fixe sur le sommet 
sélectionné en ajoutant des 
dimensions horizontale et verticale 
relatives à l'origine (les dimensions 
peuvent être éditées par la suite).

Distance
horizontale

fixe la distance horizontale entre deux 
sommets ou extrémités de ligne. Si un 
seul élément est sélectionné, la distance
sera relative à l'origine.

Distance
verticale

fixe la distance verticale entre deux 
sommets ou extrémités de ligne. Si un 
seul élément est sélectionné, la 
distance sera relative à l'origine.

Longueur

 fixe la longueur d'un segment 
sélectionné, ou la distance entre deux 
points, ou entre une ligne droite et un 
point.

Rayon

crée une contrainte radiale sur un arc 
ou un cercle sélectionné en ajoutant un
rayon (cette dimension pourra être 
éditée par la suite).

Angle Interne

crée une contrainte d'angle interne entre
deux lignes sélectionnées.

Loi de Snell

contraint deux lignes à respecter une 
loi de réfraction simulant la trajectoire 
de la lumière à travers une interface.

Alignement
Interne

aligne les éléments selectionnés à la 
forme sélectionnée (par exemple, 
contraint une ligne à devenir le grand 
axe d'une ellipse).

Basculement
de Contrainte

bascule la barre d'outils ou les 
contraintes sélectionnées vers / depuis
le Mode Référence.

Autres contraintes :

Outil Description Outil Description

Nouvelle
Esquisse

crée une nouvelle esquisse sur un plan
ou une face sélectionnée. Si rien n'est 
sélectionné, le plan XY sera utilisé par 
défaut.

Editer
l'Esquisse

édite l'esquisse sélectionnée.

Quitter
l'Esquisse

quitte le mode Edition de l'esquisse en 
cours d’édition. Vue de

l'Esquisse

définit l'affichage de l'objet 
perpendiculairement au plan de 
l'esquisse.
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Appliquer une
Esquisse

applique une esquisse sur une face ou 
un solide sélectionné.

Réorienter
l'esquisse

réoriente l'esquisse en cours.

Valider
l'Esquisse

vérifier la tolérance des différents 
points et les faire correspondre entre 
eux.

Fusionner
des

Esquisses

fusionner deux ou plusieurs esquisses.

Esquisse
miroir

crée une esquisse symétrique selon 
l'axe X, l'axe Y ou l'origine. Copier une

esquisse

Recopie les éléments d’une esquisse 
dans l’esquisse en mode édition [v 0.17]

Atelier Part Design (conception de pièces)

L'atelier de conception de pièces contient des outils avancés pour créer des pièces solides. Il contient 
également tous les outils du sketcher. Comme il ne peut produire que des formes solides (la règle numéro 1 
de Part Design), c'est l' atelier principal à utiliser lors de la conception de pièces (parts) à fabriquer ou 
imprimer en 3D, car vous obtiendrez toujours un objet imprimable.

Outil Description Outil Description

Extrusion

Crée un objet solide par extrusion 
(Protrusion) de l’esquisse sélectionnée. Poche

Crée une poche (ou cavité) dans un 
solide existant, à partir de l’esquisse 
sélectionnée.

Révolution

Crée un solide par révolution de 
l’esquisse sélectionnée autour d'un 
axe.

Gorge
(rainure)

Enlève de la matière d'un solide existant
par révolution de l’esquisse sélectionnée
autour d'un axe (gorge ou rainure 
circulaire ...).

Congé

Applique un congé sur une/plusieurs 
arêtes sélectionnées d'un objet. Chanfrein

Applique un chanfrein sur une/plusieurs 
arêtes sélectionnées d'un objet.

Dépouille

Applique une pente angulaire aux 
faces d'un objet (dépouille). Symétrie

Copie une fonction par symétrie par 
rapport à un plan ou une face (plane).

Répétition
Linéaire

Crée une répétition linéaire d’une 
fonction. Répétition

Polaire

Crée une répétition polaire d’une 
fonction.

Transformatio
n multiple

Crée une transformation multiple d’une
fonction. Scaled

Copie une fonction à une échelle 
différente

Assistant de
conception

d'arbre

Génère un arbre à partir d'un tableau 
de valeurs et permet d'analyser les 
forces et moments.

Assitant de
création

d'engrenage

Permet de créer différents types 
d’engrenages.
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Atelier Arch (Architecture)
L'atelier Architecture (ou « Arch » pour faire court) fournit un flux de travail de type BIM à FreeCAD, avec des 
fonctionnalités telles que le support du format IFC, des entités architecturales pleinement paramétriques 
comme les murs, éléments structurels ou fenêtres, et la production d'une documentation 2D complète. Le 
module Arch dispose également de tous les outils de l'atelier Draft.

Outil Description Outil Description

Mur

Crée un mur à partir de zéro ou à 
partir d'un objet sélectionné. Élément

structurel

Crée un élément structurel à partir de 
zéro ou à partir d'un objet sélectionné.

Rebar

Crée un renforcement de barres sur 
l'élément structurel sélectionné. Étage

Crée un étage incluant les objets 
sélectionnés.

Bâtiment

Crée un bâtiment incluant les objets 
sélectionnés. Site

Crée un site incluant les objets 
sélectionnés.

Fenêtre

Crée une fenêtre (ou porte) sur un 
objet sélectionné servant de support. Plan de coupe

Ajoute un plan de coupe au document.

Système d'axes

Ajouter un système d'axes dans le 
document. Toiture

Crée un toit en pente à partir d'une face 
sélectionnée.

Espace

Crée un objet spatial dans le 
document. Escaliers

Crée un objet escalier dans le document.

Panneau

Crée un objet panneau à partir de 
zéro ou d'un objet 2D sélectionné. Ossature

Crée une ossature à partir d'un objet 2D 
plan et d'un profil.
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Outil Description Outil Description

Equipement

Crée un objet d’équipement ou 
founiture. Matériau

Attribue un matériau à l'objet sélectionné.

Liste
Crée différents types de listes.

Tube
Crée un tube. (v0,17) Connecter

tubes

Crée un onglet ou une connexion entre 
deux ou trois tubes sélectionnés. (v0,17).

Coupe
Coupe un objet selon un plan défini.

Ajouter
Ajouter un objet à un composant.

Retirer

Retirer ou effacer un objet d'un 
composant. Infos

Active ou quitte le mode Informations sur 
un modèle.

Atelier de mise en plan (Drawing)
L'atelier de mise en plan (Drawing) vous permet de coucher sur papier votre projet 3D, en mettant des vues 
de votre modèle dans une fenêtre 2D et en insérant cette fenêtre dans une mise en plan (page). Celle-ci 
pourra avoir une bordure, un titre et un logo, et cette page pourra ensuite être imprimée. L'atelier de mise en 
plan est pour le moment en construction et consiste plus ou moins en un aperçu technologique ! 

Outil Description Outil Description

Ouvrir SVG

Ouvre une feuille de dessin 
précédemment sauvegardée au 
format de fichier SVG.

Nouvelle feuille
de dessin

Créée une nouvelle feuille de dessin 
(format A3 par défaut de FreeCAD).

Insérer une vue

Insère une vue de l'objet sélectionné
dans la feuille active. Annotation

Ajoute une annotation dans la feuille de 
dessin courante.

Clip

Ajoute un groupe de clips dans la 
feuille de dessin courante. Aperçu dans

navigateur 

Ouvre un aperçu de la feuille courante 
dans le navigateur.

Vues
Orthogonales

Crée automatiquement des vues 
orthogonales d'un objet sur la feuille 
de dessin. Symbole

Ajoute le contenu d'un fichier SVG en tant
que symbole sur la feuille de dessin en 
cours.

Vue détail

Insère une vue de détail de l'objet 
sélectionné dans la feuille de dessin 
en cours.

Sauvegarder

Exporte la feuille de dessin dans un 
fichier au format SVG.
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Autres ateliers de travail intégrés
Bien que ce qui précède résume les outils les plus importants de FreeCAD, beaucoup d'autres ateliers de 
travail sont disponibles, parmi lesquels :

• L’atelier maillage (Mesh Workbench) permet de travailler avec des maillages polygonaux (polygon 
meshes). Bien que les maillages ne soient pas le type préféré de géométrie à utiliser dans FreeCAD, 
en raison de leur manque de précision et de support pour les courbes, les mailles ont encore 
beaucoup d'usages et sont entièrement prises en charge dans FreeCAD. L’atelier maillage offre 
également un certain nombre d'outils Part-vers-Mesh et Mesh-vers-Part.

• L’atelier de rendu réaliste (Raytracing Workbench) offre des outils pour l'interface avec des 
programmes externes tels que povray ou luxrender. Depuis FreeCAD, cet espace de travail vous 
permet de produire des rendus de haute qualité à partir de vos modèles.

• L’atelier feuille de calcul (Spreadsheet Workbench) permet la création et la manipulation de données 
de tableur, qui peuvent être extraites des modèles FreeCAD. Les cellules de feuille de calcul peuvent 
également être référencées dans de nombreux domaines de FreeCAD, ce qui permet de les utiliser 
comme structures de données de base.

• L’atelier Analyse des Eléments Finis (FEM Workbench) traite de l'analyse des éléments finis (Finite 
Elements Analysis) et permet d'effectuer des calculs de résistance pré et post-traitement et d'afficher 
les résultats graphiquement.

Ateliers externes
Un certain nombre d'autres ateliers très utiles produits par les membres de la communauté FreeCAD existent 
également. Bien qu'ils ne soient pas inclus dans une installation standard de FreeCAD, ils sont faciles à 
installer en tant que plug-ins. Ils sont tous référencés dans le dépôt FreeCAD-addons. Parmi les plus 
développés se trouvent les suivants :

• L’atelier de dimensionnement de dessin (Drawing Dimensioning Workbench) offre de nombreux 
nouveaux outils pour travailler directement sur les feuilles de dessin et vous permet d'ajouter des 
dimensions, des annotations et d'autres symboles techniques avec un grand contrôle sur leur aspect.

• L’atelier Fixations (Fasteners Workbench) offre une large gamme d'éléments de fixation prêts à insérer 
comme des vis, des boulons, des tiges, des rondelles et des écrous. De nombreuses options et 
paramètres sont disponibles.

• L' atelier Assemblage2 (Assembly2 Workbench) offre une série d'outils pour réaliser et travailler avec 
des assemblages.

Lire plus d'informations

• La liste complète des ateliers: http://www.freecadweb.org/wiki/index.php?Title=ateliers 

• L’atelier Part: http://www.freecadweb.org/wiki/index.php?title=Part_Module 

• L’atelier Draft: http://www.freecadweb.org/wiki/index.php?title=Draft_Module 

• L’atelier Sketcher et l’atelier Part Design: http://www.freecadweb.org/wiki/index.php?
Title=PartDesign_atelier 

• L’atelier Arch: http://www.freecadweb.org/wiki/index.php?title=Arch_Module 

• L’atelier Drawing: http://www.freecadweb.org/wiki/index.php?Title=Drawing_Module 

• L’atelier FEM: http://www.freecadweb.org/wiki/index.php?title=Fem_atelier 

• Le dépôt des greffons pour FreeCAD: https://github.com/FreeCAD/FreeCAD-addons
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1-3-2 Modélisation traditionnelle - la voie CSG
CGS signifie Constructive Solid Geometry et décrit la manière la plus simple de travailler avec la Géométrie 
3D solide, qui crée des objets complexes en ajoutant/enlevant des éléments de volumes en utilisant des 
opérations booléennes telles que l'union, la soustraction ou l'intersection de solides.

Comme nous l'avons vu plus tôt dans ce manuel, FreeCAD peut gérer de nombreux types de géométrie, mais 
le type préféré et le plus utile pour le genre d'objets 3D que nous voulons concevoir avec FreeCAD, c'est-à-
dire les objets du monde réel, est, sans aucun doute, solide, la géométrie BREP, qui est principalement prise 
en charge par l’atelier Part (Part Workbench). Contrairement aux maillages de polygones (polygon meshes), 
qui sont fabriqués uniquement de points et triangles, les objets BREP ont leurs faces définies par des courbes 
mathématiques, qui permettent une précision absolue, peu importe l'échelle.

La différence entre les deux peut être comparée à la différence entre bitmap et images vectorielles. Comme 
pour les images bitmap, les maillons polygonaux ont leurs surfaces courbes fractionnées en une série de 
points. Si vous le regardez très près, ou que vous l'imprimez très grand, vous n’allez pas voir une surface 
courbe mais une surface facettisée. Dans les images vectorielles et les données BREP, la position de 
n'importe quel point sur une courbe n'est pas stockée dans la géométrie mais est calculée à la volée, avec 
une précision exacte.

Dans FreeCAD, toute la géométrie basée sur BREP est gérée par un autre logiciel open source, 
OpenCasCade. L'interface principale entre FreeCAD et le noyau OpenCasCade est l’atelier Part. La plupart 
des autres ateliers créent leurs fonctionnalités au dessus de l’atelier Part.

Bien que d'autres ateliers proposent souvent des outils plus avancés pour construire et manipuler la 
géométrie, puisqu'ils manipulent tous les objets Part, il est très utile de savoir comment ces objets fonctionnent
en interne et peuvent utiliser les outils de Part car, plus simples, ils peuvent très souvent vous aider à 
contourner les problèmes que les outils les plus intelligents ne parviennent pas à résoudre correctement.

Pour illustrer le fonctionnement de l’atelier Part, nous modéliserons cette table, en utilisant uniquement des 
opérations CSG (à l'exception des vis, pour lesquelles nous utiliserons l'un des greffons (addons), et les 
dimensions, qui seront vues dans le chapitre suivant) :
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Créez un nouveau document (Ctrl + N ou menu Fichier -> Nouveau document), passez à l’atelier Part, et 
commencez par le premier pied :

• Appuyez sur le bouton Boîte 

• Sélectionnez la boite obtenue, puis définissez les propriétés suivantes (dans l'onglet Données):

◦ Longueur: 80mm (ou 8cm, ou 0.8m, FreeCAD fonctionne dans n'importe quelle unité)

◦ Largeur: 80mm

◦ Hauteur: 75cm

• Dupliquez la boîte en appuyant sur Ctrl + C puis sur Ctrl + V (ou menu Edition -> Copier et coller)

• Sélectionnez le nouvel objet qui a été créé

• Changez sa position en modifiant sa propriété de placement :

◦ Position x: 8mm

◦ Position y: 8mm
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Vous devriez obtenir deux boîtes hautes, à une distance de 8 mm l'une de l'autre :

• Maintenant, nous pouvons soustraire l'un de l'autre: Sélectionnez le premier, c'est-à-dire celui qui 
reste donc avec la touche CTRL enfoncée, sélectionnez l'autre, qui sera soustrait (l'ordre est 

important) et appuyez sur le bouton Soustraction (soustraction booléenne)  :
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Observez que l'objet nouvellement créé, appelé "Cut", contient toujours les deux cubes que nous avons 
utilisés comme les opérandes. En fait, les deux cubes sont toujours présents dans le document, ils ont 
simplement été cachés et regroupés sous l'objet "Cut" dans l'arborescence. Vous pouvez toujours les 
sélectionner en développant la flèche à côté de l'objet "Cut" et, si vous le souhaitez, les rendre visibles à 
nouveau en cliquant droit sur eux ou en modifiant l'une de leurs propriétés.

• Maintenant, créez les trois autres pieds en copiant notre cube de base 6 autres fois. Puisqu'il est 
toujours copié, vous pouvez simplement coller (Ctrl + V) 6 fois. Modifiez leur position comme suit :

◦ Cube002: x: 0, y: 80cm

◦ Cube003: x: 8mm, y: 79.2cm

◦ Cube004: x: 120cm, y: 0

◦ Cube005: x: 119.2cm, y: 8mm

◦ Cube006: x: 120cm, y: 80cm

◦ Cube007: x: 119.2cm, y: 79.2cm
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• Maintenant, faisons les trois autres coupures, en sélectionnant d'abord le cube "hôte" puis le cube à 
soustraire. Nous avons maintenant quatre objets coupés :

Vous avez peut-être pensé que, au lieu de dupliquer le cube de base six fois, nous pourrions dupliquer le pied 
complet trois fois. C'est tout à fait vrai, comme toujours dans FreeCAD, il existe plusieurs façons d'obtenir un 
même résultat. C'est une chose précieuse à retenir, parce que, lorsque nous progresserons vers des objets 
plus complexes, certaines opérations pourraient ne pas donner un résultat correct et nous devons souvent 
essayer d'autres façons.

• Nous allons maintenant faire des trous pour les vis, en utilisant la même méthode de coupe. Puisque 
nous avons besoin de 8 trous, deux dans chaque pied, nous pourrions faire 8 objets à soustraire. Au 
lieu de cela, explorons d'autres façons et faisons 4 cylindres, qui seront réutilisés par deux pieds. Alors,

créons quatre  cylindres en utilisant l'outil Cylindre . Vous pouvez à nouveau, en faire un seul et le 
doubler ensuite. Donnez à tous les cylindres un rayon de 6 mm. Cette fois, nous devrons les faire 
pivoter, ce qui se fait également via la propriété Placement :

◦ Cylindre: hauteur: 130cm, angle: 90 °, axe: x: 0, y: 1, position: x: -10mm, y: 40mm, Z: 72cm

◦ Cylindre001: hauteur: 130cm, angle: 90 °, axe: x: 0, y: 1, position: x: -10mm, y: 84cm, Z: 72cm

◦ Cylindre002: hauteur: 90cm, angle: 90 °, axe: x: -1, y: 0, position: x: 40mm, y: -10mm, Z: 70cm

◦ Cylindre003: hauteur: 90cm, angle: 90 °, axe: x: -1, y: 0, position: x: 124cm, y: -10mm, Z: 70cm
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Vous remarquerez que les cylindres sont un peu plus longs que nécessaire. C'est parce que, comme dans 
toutes les applications 3D solides, les opérations booléennes dans FreeCAD sont parfois trop sensibles à des 
situations face-sur-face et pourraient échouer. En faisant cela, nous nous sommes placés dans une situation 
sûre.

• Maintenant, faisons les soustractions. Sélectionnez le premier pied, puis, avec la touche CTRL 
enfoncée, sélectionnez un des cylindres qui le traversent, appuyez sur le bouton Couper. Le trou sera 
fait, et le cylindre caché. Trouvez-le dans l'arborescence en développant le pied percé.

• Sélectionnez un autre pied percé par ce cylindre caché, puis répétez l'opération, cette fois-ci en 
sélectionnant le tube dans l'arborescence avec Ctrl +, car il est caché dans la vue 3D (vous pouvez 
également le rendre visible et le sélectionner dans la vue 3D). Répétez ceci pour les autres pieds 
jusqu'à ce que chacun d'eux ait ses deux trous :
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Comme vous pouvez le voir, chaque pied est devenu une série assez longue d'opérations. Tout cela reste 
paramétrique, et vous pouvez changer n'importe quel paramètre de l'une des anciennes opérations à tout 
moment. Dans FreeCAD, nous nous référons souvent à cette pile comme «historique de la modélisation» (ou 
parfois arbre de construction), car elle porte en fait tout l’historique des opérations que vous avez effectuées.

Une autre particularité de FreeCAD est que le concept de l'objet 3D et le concept de l'opération 3D ont 
tendance à se fondre en une même chose. La coupe est à la fois une opération, et l’objet 3D résultant de cette
opération. Dans FreeCAD, cela s'appelle une "fonctionnalité", plutôt que objet ou opération.

• Maintenant, faisons le dessus de la table, ce sera un simple bloc de bois ; faisons-le avec une autre 
boîte de longueur: 126cm, largeur: 86cm, hauteur: 8cm, position: x: 10mm, y: 10mm, z, 67cm. Dans 
l'onglet Affichage, vous pouvez lui donner une belle couleur brun-semblable au bois en changeant sa 
Propriété couleur :
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Notez que, bien que les pieds aient 8 mm d'épaisseur, nous l'avons placé à 10 mm, en laissant 2 mm entre 
eux. Ce n'est pas nécessaire, bien sûr, cela n'arrivera pas avec la vraie table, mais c'est une pratique courante
utilisée dans ce genre de modèles "assemblés", cela aide les personnes qui regardent le Modèle pour 
comprendre que ce sont des pièces indépendantes, qui devront être jointes ensemble manuellement plus tard.

Maintenant que nos cinq pièces sont complètes, c'est le bon moment pour leur donner des noms plus parlants
que "Cut015". En cliquant avec le bouton droit sur les objets dans l'arborescence (ou en appuyant sur F2), 
vous pouvez renommer de façon plus significative pour vous-même ou pour une autre personne qui ouvrirait 
votre travail plus tard. On dit souvent que le fait de donner simplement des noms concrets à vos objets est 
beaucoup plus important que la façon dont vous les modélisez.

• Nous allons maintenant placer des vis. Il existe aujourd'hui un complément extrêmement utile 
développé par un membre de la communauté FreeCAD, que vous pouvez trouver sur le dépôt de 
greffons FreeCad (FreeCAD addons), appelé Fasteners, qui rend l'insertion de vis très facile.
L'installation d’ateliers supplémentaires est simple et décrite dans les pages des greffons (addons).

• Une fois que vous avez installé l’atelier Fasteners et redémarré FreeCAD, il apparait dans la liste des 
ateliers, et nous pouvons l’utiliser. Ajouter une vis à l'un de nos trous est effectué en sélectionnant 
d'abord l'arête circulaire de notre trou :
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• Ensuite, nous pouvons appuyer sur un des boutons de choix de vis de l’atelier Fasteners, par exemple 
le boulon hexagonal EN 1665 à brides, série lourde. La vis sera placée et alignée sur notre trou, et 
le diamètre sera automatiquement sélectionné pour correspondre à la taille de notre trou. Parfois, la vis
sera inversée, ce que nous pouvons corriger en inversant son sens. Nous pouvons également définir 
son décalage à 2mm, pour suivre la même règle que nous avons utilisée entre la table et les pieds :
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• Répétez ceci pour tous les trous, et notre table est complète !

La structure interne des objets Part

Comme nous l'avons vu ci-dessus, il est possible dans FreeCAD de sélectionner non seulement des objets 
entiers, mais des éléments d’entre eux, comme la bordure circulaire de notre trou de vis. C'est le bon moment 
pour regarder rapidement la façon dont les objets Part sont construits en interne. Chaque atelier qui produit 
une géométrie Part sera basée sur ceux-ci :

• Vertices (sommets) : ce sont des points (généralement des points d'extrémité) sur lesquels tout le 
reste est construit. Par exemple, une ligne comporte deux sommets.

• Arêtes : les arêtes sont de la géométrie linéaire comme les lignes, les arcs, les ellipses ou les courbes 
NURBS. Elles ont généralement deux sommets, mais certains cas particuliers en ont seulement un (un
cercle fermé par exemple).

• Lignes composites : une ligne composite est une succession d'arêtes connectées par leurs 
extrémités. Elle peut contenir des arêtes de n'importe quel type, et elle peut être fermée ou non.

• Faces : les faces peuvent être planes ou courbes, et peuvent être formées par une ligne composite 
fermée qui forme la bordure de la face, ou plus d'une, dans le cas où la face a des trous.
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• Coquilles : les coquilles sont simplement un groupe de faces reliées par leurs bords. Elles peuvent 
être ouvertes ou fermées.

• Solides : lorsqu'une coquille est complètement fermée, c'est-à-dire qu'elle n'a pas de "fuite", elle 
devient solide. Les solides portent la notion d'intérieur et d'extérieur. De nombreux ateliers s'appuient 
sur cette notion pour que les objets qu'ils produisent puissent être construits dans le monde réel.

• Composés : Les composés sont simplement des agrégats d'autres formes, quel que soit leur type, en 
une seule forme.

Dans la vue 3D, vous pouvez sélectionner individuellement des sommets, des arêtes ou des faces. En 
sélectionnant l'un d’entre eux, vous sélectionnez également l'objet entier.

Une note sur le design partagé

Vous pourriez regarder la table ci-dessus et penser que son design n'est pas bon. La fixation des pieds sur le 
plateau de table est probablement trop faible. Vous voudrez peut-être ajouter des pièces de renfort, ou 
simplement vous avez d'autres idées pour le faire mieux. C'est là que le partage devient intéressant. Vous 
pouvez téléchargez le fichier effectué pendant cet exercice à partir du lien ci-dessous, et le modifier pour le 
refaire mieux. Ensuite, si vous partagez ce fichier amélioré, d'autres pourraient être en mesure de le rendre 
encore mieux, ou utiliser votre table bien conçue dans leurs projets. Votre conception pourrait alors donner 
d'autres idées à d'autres personnes, et peut-être vous aurez aidé un petit peu à faire un monde meilleur ...

Téléchargements

• Le fichier produit dans cet exercice: 
https://github.com/yorikvanhavre/FreeCADmanual/blob/master/files/table.FCStd

Lire plus d’informations

• L’atelier Part: http://www.freecadweb.org/wiki/index.php?title=Part_Module 

• Le dépôt FreeCAD addons: https://github.com/FreeCAD/FreeCAD-addons 

• L’atelier Fasteners: https://github.com/shaise/FreeCAD_FastenersWB
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1-3-3 Dessin 2D traditionnel
Vous pouvez être intéressé par FreeCAD car vous avez déjà une expérience de dessin technique, par 
exemple avec un logiciel comme AutoCAD. Ou vous savez déjà quelque chose dans le Design, ou vous 
préférez dessiner avant de construire. Dans les deux cas, FreeCAD propose un atelier avec des 
fonctionnalités plus traditionnelles, avec des outils que l’on trouve dans la plupart des applications CAO 2D : 
L’atelier de dessin 2D (Draft Workbench).

L’atelier Draft, bien qu'il adopte des façons de travailler hérité du dessin traditionnel 2D du monde de la CAO 
n'est pas limité au royaume 2D. Tous ses outils fonctionnent dans l'ensemble de l'espace 3D et beaucoup de 

ses outils, par exemple Déplacement (  Move ) ou Rotation (  Rotate), sont couramment utilisés partout 
dans FreeCAD car ils sont souvent plus intuitifs que changer les paramètres de placement manuellement.

Parmi les outils offerts par l’atelierDraft, vous trouverez des outils de dessin traditionnels comme ligne (

Line), cercle (  Circle) ou polyligne (  Wire), des outils de modification comme déplacer (  Move), faire 

pivoter (  Rotate) ou décaler (  Offset), un système de plan de travail / grille (working plane/grid system) qui 
vous permet de définir précisément dans quel plan vous travaillez, et un système d'accrochage complet 
(snapping system) qui rend très facile de dessiner et de positionner précisément des éléments l'un par rapport 
à l'autre.

Pour montrer le travail et les possibilités de l'ébauche de travail, nous réaliserons un exercice simple, dont le 
résultat sera ce petit dessin, montrant le plan d'étage d'une petite maison qui ne contient qu'un dessus de 
cuisine (un plan d'appartement très absurde, mais on peut faire ce que nous voulons ici, n'est-ce pas?) :

• Rendez-vous dans l’atelier Draft
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• Comme dans toutes les applications de dessin technique, il est judicieux de configurer votre 
environnement correctement, cela vous épargnera beaucoup de temps. Configurez la grille et le plan 
de travail (grid and working plane), le texte (Text) et les paramètres de dimensions (Dimension) à votre 
convenance dans le menu Edition -> Préférences -> Draft. Dans cet exercice, cependant, nous 
agissons comme si ces paramètres de préférences étaient laissés à leurs valeurs par défaut.

L’atelier Draft dispose également de deux barres d'outils spéciales : l'une avec les paramètres visuels, où 
vous pouvez modifier le plan de travail actuel, activer / désactiver le mode de construction (construction 
mode), définir la couleur de la ligne, la couleur de la face, l’épaisseur de la ligne et la taille du texte à utiliser 
pour les nouveaux objets, Et un autre avec des filtres d’accrochages. Là, vous pouvez activer / désactiver la 
grille et définir / désactiver les filtres d’accrochages particuliers (Snap locations) :

• Commençons par passer en mode construction, ce qui nous permettra de dessiner des lignes 
directrices sur lesquelles nous allons dessiner notre géométrie finale.
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• Si vous le souhaitez, mettez le plan de travail sur XY. Si vous faites cela, le plan de travail ne 
changera pas, peu importe la vue actuelle. Si ce n'est pas le cas, le plan de travail s'adapte 
automatiquement à la vue actuelle, et vous devriez prendre soin de rester en vue de dessus lorsque 
vous souhaitez dessiner sur le plan XY (sol).

• Ensuite, sélectionnez l'outil Rectangle (  Rectangle) et tracez un rectangle, en commençant par le 
point (0,0,0), de 2 mètres par 2 mètres (laissez Z à zéro). Notez que la plupart des commandes Draft 
peuvent être entièrement exécutées à partir du clavier, sans toucher la souris, en utilisant leur raccourci
à deux lettres. Notre premier rectangle 2x2m peut se faire comme ceci : re 0 Entrée 0 Entrée 0 Entrée
2m Entrée 2m Entrée 0 Entrée.

• Dupliquez ce rectangle de 15 cm à l'intérieur, en utilisant l'outil Décalage (  Offset), en activant son 
mode Copie et en lui donnant une distance de 15 cm :

• Nous pouvons ensuite dessiner quelques lignes verticales pour définir où nos portes et fenêtres seront 

placées, en utilisant l'outil Ligne (  Line). L’intersection de ces lignes avec nos deux rectangles nous 
donnera des intersections utiles pour enrayer nos murs. Dessinez la première ligne du point (15cm, 
1m, 0) au point (15cm, 3m, 0).

• Dupliquez cette ligne 5 fois, en utilisant l'outil Déplacer (  Move) avec le mode Copy activé. Activez 
également le mode relatif, ce qui nous permettra de définir des déplacements selon des distances 
relatives, ce qui correspond à la position exacte de chaque ligne. Donnez à chaque nouvelle copie un 
point de départ, vous pouvez le laisser à (0,0,0) par exemple, et les points finaux relatifs suivants :
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◦ Line001: x: 10cm

◦ Line002: x: 120cm

◦ Ligne 003: x: -55cm, y: -2m

◦ Line004: x: 80cm

◦ Line005: x: 15cm

• C'est tout ce dont nous avons besoin maintenant, nous pouvons donc désactiver le mode de 
construction. Vérifiez que toute la géométrie de la construction a été placée dans un groupe 
"Construction", ce qui permet de le masquer tout à la fois ou même de le supprimer complètement 
plus tard.

• Maintenant, dessinons nos deux pièces murales à l'aide de l'outil Polyligne (  Wire ). Assurez-vous 

que le filtre d’accrochage intersection (  intersection snap ) est activé, car nous devrons créer les 
intersections de nos lignes et de nos rectangles. Dessinez deux polylignes comme suit, en cliquant 
sur tous les points de leurs contours. Pour les fermer, cliquez sur le premier point, ou appuyez sur le
bouton Fermer :
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• Nous pouvons changer leur couleur grise par défaut en un motif de hachures agréable, en  
sélectionnant les deux murs, et en définissant leur propriété Motif à Simple, et leur taille à votre 
goût, par exemple 0,005.
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• Nous pouvons maintenant cacher la géométrie de construction en cliquant avec le bouton droit sur 
le groupe Construction et en choisissant Masquer la sélection.

• Dessinons maintenant les fenêtres et les portes. Assurez-vous que le filtre d’accrochage Point 

Milieu (  midpoint snap ) est activé et tracez six lignes comme suit :
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• Nous allons maintenant changer la ligne de porte pour créer un symbole de porte ouvert. 

Commencez par faire tourner la ligne à l'aide de l'outil Rotation (  Rotate). Cliquez sur l'extrémité 
de la ligne en tant que centre de rotation, lui donner un angle de départ de 0 et un angle d'extrémité 
de -90.

• Ensuite, créez l'arc d'ouverture avec l'outil Arc (  Arc). Choisissez le même point que le centre de 
rotation que nous avons utilisé dans l'étape précédente comme centre, cliquez sur l'autre point de la 
ligne pour donner le rayon, puis les points de début et de fin comme suit :
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• Nous pouvons maintenant placer des meubles. Pour commencer, placez un compteur en dessinant 
un rectangle du coin supérieur gauche et en lui donnant une largeur de 170cm et une hauteur de 
-60cm. Dans l'image ci-dessous, la propriété Transparence du rectangle est configurée à 80%, pour
lui donner un bon aspect des meubles.

• Ensuite, ajoutons un lavabo et une table de cuisson. Dessiner ces types de symboles à la main peut
être très fastidieux, et ils sont généralement faciles à trouver sur Internet, par exemple sur 
http://www.cad-blocks.net. Dans la section Téléchargements ci-dessous, pour plus de commodité, 
nous avons récupéré un évier et une table de cuisson sur ce site et les avons sauvegardés en tant 
que fichiers DXF. Vous pouvez télécharger ces deux fichiers en visitant les liens ci-dessous et en 
cliquant avec le bouton droit sur le bouton Raw, puis en sélectionnant Enregistrer sous.

• L'insertion d'un fichier DXF dans un document FreeCAD ouvert peut être effectuée soit en 
choisissant l'option du menu Fichier -> Importer, soit en faisant glisser et déposer le fichier DXF 
depuis votre explorateur de fichiers dans la fenêtre FreeCAD. Le contenu des fichiers DXF peut ne 
pas apparaître directement au centre de votre vue actuelle, selon l'endroit où ils se trouvaient dans 
le fichier DXF. Vous pouvez utiliser le menu Affichage -> Affichage standard -> Afficher tout pour 
faire un zoom arrière et trouver les objets importés. Insérez les deux fichiers DXF et déplacez-les à 
un emplacement approprié sur le dessus de la table :
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• Nous pouvons maintenant placer quelques dimensions à l'aide de l'outil Dimension(  Dimension). 
Les dimensions sont dessinées en cliquant sur 3 points: le point de départ, un point final et un 
troisième point pour placer la ligne de cote. Pour obtenir des dimensions horizontales ou verticales, 
même si les deux premiers points ne sont pas alignés, appuyez sur Maj lorsque vous cliquez sur le 
deuxième point.

• Vous pouvez modifier la position d'un texte de cote en double-cliquant sur la dimension dans 
l'arborescence. Un point de contrôle vous permettra de déplacer le texte graphiquement. Dans notre
exercice, les textes "0.15" ont été déplacés pour une meilleure clarté.

• Vous pouvez modifier le contenu du texte de cote en éditant leur propriété Override. Dans notre 
exemple, les textes des dimensions des portes et des fenêtres ont été édités pour indiquer leurs 
hauteurs :
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• Ajoutons des textes de description à l'aide de l'outil Texte (  Text). Cliquez sur un point pour 
positionner le texte, puis entrez les lignes de texte, en appuyant sur Entrée après chaque ligne. 
Pour terminer, appuyez deux fois sur Entrée.

• Les lignes de repère (également appelées «leaders») qui relient les textes à l'élément qu'ils 
décrivent se font simplement avec l'outil Polyligne. Dessinez les polylignes, à partir de la position du
texte, jusqu’à l'endroit décrit. Une fois que cela est fait, vous pouvez ajouter une bille ou une flèche à
la fin des fils en définissant leur propriété End Arrow (extrémité de la flèche) sur True.
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• Notre dessin est maintenant terminé ! Puisqu'il commence à y avoir un certain nombre d'objets, il 
serait judicieux de faire du nettoyage et de placer tout dans une belle structure de groupes, pour 
rendre le fichier plus facile à comprendre à une autre personne :
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• Nous pouvons maintenant imprimer notre travail en le plaçant sur une feuille de dessin, que nous 
allons montrer plus loin dans ce manuel, ou exporter directement notre dessin vers d'autres 
applications de CAO en l'exportant vers un fichier DXF. Il suffit de sélectionner notre groupe "Plan 
d'étage", sélectionnez le menu Fichier -> Exporter, et sélectionnez le format Autodesk DXF. Le 
fichier peut alors être ouvert dans n'importe quelle autre application CAO 2D telle que LibreCAD. 
Vous pouvez remarquer quelques différences selon les configurations de chaque application.
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• La chose la plus importante à propos de l’atelier Draft, c'est que la géométrie que vous créez avec 
lui peut être utilisée comme base ou extrudée facilement dans des objets 3D, simplement en 

utilisant l'outil Part_Extrude (  Part_Extrude) de l’atelier Part (Part Workbench) ou, pour rester dans

Draft, l'outil (  Trimex (Trim/Extend/Extrude)), qui, sous le capot, exécute une extrusion de pièce, 
mais est-ce "la méthode de projet", c'est-à-dire celle qui vous permet d'indiquer et d'accrocher 
graphiquement la longueur d'extrusion . Expérimentez l'extrusion de nos murs comme indiqué ci-
dessous.

• En appuyant sur le bouton Sélectionner le plan de travail (  working plane) après avoir 
sélectionné une face d'un objet, vous pouvez également placer le plan de travail n'importe où et, par
conséquent, dessiner des objets Draft dans différents plans, par exemple sur le dessus des murs. 
Ceux-ci peuvent ensuite être extrudés pour former d'autres solides 3D. Expérimentez le réglage du 
plan de travail sur l'une des faces supérieures des murs, puis tracez des rectangles là-haut.

06/06/17 Manuel_Freecad.odt Page 71 / 166

https://www.freecadweb.org/wiki/Draft_SelectPlane
https://www.freecadweb.org/wiki/Draft_Trimex
https://www.freecadweb.org/wiki/Part_Module
https://www.freecadweb.org/wiki/Part_Extrude
https://www.freecadweb.org/wiki/File:Part_Extrude.png
https://www.freecadweb.org/wiki/File:Draft_Trimex.png
https://www.freecadweb.org/wiki/File:Draft_SelectPlane.png


• Toutes sortes d'ouvertures peuvent également être faites aussi facilement en dessinant des objets 
Draft sur les faces des murs, puis en les extrudant, puis en utilisant les outils booléens de l’atelier 
Part pour les soustraire d'un autre solide, comme nous l'avons vu dans le chapitre précédent.

Fondamentalement, ce que fait l’atelier Draft, c'est fournir des moyens graphiques pour créer des opérations 
partielles de base. Pendant que dans Part, vous positionnez généralement les objets en définissant leur 
propriété de placement à la main, dans Draft vous pouvez le faire à l'écran. Il y a des moments où c’est mieux,
d'autres fois où l'autre est préférable. N'oubliez pas, vous pouvez créer des outils personnalisés dans un de 
ces ateliers, ajouter les outils de l'autre et obtenir le meilleur des deux mondes.

Téléchargements
• Le fichier créé lors de cet exercice: 

https://github.com/yorikvanhavre/FreeCADmanual/Blob/master/files/cabin.FCStd 

• Le fichier DXF de l'évier: https://github.com/yorikvanhavre/FreeCADmanual/Blob/master/files/sink.dxf 

• Le fichier DXF de la table de cuisson: 
https://github.com/yorikvanhavre/FreeCADmanual/Blob/master/files/cooktop.dxf 

• Le fichier final DXF produit lors de cet exercice: Https://github.com/yorikvanhavre/FreeCAD-
manual/blob/master/files/cabin.dxf 

Lire plus d'informations
• L’atelier Draft: http://www.freecadweb.org/wiki/index.php?title=Draft_Module 

• Filtres d’accrochage: http://www.freecadweb.org/wiki/index.php?title=Draft_Snap 

• Le plan de travail Draft: http://www.freecadweb.org/wiki/index.php?Title=Draft_SelectPlane 
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1-3-4 Modélisation pour la conception de produits
La conception du produit (Product design) est à l'origine un terme commercial, mais dans le monde 3D, cela 
signifie souvent la modélisation de quelque chose avec l'idée de l'imprimer en 3D (3D-printed) ou, plus 
généralement, de le fabriquer avec une machine, imprimante 3D ou machine CNC (CNC machine).

Lorsque vous imprimez des objets en 3D, il est extrêmement important que vos objets soient des solides. Car 
ils deviendront des objets solides réels, c'est évident. Rien ne les empêche d'être creux à l'intérieur, bien sûr. 
Mais vous devez toujours avoir une idée claire de quels points sont à l'intérieur de la matière et quels points se
trouvent à l'extérieur, car l'imprimante 3D ou la machine CNC doit savoir exactement ce qui est rempli de 
matière et ce qui ne l'est pas. Pour cette raison, dans FreeCAD, l’atelier PartDesign (PartDesign Workbench) 
est l'outil idéal pour construire de telles pièces, car il veillera toujours pour vous à ce que vos objets restent 
des solides et réalisables.

Pour illustrer comment fonctionne l’atelier PartDesign, créons ce morceau bien connu de Lego :

La chose pratique avec les pièces de Lego est que les dimensions sont faciles à obtenir sur internet, au moins
pour les pièces standard. Il est assez facile de les modéliser et de les imprimer sur une imprimante 3D, et 
avec un peu de patience (l'impression 3D nécessite souvent beaucoup d'ajustements et de réglages), vous 
pouvez faire des pièces totalement compatibles et qui s’encastrent parfaitement dans des blocs Lego 
d'origine.

Dans l’exemple ci-dessous, nous allons créer un morceau 1,5 fois plus grand que l'original.

Nous allons maintenant utiliser exclusivement les outils des ateliers Esquisses (Sketcher) et PartDesign. Étant
donné que tous les outils de l’atelier Sketcher sont également inclus dans l’atelier PartDesign, nous pouvons 
rester dans PartDesign et nous n'aurons pas à basculer entre les deux.
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Les objets Part Design sont entièrement basés sur des esquisses. Une esquisse est un objet 2D, composé 
d’éléments linéaires (lignes ou segments de droites, arcs de cercle ou ellipses) et de contraintes. Ces 
contraintes peuvent être appliquées soit sur des éléments linéaires, soit sur leurs points d'extrémités ou leurs 
points centraux, et forceront la géométrie à adopter certaines règles. Par exemple, vous pouvez placer une 
contrainte verticale sur un segment de droite pour le forcer à rester vertical ou une contrainte de position 
(verrouillage) sur un point d'extrémité pour lui interdire de se déplacer.

Lorsqu'une esquisse comporte une quantité définie de contraintes qui interdit les déplacements de tous les 
points de l’esquisse, nous parlons d'une esquisse totalement contrainte. Quand il y a des contraintes 
redondantes, qui pourraient être supprimées sans que la géométrie ne soit déplacée, on dit qu’elle est sur-
contrainte. Cela devrait être évité, et FreeCAD vous informera si un tel cas se produit.

Les esquisses disposent d’un mode d'édition, où leur géométrie et leurs contraintes peuvent être modifiées. 
Quand vous avez terminé l'édition, et quittez le mode d'édition, les esquisses se comportent comme n'importe 
quel autre objet FreeCAD, et peuvent être utilisées comme éléments de construction pour tous les outils de 
conception de pièces, mais aussi dans d'autres ateliers, tels que Part ou Arch. L’atelier Draft (Draft workbench)
dispose également d'un outil qui convertit les éléments Draft en esquisses, et vice versa.

• Commençons par modéliser une forme parallélipipédique qui sera la base de notre brique Lego. Plus 
tard nous allons creuser l'intérieur, et ajouter les 8 bossages sur le dessus. Commençons donc en 
faisant une esquisse rectangulaire que nous allons ensuite extruder :

• Passez à l'atelier de conception de pièces PartDesign (PartDesign Workbench).

• Cliquez sur le bouton Nouvelle esquisse (  New Sketch). Une boîte de dialogue apparaîtra pour 
demander où vous voulez construire votre esquisse, choisissez le plan XY, qui est le plan "sol". 
L'esquisse sera créée et sera immédiatement changée en mode édition, et la vue sera orientée pour 
regarder votre esquisse selon la normale au plan de travail.

• Maintenant, nous pouvons dessiner un rectangle, en sélectionnant l'outil Rectangle (  Rectangle) et 
en cliquant deux sommets en diagonale. Vous pouvez placer les deux points n'importe où, car leur 
emplacement correct sera défini dans l'étape suivante.

• Vous remarquerez que quelques contraintes ont été automatiquement ajoutées à notre rectangle: les 
segments verticaux ont eu une contrainte verticale, les segments horizonaux une contrainte 
horizontale, et chaque sommet une contrainte point-sur-point qui collent les segments ensemble. Vous 
pouvez expérimenter le déplacement du rectangle en traînant ses lignes avec la souris, toute la 
géométrie continuera à obéir aux contraintes.

06/06/17 Manuel_Freecad.odt Page 74 / 166

https://www.freecadweb.org/wiki/Sketcher_Rectangle
https://www.freecadweb.org/wiki/Sketcher_NewSketch
https://www.freecadweb.org/wiki/PartDesign_Workbench
https://www.freecadweb.org/wiki/Draft_Module
https://www.freecadweb.org/wiki/Arch_Module
https://www.freecadweb.org/wiki/Part_Module
https://www.freecadweb.org/wiki/File:Sketcher_NewSketch.png
https://www.freecadweb.org/wiki/File:Sketcher_CreateRectangle.png


• Maintenant, ajoutons trois autres contraintes:

◦ Sélectionnez l'un des segments verticaux et ajoutez une contrainte de distance vecticale (
Vertical Distance Constraint). Donnez-lui une dimension de 23,7 mm.

◦ Sélectionnez l'un des segments horizontaux et ajoutez une contrainte de distance horizontale (
Horizontal Distance Constraint). Donnez-lui la valeur de 47.7mm.

◦ Enfin, sélectionnez l'un des points d'angle, puis le point d'origine (qui est le point à l’intersection des

axes rouge et vert), puis ajoutez une contrainte de coïncidence (  Point on Point Constraint). Le 
rectangle va alors passer au point d'origine, et votre croquis devient vert, ce qui signifie qu’il est 
maintenant complètement contraint. Vous pouvez essayer de déplacer ses lignes ou points, rien ne
bouge plus.
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Notez que la dernière contrainte point-sur-point n'était pas absolument nécessaire. Vous n'êtes jamais obligé 
de travailler avec des esquisses entièrement contraintes. Cependant, si nous allons imprimer ce bloc dans 
une imprimante 3D, il faudra maintenir notre pièce proche du point d'origine (qui sera l'origine de l'espace 
dans lequel la tête de l'imprimante peut se déplacer). En ajoutant cette contrainte, nous sommes assurés que 
notre pièce sera toujours "ancrée" à ce point d'origine.

• Notre esquisse de base est maintenant prête, nous pouvons quitter le mode d'édition en appuyant sur 
le bouton Fermer en haut du panneau de tâches, ou simplement en appuyant sur la touche Échap. Si 
nécessaire, plus tard, nous pouvons réactiver le mode d'édition à tout moment en double-cliquant sur 
le nom de l'esquisse dans l’arbre de construction.

• Extrudons l’esquisse en utilisant l'outil Extrusion (  Pad), et donnons-lui une dimension de 14,4 mm. 
Les autres options peuvent être laissées à leurs valeurs par défaut :
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L’outil Extrusion se comporte comme l'outil Extrude de l’atelier Part que nous avons utilisé dans le chapitre 
précédent.
Il y a quelques différences, cependant, la principale étant qu'un bloc ne peut pas être déplacé.
Il est attaché pour toujours à son croquis. Si vous souhaitez modifier la position du bloc, vous devez déplacer 
l'esquisse de base. Dans le contexte actuel, où nous voulons être sûr que rien ne bougera hors de sa position,
il s'agit d'une sécurité supplémentaire.

• Nous allons maintenant définir l'intérieur du bloc, en utilisant l'outil Poche ou Cavité (  Pocket), qui est
la version PartDesign de Part Cut. Pour faire une poche, nous allons créer une esquisse sur la face 
inférieure de notre bloc, qui sera utilisée pour enlever une partie du bloc.

• Lorsque la face inférieure est sélectionnée, appuyez sur le bouton Nouvelle esquisse (  New sketch).

• Dessinez un rectangle sur la face.
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• Nous allons maintenant contraindre le rectangle par rapport à la face inférieure. Pour ce faire, nous 

devons "Importer" certaines arêtes de la face avec l'outil de Géométrie Externe (  External geometry).
Utilisez cet outil sur les deux lignes verticales de la face inférieure :
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Vous remarquerez que seuls les bords (arêtes) de la face de base peuvent être ajoutés par cet outil. Lorsque 
vous créez une esquisse avec une face pré-sélectionnée, une relation est créée entre cette face et l'esquisse, 
ce qui est important pour de nouvelles opérations. Vous pouvez toujours relier une esquisse à une autre face 

plus tard avec l'outil Accrocher l’esquisse à une face (  Map sketch).

• La géométrie externe n'est pas "réelle", elle sera cachée lorsque nous quitterons le mode édition. Mais 
nous pouvons l'utiliser pour placer des contraintes. Placez les 4 contraintes suivantes :

◦ Sélectionnez les deux points supérieurs à gauche du rectangle et sur la ligne importée de gauche 

et ajoutez une contrainte de distance horizontale (  Horizontal Distance Constraint) de 1,8 mm.

◦ Sélectionnez de nouveau les deux points supérieurs à gauche du rectangle et sur la ligne importée 

de gauche. Ajoutez une contrainte de distance vecticale (  Vertical Distance Constraint) de 1,8 
mm.

◦ Sélectionnez les deux points inférieurs à droite du rectangle et sur la ligne importée de droite et 

ajoutez une contrainte de distance horizontale (  Horizontal Distance Constraint) de 1,8 mm.

◦ Sélectionnez de nouveau les deux points inférieurs à droite du rectangle et sur la ligne importée de 

droite et ajoutez une contrainte de distance verticale (  Vertical Distance Constraint) de 1,8 mm.

• Quittez le mode d'édition et vous pouvez maintenant effectuer l'opération de poche : l'esquisse étant 

sélectionnée, appuyez sur le bouton Poche (  Pocket). Donnez-lui une longueur de 12,6 mm, qui 
laissera la face supérieure de notre bloc avec une épaisseur de 1,8 mm (rappelez-vous, la hauteur 
totale de notre bloc était de 14,4 mm).
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• Nous allons maintenant attaquer les 8 bossages sur la face supérieure. Pour ce faire, comme ils sont 

une répétition d'une même fonction, nous utiliserons l'outil pratique Copie Linéaire (  Linear pattern) 
de l’atelier PartDesign, qui permet de modéliser une fois et de répéter la forme.

• Commencez par sélectionner la face supérieure de notre bloc.

• Créez une nouvelle esquisse (  New sketch).

• Créez deux cercles (  circles).

• Ajoutez une contrainte de rayon (  Radius Constraint) de 3,6 mm à chacun d'eux.

• Importez l’arête gauche de la face de base avec l'outil Géométrie Externe (  External geometry).

• Placez deux contraintes verticales et deux contraintes horizontales de 6 mm entre le centre de chaque 
cercle et les points d'angle du bord importé, donc chaque cercle a son centre à 6mm de la bordure de 
la face :

06/06/17 Manuel_Freecad.odt Page 80 / 166

https://www.freecadweb.org/wiki/Sketcher_External
https://www.freecadweb.org/wiki/Constraint_Radius
https://www.freecadweb.org/wiki/Sketcher_Circle
https://www.freecadweb.org/wiki/Sketcher_NewSketch
https://www.freecadweb.org/wiki/PartDesign_LinearPattern
https://www.freecadweb.org/wiki/File:PartDesign_LinearPattern.png
https://www.freecadweb.org/wiki/File:Sketcher_NewSketch.png
https://www.freecadweb.org/wiki/File:Sketcher_Circle.png
https://www.freecadweb.org/wiki/File:Constraint_Radius.png
https://www.freecadweb.org/wiki/File:Sketcher_External.png


• Notez comment, une fois de plus, lorsque vous verrouillez la position et la dimension de tous les 
éléments de votre esquisse, celle-ci devient complètement contrainte. Cela vous assure du résultat 
pour la suite. Vous pourriez modifier la première esquisse maintenant, tout ce que nous avons fait 
ensuite serait conservé.

• Quittez le mode d'édition, sélectionnez cette nouvelle esquisse et créez une extrusion (  Pad) de 
2.7mm :
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• Notez que, comme précédemment avec la poche, puisque nous avons utilisé la face supérieure de 
notre bloc de base en tant que support pour cette dernière esquisse, toute opération PartDesign que 
nous effectuons avec cette esquisse sera correctement construite en haut de la forme de base : les 
deux bossages ne sont pas des objets indépendants, ils ont été extrudés directement de notre brique. 

C'est le grand avantage de travailler avec l'atelier Part Design : tant que vous prenez garde à 
construire une forme à partir de la forme précédente, vous construisez réellement un dernier objet 
solide.

• Nous pouvons maintenant dupliquer nos deux bossages quatre fois, alors nous en aurons huit. 
Sélectionnez le dernier bossage que nous venons de créer.

• Appuyez sur le bouton de copie linéaire (  Linear pattern).

• Donnez-lui une longueur de 36 mm (qui est l’amplitude totale que nous souhaitons occuper avec nos 
copies), dans la direction «Axe d'esquisse horizontale», et faites-en 4 occurrences :
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• Encore une fois, il faut voir que ce n'est pas seulement une duplication d'un objet, c'est une 
caractéristique de notre forme qui a été dupliquée, l'objet final n'est encore qu'un seul objet solide.

• Maintenant, travaillons sur les trois «tubes» qui remplissent le vide que nous avons créé sur la face 
inférieure. Nous avons plusieurs possibilités : créer une esquisse avec trois cercles, l’extruder puis 
créer une poche trois fois, ou créer une esquisse de base avec deux cercles concentriques et les 
extruder pour former le tube déjà complet, ou même d'autres combinaisons. Comme toujours dans 
FreeCAD, il y a de nombreuses façons d'atteindre un même résultat. Parfois, une façon ne 
fonctionnera pas comme nous voulons, et nous devons essayer d'autres façons. Ici, nous allons 
prendre l'approche la plus sûre, et faire les choses l’une après l'autre.

• Sélectionnez la face qui se trouve au fond de l'espace que nous avons creusé précédemment à 
l'intérieur du bloc.

• Créez une nouvelle esquisse, ajoutez un cercle avec un rayon de 4.8825mm, importez le bord gauche 
de la face et positionnez le centre verticalement et horizontalement à 10,2 mm du coin supérieur de la 
face :
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• Quittez le mode d'édition et extrudez sur une longueur de 12,6 mm.

• Créez une copie linéaire de cette dernière extrusion, donnez-lui une longueur de 24mm et 3 
occurrences. Nous avons maintenant trois bossages dans l'espace creux :
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• Maintenant, faisons les derniers trous. Sélectionnez la face circulaire du premier de nos trois 
bossages.

• Créez une nouvelle esquisse, importez le bord circulaire de notre face, créez un cercle avec un rayon 

de 3,6 mm, et ajoutez une contrainte de coïncidence (  Point on Point Constraint) entre le centre du 
cercle importé et celui notre nouveau cercle. Nous avons maintenant un cercle parfaitement centré, et 
une fois encore complètement contraint :
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• Quittez le mode d'édition et créez une poche à partir de cette esquisse, d'une longueur de 12,6 mm.

• Créez une copie linéaire de cette poche, avec une longueur de 24 mm et 3 occurrences. 
C'est la dernière étape, notre pièce de lego est maintenant terminée, on peut lui donner une belle 
couleur de la victoire !
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Vous remarquerez que l’historique de modélisation ou arbre de construction (ce qui apparaît dans 
l'arborescence) est devenue assez long. Ceci est précieux car chaque étape de ce que nous avons fait peut 
être modifié plus tard.

L’adaptation de ce modèle pour un autre type de brique, par exemple une avec 2x2 bossages, au lieu de 2x4, 
serait du gâteau, il faudrait simplement changer quelques dimensions et le nombre d'occurrences dans les 
copies linéaires. Nous pourrions créer aussi facilement des pièces plus grandes qui n’existent pas dans le jeu 
original de Lego.

Mais nous pourrions aussi avoir besoin de nous débarrasser de l’historique, par exemple si nous voulons 
modéliser un château avec cette brique, et ne voulons pas que cet historique soit répété 500 fois dans notre 
fichier.

Il existe deux façons simples de se débarrasser de l’historique, on utilise l'outil de création de copie simple 
(Create simple copy) de l’atelier Part (Part Workbench), qui créera une copie de notre pièce qui ne dépend 
plus de l'historique (vous pouvez supprimer l'historique complet après), l'autre façon est d'exportater la pièce 
dans un fichier STEP et de la reimporter.

Assemblage

Mais le meilleur des deux mondes existe également, qui est l'atelier Assembly2 (Assembly2 Workbench), un 
greffon (addon) qui peut être installé à partir du dépôt FreeCAD-addons. Cet atelier s'appelle "2" car il existe 
également un atelier intégré d'assemblage en développement, qui n'est pas encore prêt. L’atelier Assembly2, 
cependant, fonctionne déjà très bien pour construire des assemblages, et comporte également quelques 
contraintes d'objet à objet que vous pouvez utiliser pour contraindre la position d'un objet par rapport à un 
autre. Dans l'exemple ci-dessous, cependant, il sera plus rapide et plus facile de positionner les pièces à l'aide

du déplacement (  Draft Move) et de la rotation (  Draft Rotate) de l’atelier Draft que d'utiliser les contraintes
d’Assembly2.
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• Enregistrez le fichier que nous avons fait jusqu'ici.

• Installez l’atelier Assembly2 (Assembly2 Workbench) et redémarrez FreeCAD.

• Créez un nouveau document vide.

• Passez à l’atelier Assembly2.

• Appuyez sur Importer une pièce à partir d'un autre document FreeCAD.

• Sélectionnez le fichier que nous avons enregistré ci-dessus.

• La pièce finale sera importée dans le document actuel. L'atelier Assembly2 déterminera 
automatiquement quelle est la pièce finale dans notre fichier qui doit être utilisée, et le nouvel objet 
reste lié au fichier d’origine. Si nous revenons en arrière et modifions le contenu du premier fichier, 
nous pouvons appuyer sur le bouton Mettre à jour les pièces importées dans l'assemblage pour 
mettre à jour les pièces ici.

• En utilisant le bouton Importer une pièce à partir d'un autre document FreeCAD plusieurs fois, et 
en déplaçant et en orientant les pièces convenablement (avec les outils de  l’atelier Draft ou en 
manipulant leurs propriétés de placement), nous pouvons créer rapidement un petit assemblage :

Téléchargements
• Le modèle produit lors de cet exercice: 

https://github.com/yorikvanhavre/FreeCADmanual/Blob/master/files/lego.FCStd 

Lire plus d'informations

• L’atelier Sketcher: http://www.freecadweb.org/wiki/index.php?title=Sketcher_Module 

• L’atelier Part Design: http://www.freecadweb.org/wiki/index.php?Title=PartDesign_atelier 

• L’atelier Assembly2 : https://github.com/hamish2014/FreeCAD_assembly2 
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1-3-5 Préparation de modèles pour l'impression 3D
L'une des principales utilisations de FreeCAD est de produire des objets du monde réel. Ceux-ci peuvent être 
conçus dans FreeCAD, et ensuite réalisés concrètement de différentes façons, telles que communiqués à 
d'autres personnes qui les fabriqueront ensuite ou, de plus en plus souvent, envoyés directement à une 
imprimante 3D (3D printer) ou à une machine CNC (CNC mill). Ce chapitre vous montrera comment préparer 
vos modèles à envoyer à ces machines.

Si vous avez été prudent lors de la modélisation, la plupart des difficultés que vous pourriez rencontrer lors de 
l'impression de votre modèle en 3D a déjà été évitée. Cela implique essentiellement :

• de vérifier que vos objets 3D sont des solides. Les objets du monde réel sont des solides, le modèle 
3D doit aussi être un solide. Nous avons vu dans des chapitres précédents que FreeCAD vous aide 
beaucoup et que l’atelier Part Design (PartDesign Workbench) vous informera si vous faites une 
opération qui empêche votre modèle de rester un solide. L’atelier Part (Part Workbench) contient 

également un outil de vérification de la géométrie (  Check Geometry) pratique pour vérifier les 
défauts éventuels.

• de vérifier les dimensions de vos objets. Un millimètre sur le modèle sera un millimètre dans la vie 
réelle. Chaque dimension importe.

• de contrôler la dégradation. Aucune imprimante 3D ou système de fraisage CNC ne peut utiliser 
directement les fichiers FreeCAD. La plupart d'entre eux ne comprennent qu'un langage machine 
appelé G-Code. G-code a des dizaines de variantes différentes, chaque machine ou fournisseur utilise 
généralement son propre G-code. La conversion de vos modèles en G-code peut être simple et 
automatique, mais vous pouvez le faire également manuellement, avec un contrôle total sur la sortie. 
En tout cas, une certaine perte de qualité de votre modèle se produira inévitablement pendant le 
processus. Lors de l'impression en 3D, vous devez toujours vous assurer que cette perte de qualité 
reste inférieure à vos exigences minimales.

Ci-dessous, nous supposerons que les deux premiers critères sont respectés, et que maintenant, vous êtes 
en mesure de produire des objets solides avec des dimensions correctes. Nous allons maintenant voir 
comment traiter le troisième point.

1-3-5-1 Exportation vers des trancheuses
C'est la technique la plus utilisée pour l'impression en 3D. L'objet 3D est exporté vers un autre programme (la 
trancheuse) qui générera le G-code à partir de l'objet, en le découpant en couches minces (d'où le nom), qui 
définira les mouvements que l'imprimante 3D fera.

Étant donné que beaucoup de ces imprimantes sont construites par soi-même, il y a souvent de petites 
différences de l'une à l'autre. Ces programmes offrent généralement des possibilités de configuration avancée 
qui permettent d’adapter exactement la sortie aux particularités de votre imprimante 3D.

L'impression 3D réelle, cependant, est un sujet trop vaste pour ce manuel. Mais nous verrons comment 
exporter et utiliser ces trancheuses pour vérifier que la sortie est correcte.

1-3-5-2 Conversion d'objets en mailles
Aucune des trancheuses, à cette date, ne prend directement la géométrie solide que nous produisons dans 
FreeCAD. Nous devrons donc convertir n'importe quel objet que nous souhaitons imprimer en 3D en un 
premier maillage, que le trancheur peut ouvrir. Heureusement, autant que convertir un maillage en un solide 
est une opération compliquée, le contraire, la conversion d'un solide en maillage, est très simple. Tout ce à 
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quoi il faut faire attention est que c'est maintenant que la dégradation que nous avons mentionnée ci-dessus 
se produira. Nous devons vérifier que la dégradation reste dans des limites acceptables.

Toute la gestion du maillage, dans FreeCAD, est effectuée par un atelier spécifique, l’atelier Mesh (Mesh 
Workbench). Cet atelier contient, outre le plus important, les outils qui convertissent les objets Part en objets 
Mesh, plusieurs utilitaires qui ont pour but d'analyser et de réparer les maillages.

Bien que le travail avec des maillages ne soit pas la fonction principale de FreeCAD, lorsque vous travaillez 
avec la modélisation 3D, vous avez souvent besoin de traiter des objets maillés, car leur utilisation est très 
répandue parmi d'autres applications. Cet atelier vous permet de les gérer complètement dans FreeCAD.

• Convertissons un des objets que nous avons modelés dans les chapitres précédents, comme la pièce 
de lego (qui peut être téléchargée à partir de la fin du chapitre précédent).

• Ouvrez le fichier FreeCAD contenant la pièce Lego.

• Passez à l’atelier Mesh (Mesh Workbench).

• Sélectionnez la brique lego.

• Sélectionnez le menu Maillages -> Créer un maillage à partir de la forme.

• Un panneau de tâches s'ouvre avec plusieurs options. Quelques algorithmes de maillage 
supplémentaires (Mefisto ou Netgen) pourraient ne pas être disponibles, selon la manière dont votre 
version de FreeCAD a été compilée. L'algorithme de maillage standard sera toujours présent. Il offre 
moins de possibilités que les deux autres, mais est totalement suffisant pour les objets plus petits que 
la taille d'impression maximale d'une imprimante 3D.
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• Sélectionnez le maillage standard et laissez la valeur d'écart à la valeur par défaut de 0,10. Appuyez 
sur OK.

• Un objet maillage sera créé, exactement par dessus notre objet solide. Pour comparer les deux vous 
pouvez soit cacher le solide, soit déplacer l'un des objets par rapport à l’autre.

• Modifiez la propriété Vue -> Mode d’affichage du nouvel objet maillage en Lignes de plans, afin de 
voir comment s'est déroulée la triangulation.

• Si vous n'êtes pas satisfait et pensez que le résultat est trop grossier, vous pouvez répéter l’opération, 
en abaissant la valeur d'écart. Dans l'exemple ci-dessous, le maillage gauche a utilisé la valeur par 
défaut de 0,10, tandis que celui de droite utilise 0,01 :

Dans la plupart des cas, cependant, les valeurs par défaut donneront un résultat satisfaisant.

• Nous pouvons maintenant exporter notre maillage à un format de maillage, tel que STL, qui est 
actuellement le format le plus utilisé dans l'impression 3D, en utilisant le menu Fichier -> Exporter et 
choisir le format de fichier STL.

Si vous ne possédez pas d'imprimante 3D, il est généralement très facile de trouver des services 
commerciaux qui vont imprimer et vous envoyer les objets imprimés par courrier. Parmi les plus célèbres, on 
trouve Shapeways et Sculpteo, mais vous en trouverez généralement beaucoup d'autres dans votre propre 
ville. Dans toutes les grandes villes, vous trouverez également aujourd'hui des Fab labs, qui sont des 
laboratoires ou ateliers équipés d'une gamme de machines de fabrication 3D, incluant presque toujours au 
moins une imprimante 3D. Les FabLabs sont habituellement des espaces communautaires, qui vous 
permettront d'utiliser leurs machines, moyennant des frais ou gratuitement selon le FabLab, mais aussi vous 
apprendre à les utiliser et à promouvoir d'autres activités autour de la fabrication 3D.
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1-3-5-3 Utilisation de Slic3r
Slic3r est une application qui convertit des objets STL en G-code pouvant être envoyé directement vers les 
imprimantes 3D. Comme FreeCAD, il est gratuit, open-source et s'exécute sous Windows, Mac OS et Linux.

La configuration correcte des paramètres pour l'impression 3D est un processus compliqué, où vous devez 
avoir une bonne connaissance de votre imprimante 3D ; il n'est donc pas très utile de générer du G-code 
avant de pouvoir effectivement imprimer (votre fichier de G-code peut ne pas fonctionner correctement sur une
autre imprimante), mais c'est utile pour nous de toute façon, pour vérifier que notre fichier STL sera 
imprimable sans problème.

Ceci est notre fichier STL exporté ouvert dans Slic3r. En utilisant l'onglet Aperçu, et en déplaçant le curseur 
droit, nous pouvons visualiser le chemin que la tête d'imprimante 3D suivra pour construire notre objet.

1-3-5-4 Utilisation du greffon (addon) Cura
Cura est une autre application Slicer gratuite et open-source pour Windows, Mac et Linux, maintenue par le 
fabricant d'imprimantes 3D Ultimaker. Certains utilisateurs de FreeCAD ont créé un atelier Cura (Cura 
Workbench) qui utilise Cura en interne. L’atelier Cura est disponible dans le dépôt FreeCAD addons. Pour 
utiliser l’atelier Cura, vous devez également installer Cura lui-même, qui n’est pas inclus dans l'atelier.

Une fois que vous avez installé Cura et l'atelier Cura, vous pourrez l'utiliser pour produire le fichier G-code 
directement à partir des objets Part, sans avoir besoin de les convertir en maillages et sans avoir besoin 
d'ouvrir une application externe. Produire un autre G-code à partir du fichier de notre brique Lego, en utilisant 
l’atelier Cura cette fois, se déroule comme suit :

• Chargez le fichier contenant notre brique Lego (il peut être téléchargé à la fin du chapitre précédent)

• Allez dans l’atelier Cura (Cura Workbench).
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• Configurez l'espace de l'imprimante en choisissant le menu impression 3D -> Définir une 
imprimante 3D. Comme nous n'allons pas imprimer de façon réelle, nous pouvons laisser les 
paramètres tels qu'ils sont. La géométrie du lit d'impression et l'espace disponible seront affichés dans 
la vue 3D.

• Déplacez la brique Lego à un endroit approprié, comme le centre du lit d'impression. N'oubliez pas que
les objets PartDesign ne peuvent pas être déplacés directement, donc vous devez soit déplacer sa 
toute première esquisse (le premier rectangle), ou déplacer (et créer) une copie, qui peut être faite 
avec l'outil Part -> Créer copie simple (Part -> Create Simple Copy). La copie peut être déplacée, par 

exemple avec l’outil Déplacer de Draft (  Draft -> Move).

• Sélectionnez l'objet à imprimer et sélectionnez dans le menu Impression 3D -> Trancher avec le 
moteur Cura.

• Dans le panneau de tâches qui s'ouvre, assurez-vous que le chemin d'accès à l'exécutable Cura est 
correctement défini. Comme nous n'allons pas vraiment imprimer, nous pouvons laisser toutes les 
autres options telles qu'elles sont. Appuyez sur OK. Deux fichiers seront générés dans le même 
répertoire que votre fichier FreeCAD, un fichier STL et un fichier G-code.

• Le G-code généré peut également être réimporté dans FreeCAD (en utilisant le préprocesseur slic3r) 
pour vérification.
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1-3-5-5 Génération du G-code
FreeCAD offre également des moyens plus avancés pour générer directement le G-code. C'est souvent 
beaucoup plus compliqué que l'utilisation d'outils automatiques comme nous l'avons vu ci-dessus, mais a 
l'avantage de vous laisser contrôler pleinement la sortie. Ceci n'est généralement pas nécessaire lors de 
l'utilisation d'imprimantes 3D, mais devient très important lors de la gestion du fraisage CNC, car les machines
sont beaucoup plus complexes.

La génération des parcours d’outils en G-code dans FreeCAD se fait avec l’atelier Path (Path Workbench). Il 
dispose d'outils qui génèrent des parcours d’outils complets et d'autres qui ne génèrent que des portions d'un 
projet G-code, qui peuvent être assemblés pour former une opération de fraisage complète.

La génération de parcours de fraisage CNC est un autre sujet qui est trop vaste pour être adapté à ce manuel,
nous allons donc montrer comment construire un projet de cheminement simple, sans se soucier de la plupart 
des détails de l'usinage CNC réel.

• Chargez le fichier contenant notre pièce de lego, et passez à  l’atelier Path (Path Workbench).

• Puisque la pièce finale ne contient plus une face supérieure rectangulaire, cachez la dernière étape de 
la pièce de lego, et montrez le premier bloc parallélipipédique que nous avons fait, qui a une face 
supérieure rectangulaire.

• Sélectionnez la face supérieure et appuyez sur le bouton Contour de face (  Face Profile).

• Définissez sa propriété Offset (décalage) à 1mm, qui correspond au rayon de la fraise.
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• Ensuite, dupliquons cette première boucle à plusieurs reprises, de sorte que l'outil découpera le bloc 

tout entier. Sélectionnez le contour FaceProfile et appuyez sur le bouton Copie réseau (  Array).

• Réglez la propriété Copies du réseau linéaire sur 8, et son intervalle à -2 mm dans la direction Z 
(profondeur de passe), et déplacez la position du réseau linéaire de 2 mm dans la direction Z, de sorte 
que la coupe commencera un peu au dessus du bloc, et inclura aussi la hauteur des bossages.

• Maintenant, nous avons défini un parcours d’usinage qui, après exécution par la fraiseuse, va 
contourner un volume rectangulaire sur un bloc de matériau. Nous devons maintenant réaliser l'espace
entre les bossages, afin de les révéler. Cachez le bloc, et montrez à nouveau la pièce finale, afin que 
nous puissions choisir la face qui se trouve entre les bossages.

• Sélectionnez la face supérieure et appuyez sur le bouton Poche (  Face Pocket). Définissez la 
propriété Décalage (Offset) à 1mm (toujours le rayon de la fraise), et la hauteur de dégagement d’outil 
à 20mm. C'est la hauteur de l'endroit où l’outil se déplace lorsque vous passez d'une boucle du 
parcours à l'autre. Sinon, la fraise pourrait couper tout droit à travers un de nos bossages :
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• Encore une fois, créez un tableau de copie. Sélectionnez l'objet Poche (FacePocket) et appuyez sur le 

bouton Copie réseau (  Array). Réglez le nombre de copies sur 1 et le décalage à -2 mm dans la 
direction Z. Déplacez la position du réseau (pas de la copie) à 2 mm dans la direction Z. Nos deux 
opérations sont maintenant terminées :
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• Maintenant, tout ce qu'il reste à faire est de relier ces deux opérations en une seule. Cela peut se faire 
avec un Parcours Composé (Path Compound) ou un projet Path (Path Project). Comme nous n'aurons 
besoin de rien de plus et que nous serons prêts à exporter le parcours d’outil, nous allons utiliser le 

projet. Appuyez sur le bouton Projet (  Project).

• Définir la propriété Utiliser les Placements du projet à Vrai, car nous avons changé le placement des 
tableaux, et nous voulons que cela soit pris en compte dans le projet.

• Dans l'arborescence, faites glisser et déposez les deux tableaux dans le projet. Vous pouvez 
réorganiser des réseaux à l'intérieur du projet si nécessaire, en double-cliquant dessus.

• Le projet peut maintenant être exporté en G-code, en le sélectionnant, en choisissant le menu Fichier 
→ Exporter, en sélectionnant le format G-code, et dans la boîte de dialogue contextuelle qui s'ouvrira, 
en sélectionnant un post processeur adapté à votre machine.

Il existe de nombreuses applications disponibles pour simuler l’usinage réel, l'une d'entre elles étant 
également multi-plate-forme et open-source, comme FreeCAD, est Camotics.

Téléchargements

• Le fichier STL généré dans cet exercice: 
https://github.com/yorikvanhavre/FreeCADmanual/Blob/master/files/lego.stl 

• Le fichier généré lors de cet exercice: 
https://github.com/yorikvanhavre/FreeCADmanual/Blob/master/files/path.FCStd 

• Le fichier G-code généré dans cet exercice: 
https://github.com/yorikvanhavre/FreeCADmanual/Blob/master/files/lego.gcode 

Lire plus d'informations

• L’atelier Mesh: http://www.freecadweb.org/wiki/index.php?title=Mesh_Module 

• Le format de fichier STL: https://en.wikipedia.org/wiki/STL_%28file_format%29 

• Slic3r: http://slic3r.org/ 

• Cura: https://ultimaker.com/fr/products/cura-software 

• L’atelier Cura: https://github.com/cblt2l/FreeCAD-CuraEngine-Plugin 

• L’atelier Path : http://www.freecadweb.org/wiki/index.php?title=Path_atelier 

• Camotics: http://camotics.org/ 
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1-3-6 Génération de dessins 2D
Lorsque votre modèle ne peut pas être imprimé ou usiné directement par une machine, par exemple il est trop
grand (un bâtiment), ou il faut un assemblage manuel après la préparation des pièces, vous aurez 
généralement besoin d’expliquer à une autre personne comment faire cela. Dans les domaines techniques 
(ingénierie, architecture, etc), cela se fait généralement avec des dessins qui expliqueront comment faire, qui 
sont remis à la personne responsable de l’assemblage du produit final.

Les exemples typiques sont les instructions Ikea (Ikea instructions), les dessins d'architecture (architectural 
drawings) ou les plans (blueprints). Ces dessins contiennent généralement non seulement le dessin lui-même,
mais aussi de nombreuses annotations, telles que les textes, dimensions, chiffres, symboles qui aideront les 
autres à comprendre ce qui doit être fait et comment.

Dans FreeCAD, l'atelier chargé de faire de tels dessins est l’atelier Dessin (Drawing Workbench).

L’atelier Dessin vous permet de créer des feuilles de dessin qui peuvent être vierges, ou d’utiliser un modèle 
pré-défini pour avoir déjà une série d'éléments sur la feuille, tels que les bordures et le titre. Sur ces feuilles, 
vous pouvez ensuite placer les vues des objets 3D que vous avez modélisés précédemment et configurer 
comment ces vues doivent apparaître sur la feuille. Enfin, grâce à un greffon (addon) appelé atelier de 
Dimensionnement de Dessin (Drawing Dimensioning Workbench), vous pouvez également placer toutes 
sortes d'annotations sur la feuille, telles que dimensions, textes et autres symboles habituels couramment 
utilisés dans les dessins techniques.

Les feuilles de dessin, une fois complétées, peuvent être imprimées ou exportées sous forme de fichiers SVG,
PDF ou DXF.

Dans l'exercice suivant, nous verrons comment créer un dessin simple d'un modèle de chaise trouvé dans la 
bibliothèque FreeCAD (FreeCAD library) en allant dans Meubles -> Chaises -> IkeaChair. La bibliothèque 
FreeCAD peut facilement être ajoutée à votre installation FreeCAD (reportez-vous au chapitre d'installation de 
ce manuel), ou vous pouvez télécharger simplement le modèle à partir de la page Web de la bibliothèque ou 
via le lien direct fourni au bas de ce chapitre.
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• Chargez le fichier IkeaChair à partir de la bibliothèque. Vous pouvez choisir entre la version .FCStd, qui
chargera l'historique de la modélisation complète, ou la version .step, qui ne créera qu'un seul Objet, 
sans l'historique. Comme nous n'aurons plus besoin de modéliser maintenant, il est préférable de 
choisir la version .step, car le fichier sera plus facile à manipuler. 

• Passer à l’atelier Dessin (Drawing Workbench)

• Appuyez sur la petite flèche à côté du bouton Nouvelle page de dessin (  New Drawing Page).

• Sélectionnez le modèle A4 Portrait / ISO7200. Un nouvel onglet s'ouvre dans votre fenêtre FreeCAD, 
montrant la nouvelle page.

• Dans l'arborescence (ou dans l'onglet modèle), sélectionnez le modèle de la chaise.

• Appuyez sur le bouton Insérer une vue (  Insert view).

• Un objet Vue sera créé sur notre page. Donner à la vue les propriétés suivantes :

◦ X: 100

◦ Y: 150

◦ Échelle: 0,1

◦ Rotation: 270
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• Nous avons maintenant une belle vue de dessus (qui est la projection par défaut) de notre chaise :

• Répétez l'opération deux fois pour créer deux autres vues. Nous allons définir leurs valeurs X et Y, qui 
indiquent la position de la vue sur la page, afin de les distinguer de la vue de dessus, et leur 
orientation, pour créer différentes orientations de vue. Donnez à chaque nouvelle vue les propriétés 
suivantes :

◦ Vue001 (vue de face) : X: 100, Y: 130, échelle: 0.1, Rotation: 90, direction: (-1,0,0)

◦ Vue002 (vue latérale) : X: 180, Y: 130, échelle: 0.1, Rotation: 90, direction: (0, -1,0)
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• Nous obtenons alors la page suivante :

• Nous pouvons régler un peu l'apparence de nos vues si nous voulons, par exemple nous pouvons 
régler leur propriété Largeur de trait à 0,5. 

Nous allons maintenant placer des dimensions et des indications sur notre dessin. Il existe deux façons 
d'ajouter les dimensions d'un modèle, l’une consistant à placer les dimensions dans le modèle 3D en utilisant 

l’outil de dimensionnement de l’atelier Draft (  Dimension ), puis à montrer ces dimensions sur notre dessin 

avec l'outil Draft View (qui peut être utilisé avec une seule dimension ou un groupe contenant des 
dimensions), ou nous pouvons faire les choses directement sur la feuille de dessin, en utilisant l’atelier 
Dimensionnement du Dessin (Drawing Dimensioning Workbench), qui peut être installé à partir des greffons 
FreeCAD (FreeCAD addons). Nous allons utiliser cette dernière méthode.
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• Passez à l’atelier de dimensionnement du dessin (Drawing Dimensioning Workbench)

• Appuyez sur le bouton Ajouter une dimension linéaire. Les nœuds disponibles sont mis en 
surbrillance en vert sur la page de dessin : 

• Cliquez deux de ces points, puis cliquez sur un troisième point pour placer la ligne de cote :
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• L'outil Dimension linéaire, comme la plupart des autres outils de dimensionnement du dessin, ne se 
ferme pas après avoir inscrit la cote, ce qui vous permet de placer plus de dimensions. Quand vous 
avez terminé, cliquez simplement sur le bouton Fermer dans le panneau de tâches.

• Répétez l'opération, jusqu'à ce que toutes les dimensions que vous souhaitez indiquer soient placées. 
Prenez une minute pour parcourir les différentes options proposées dans le panneau des tâches pour 
une dimension linéaire. Par exemple, en désactivant l'option de mise en place automatique du texte,
vous pourrez placer le texte de la dimension ailleurs, comme sur l'image ci-dessous :

• Nous allons maintenant placer deux indications, en utilisant l'outil Symboles Soudure/Stries, en 
sélectionnant celui par défaut (sans symbole de stries). Dessinez les deux lignes comme sur l'image ci-
dessus.

• Placez maintenant deux textes à l'aide de l'outil Ajouter un texte et modifiez leur propriété texte selon 
vos désirs.

• Notre dessin est maintenant terminé, tout ce qu'il reste à faire est de remplir les informations du 
cartouche. Avec la plupart des modèles FreeCAD par défaut, cela peut se faire facilement, en modifiant
la propriété Editable Texts de la page.

Notre page peut maintenant être exportée au format SVG pour être plus développée dans des applications 
graphiques comme inkscape, ou au format DXF en sélectionnant menu Fichier -> Exporter. L’atelier 
Dimensionnement du dessin dispose également de son propre outil d'exportation DXF, qui prend également 
en charge les annotations ajoutées avec cet atelier. Le format DXF est reconnu dans presque toutes les 
applications de CAO 2D existantes. Les pages de dessin peuvent également être directement imprimées ou 
exportées vers PDF.
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Téléchargements

• Le modèle de la chaise: 
https://github.com/FreeCAD/FreeCADlibrary/Blob/master/Furniture/Chairs/IkeaLikeChair.step 

• Le fichier créé lors de cet exercice: 
https://github.com/yorikvanhavre/FreeCADmanual/Blob/master/files/drawing.FCStd 

• La feuille SVG produite à partir de ce fichier: 
https://github.com/yorikvanhavre/FreeCADmanual/Blob/master/files/drawing.svg 

Lire plus d'informations

• L’atelier Drawing: http://www.freecadweb.org/wiki/index.php?Title=Drawing_Module 

• L’atelier de dimensionnement de dessin: 
Https://github.com/hamish2014/FreeCAD_drawing_dimensioning 

• La bibliothèque FreeCAD: https://github.com/FreeCAD/FreeCAD-library 

• Inkscape: http://www.inkscape.org
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1-3-7 Modélisation BIM
BIM signifie la modélisation de l'information sur le bâtiment (Building Information Modeling). La définition 
exacte est « ce qui varie », mais on peut dire simplement que les bâtiments et autres grandes structures 
comme les ponts, les tunnels, etc. sont aujourd'hui modélisés. Les modèles BIM sont généralement basés sur 
des modèles 3D et comprennent également une série de couches supplémentaires d'informations, telles que 
l'information sur les matériaux, les relations avec d'autres objets ou modèles, ou des instructions spéciales 
pour la construction ou la maintenance. Cette information supplémentaire permet toutes sortes d'analyses 
avancées du modèle, telles que la résistance structurelle, les estimations du coût et du temps de construction,
ou les calculs de la consommation d'énergie.

L'atelier Arch (Arch Workbench) de FreeCAD met en œuvre une série d'outils et d'installations pour la 
modélisation BIM. Bien qu'il ait un but différent, il est conçu pour fonctionner dans une intégration étroite avec 
le reste de FreeCAD : Tout ce qui est fait avec n'importe quel autre atelier de FreeCAD peut devenir un objet 
Arch ou être utilisé comme base pour un objet Arch.

Comme dans l’atelier PartDesign (PartDesign Workbench), les objets produits par l’atelier Arch sont destinés à
être construits dans le monde réel. Par conséquent, ils doivent être des solides. Les outils de l’atelier Arch 
s'occupent généralement de cela automatiquement, et fournissent également des outils utiles pour vous aider 
à vérifier la validité des objets.

L'atelier Arch comprend également tous les outils de l’atelier Draft (Draft Workbench), et utilise son réseau et 
son système d'accrochage. Avant de commencer, il est toujours recommandé de parcourir les pages de 
préférences de Draft et Arch et de configurer les paramètres par défaut à votre convenance.

Dans ce chapitre, nous verrons comment modéliser ce petit bâtiment :
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et produire un plan et une vue en coupe de celui-ci :

• Créez un nouveau document et passez à l’atelier Arch (Arch Workbench).

• Ouvrez le menu Editer -> Préférences -> Draft -> Grille et Accrochage et réglez le paramètre 
d'espacement de la grille à 1000 mm, donc nous avons une grille d'un mètre, ce qui sera pratique 
pour la taille de notre bâtiment.

• Sur la barre d'outils Accrochage, assurez-vous que le bouton Accrochage automatique (  grid snap) 
de la grille soit activé, afin que nous puissions utiliser la grille autant que possible.

• Réglez le plan de travail (Working Plane) sur le plan XY.

• Dessinez quatre lignes avec l'outil Ligne de Draft (  Draft Line). Vous pouvez entrer les coordonnées 
manuellement ou simplement sélectionner les points sur la grille avec la souris :

◦ Du point (0,0) au point (0,3)

◦ Du point (0,3) au point (4,3)

◦ Du point (4,3) au point (4,0)

◦ Du point (4,0) au point (0,0)
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Notez que nous avons toujours dessiné dans la même direction (dans le sens des aiguilles d'une montre). 
Cela n'est pas nécessaire, mais cela veillera à ce que les murs que nous construirons à la suite ont tous les 
mêmes directions gauche et droite. Vous pourriez également penser que nous pourrions simplement avoir 
tracé un rectangle ici, ce qui est vrai. Mais les quatre lignes nous permettront d'illustrer mieux comment ajouter
un objet à un autre.

• Sélectionnez la première ligne, puis appuyez sur le bouton Mur (  Wall).

• Répétez ceci pour les 3 autres lignes, jusqu'à ce que vous ayez 4 murs.

• Sélectionnez les quatre murs et définissez leur propriété Hauteur à 3.00m et leur propriété 
Alignement à gauche. Si vous n'avez pas dessiné les lignes dans le même ordre que nous l'avons fait
plus haut, certains des murs pourraient avoir leurs directions gauche et droite inversées, et il faudra 
peut-être régler Alignement à droite. Vous obtiendrez quatre murs croisés, à l'intérieur des lignes de 
base : 
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Maintenant, nous devons joindre ces murs ensemble, de sorte qu'ils se croisent correctement. Ceci n'est pas 
nécessaire lorsque vos murs sont dessinés d'une manière qu'ils se connectent déjà proprement, mais ici nous 
devons, car ils se croisent. Dans Arch, cela se fait en élisant l'un des murs pour être le "hôte", et en ajoutant 
les autres, en tant que «ajouts». Tous les objets d'Arch peuvent avoir n'importe quel nombre d'ajouts (objets 
dont la géométrie sera ajoutée à la géométrie de l'hôte), et de soustractions (objets dont la géométrie sera 
soustraite). Les ajouts et soustractions d'un objet peuvent être gérés à tout moment en double-cliquant sur 
l'objet dans l'arborescence.

• Sélectionnez les quatre murs en appuyant sur la touche Ctrl, le dernier étant le mur que vous avez 
choisi de devenir l'hôte.

• Appuyez sur le bouton Ajouter (  Add). Les quatre murs ont maintenant été transformés en un seul :
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Les parois individuelles sont cependant toujours accessibles, en élargissant le mur dans l'arborescence.

• Plaçons maintenant une porte. Dans FreeCAD, les portes sont considérées comme un cas particulier 
des fenêtres, ce qui se fait à l'aide de l'outil Fenêtre (Window).

• Commencez par sélectionner le mur. Ceci n'est pas nécessaire, mais une bonne habitude à prendre. 
Si un objet est sélectionné lors du démarrage de l'outil Fenêtre, vous forcerez la fenêtre à s’insérer 
dans cet objet, même si vous vous placez sur un autre objet.

• Réglez le plan de travail (Working Plane) sur auto, donc nous ne sommes pas restreints au plan de 
masse.

• Appuyez sur le bouton Fenêtre (  Window).

• Dans le panneau de création de la fenêtre, sélectionnez la présélection Porte Simple, et définissez sa 
largeur à 0,9 m et sa hauteur à 2,1 m.

• Assurez-vous que l'option Accrochage au point le plus proche (  Near snap) est activée, afin que 
nous puissions accrocher les objets à des faces.
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• Placez votre fenêtre à peu près au milieu de la face avant du mur :

• Après avoir cliqué, notre fenêtre est placée sur la bonne face, mais pas exactement où nous voulons :

06/06/17 Manuel_Freecad.odt Page 111 / 166



• Nous pouvons maintenant définir l'emplacement précis en développant le mur et les objets de la 
fenêtre dans l'arborescence et en changeant la propriété de placement de l'esquisse de base de notre 
porte. Réglez sa position sur x = 2m, y = 0, z = 0. Notre fenêtre est maintenant exactement là où nous 
le voulons :

• Répétez l'opération pour placer une fenêtre: sélectionnez le mur, appuyez sur l'outil Fenêtre, 
sélectionnez le préréglage Ouverture à 2 vantaux (Open 2-pane) et placez une fenêtre de 1 m x 1 m 
dans la même face que la porte. Réglez le placement de l'esquisse sous-jacente à la position x = 
0,6m, y = 0, z = 1,1 m, de sorte que la ligne supérieure de la fenêtre soit alignée sur le haut de la 
porte.
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Les fenêtres sont toujours construites sur des esquisses. Il est facile de créer des fenêtres personnalisées en 
créant d'abord une esquisse sur une face, puis en la transformant en une fenêtre en la sélectionnant, puis en 
appuyant sur le bouton Fenêtre. Ensuite, les paramètres de création de la fenêtre, c'est-à-dire les lignes de 
l'esquisse, doivent être extrudés et de plus peuvent être redéfinis en double-cliquant sur la fenêtre dans 
l'arborescence. Maintenant, créons une dalle :

• Réglez le plan de travail (Working Plane) sur le plan XY

• Créez un rectangle (  rectangle) avec une longueur de 5m, une hauteur de 4m, et placez-le à la 
position x: -0.5m, y: -0.5m, z: 0.

• Sélectionnez le rectangle.

• Cliquez sur l'outil Structure (  structure) pour créer une dalle à partir du rectangle.

• Réglez la propriété de hauteur de la dalle à 0,2 m et sa direction normale à (0,0, -1) car nous 
voulons qu'elle soit extrudée vers le bas. Nous pourrions aussi simplement l'avoir déplacée de 0,2 m 
vers le bas, mais il est toujours recommandé de conserver les objets extrudés au même endroit que 
leur profil de base.

• Définissez la propriété Rôle de la dalle sur dalle. Ceci n'est pas nécessaire dans FreeCAD, mais il est 
important pour l'exportation IFC, car il garantira que l'objet est exporté avec le type IFC correct.
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• Utilisons maintenant l'une des présélections structurelles pour créer une poutre métallique. Cliquez sur 

le bouton Structure (  structure), sélectionnez un préréglage HEB 180 et définissez sa hauteur à 4m. 
Placez-le n'importe où :
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• Réglez son emplacement en ajustant sa rotation à 90 ° dans l'axe (1,0,0), et sa position sur x: 90 mm, 
y: 3,5 m, z: 3,09 m. Cela positionnera la poutre exactement sur l'une des parois latérales :

• Nous devons maintenant dupliquer cette poutre plusieurs fois. Nous pourrions le faire une par une en 

utilisant l'outil de clonage (  clone), mais il y a une meilleure façon de faire toutes les copies à la fois 
en utilisant une copie en réseau :

• Sélectionnez la poutre

• Appuyez sur le bouton Réseau (  Array)

• Réglez la propriété Nombre X du tableau sur 6, laissez les nombres Y et Z à 1 

• Développez la propriété d'intervalle X et appuyez sur la petite icône d'expression (  expression) 
située sur le côté droit du champ X. Cela ouvrira un éditeur d'expressions (expressions editor) :
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• Ecrivez (4m-180mm)/5 dans le champ d'expression, et appuyez sur OK. Cela définira la valeur x à 
0.764 (4m est la longueur totale de notre paroi avant, 180mm est la largeur de la poutre, c'est pourquoi
elle s'appelle HEB180, et nous voulons un cinquième de cet espace comme intervalle entre chaque 
poutre) :
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• Nous pouvons maintenant construire facilement une dalle simple sur le dessus, en dessinant un 
rectangle directement sur le plan supérieur des poutres. Sélectionnez une face supérieure d'une des 
poutres.

• Appuyez sur le bouton Plan de travail (  working plane). Le plan de travail est maintenant réglé sur 
cette face.

• Créez un rectangle (  rectangle), en l’accrochant sur deux points opposés des poutres frontières :
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• Sélectionnez le rectangle.

• Cliquez sur le bouton structure (  structure) et créez une dalle avec une hauteur de 0,2 m.

Voilà, notre modèle est maintenant terminé. Nous devrions maintenant l'organiser afin qu'il s’exporte 
correctement vers IFC. Le format IFC exige que tous les objets d'un bâtiment se trouvent à l'intérieur d'un 
objet de construction, et éventuellement dans un historique. Il exige également que tous les bâtiments soient 
placés sur un site, mais l'exportateur IFC de FreeCAD ajoutera automatiquement un site par défaut si 
nécessaire, donc nous n'avons pas besoin d'en ajouter un ici.

• Sélectionnez les deux dalles, le mur et le réseau de poutres.

• Appuyez sur le bouton Plancher (  Floor).

• Sélectionnez le plancher que nous venons de créer.

• Appuyez sur le bouton Unité de construction (  Building).

Notre modèle est maintenant prêt à exporter :

Le format IFC (IFC format) est l'un des atouts les plus précieux dans un monde BIM gratuit, car il permet 
l'échange de données entre toute application et acteur du monde de la construction, de manière ouverte (le 
format est ouvert, gratuit et maintenu par un consortium indépendant). L'exportation de vos modèles BIM 
comme IFC garantit que tout le monde peut les voir et les analyser, peu importe l'application utilisée.

Dans FreeCAD, l'importation et l'exportation IFC se font en interconnectant un autre logiciel, appelé  
IfcOpenShell. Pour pouvoir exporter vers IFC depuis FreeCAD, le paquet IfcOpenShell-python doit être installé
sur votre système. Assurez-vous de sélectionner celui qui utilise la même version python que FreeCAD. La 
version python utilisée par FreeCAD est informée lors de l'ouverture du panneau Vue -> Panneaux -> 
console Python (View -> Panels -> Python console) dans FreeCAD. Lorsque cela est fait, nous pouvons 
alors exporter notre modèle :

• Sélectionnez l'objet supérieur que vous souhaitez exporter, c'est-à-dire l'objet Bâtiment.

• Sélectionnez le menu Fichier -> Exporter -> Industrie Fondation Classes et enregistrez votre fichier.
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• Le fichier IFC qui en résulte peut maintenant être ouvert dans une large gamme d'applications et de 
visualiseurs (l'image ci-dessous montre le fichier ouvert dans la visionneuse gratuite IfcPlusPlus). 
Vérifier le fichier exporté dans une telle application de visionneuse avant de le distribuer à d'autres 
personnes est important pour vérifier que toutes les données contenues dans le fichier sont correctes. 
FreeCAD lui-même peut également être utilisé pour réouvrir le fichier IFC résultant.

Nous allons maintenant placer certaines cotes. Contrairement au chapitre précédent, où nous avons tracé 
toutes les cotes directement sur la feuille de dessin, nous utiliserons une autre méthode ici, et placerons les 
cotes du projet (Draft dimensions) directement dans le modèle 3D. Ces cotes seront alors placées sur la 
feuille de dessin. Nous allons d'abord créer deux groupes pour nos cotes, un pour les cotes qui apparaîtront 
dans la vue en plan (coupe horizontale dans le langage du bâtiment), et un autre pour celles qui apparaissent 
sur l'élévation (vue de face dans le langage du bâtiment).

• Cliquez avec le bouton droit de la souris sur le document «maison» dans l'arborescence et créez deux 
nouveaux groupes : Dimensions du plan et Dimensions de l'élévation.

• Réglez le plan de travail (Working Plane) sur le plan XY.

• Assurez-vous que l’option Accrochage restreint (  restrict) est activée, de sorte que tout ce que vous
dessinez reste sur le plan de travail.

• Dessinez quelques cotes (  dimensions), par exemple comme sur l'image ci-dessous. En appuyant 
sur Shift et Ctrl tout en cliquant sur les points de cote, vous obtiendrez des options supplémentaires.
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• Sélectionnez toutes vos cotes et faites-les glisser vers le groupe Dimensions du Plan dans 
l'arborescence.

• Réglez le plan de travail (Working Plane) sur le plan XZ, c'est-à-dire le plan vertical frontal.

• Répétez l'opération, dessinez quelques cotes et placez-les dans le groupe Dimensions d'élévation.
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Nous allons maintenant préparer un ensemble de vues à partir de notre modèle, qui seront organisées sur une
feuille de dessin. Nous pouvons le faire avec les outils de l’atelier Dessin (Drawing), comme nous l'avons vu 
dans le chapitre précédent, mais l'atelier Arch offre également un outil avancé tout-en-un pour produire des 
vues planes, de section et d'élévation, appelées Plans de coupe (Section Plane). Nous allons maintenant 
ajouter deux de ces plans de section, pour créer une vue en plan et une vue en élévation.

• Sélectionnez l'objet Bâtiment (building) dans l'arborescence.

• Appuyez sur le bouton Plan de coupe (  Section Plane).

• Définissez sa propriété de hauteur d'affichage à 5 m, sa longueur d'affichage à 6 m, donc nous 
englobons notre maison (ce n'est pas nécessaire, mais ce sera mieux, car cela montrera naturellement
à quoi sert cet outil) et sa position de Placement à x: 2 m , Y: 1,5 m, z: 1,5 m.

• Vérifiez la liste des objets considérés par le plan de section en double-cliquant dessus dans 
l'arborescence. Les plans de coupe ne rendent que des objets spécifiés du modèle, pas tous. Les 
objets considérés par le plan de coupe peuvent être modifiés ici.

• Répétez l'opération pour créer un autre plan de coupe, donnez-lui la même longueur et hauteur 
d'affichage, et donnez-lui le Placement suivant: position: x: 2m, y: -2m, z: 1.5m, angle: 90 °, axe: x: 1, 
y: 0, z: 0. Assurez-vous que ce nouveau plan de coupe considère également l'objet Bâtiment.
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• Maintenant, nous avons tout ce dont nous avons besoin, et nous pouvons créer notre feuille de dessin.
Commencez par passer à l’atelier Drawing (Drawing Workbench) et créez une nouvelle page par 

défaut A3 Paysage (  A3 page) (ou sélectionnez un autre modèle si vous le souhaitez).

• Sélectionnez le premier plan de coupe, utilisé pour la vue en plan.

• Appuyez sur le bouton Créer une vue (  Draft View). Cet outil offre quelques fonctionnalités 
supplémentaires par rapport à l'outil de conception de dessin standard (Drawing View) et prend en 
charge les plans de coupe de l'atelier Arch.

• Donnez à la nouvelle vue les propriétés suivantes :

◦ X: 50

◦ Y: 140

◦ Échelle: 0,03

◦ Largeur de ligne: 0.15

◦ Montrer la coupe: vrai

◦ Afficher le remplissage: vrai

• Sélectionnez l'autre plan de section et créez une nouvelle vue, avec les propriétés suivantes :

◦ X: 250

◦ Y: 150

◦ Échelle: 0,03

◦ Rendu: solide
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Nous allons maintenant créer deux nouvelles vues, une pour chaque groupe de dimensions.

• Sélectionnez le groupe Dimensions du plan.

• Appuyez sur le bouton Créer une vue (  Draft View).

• Donnez à la nouvelle vue les propriétés suivantes :

◦ X: 50

◦ Y: 140

◦ Échelle: 0,03

◦ Largeur de ligne: 0.15

◦ Taille de la police: 10mm

• Répétez l'opération pour l'autre groupe, avec les paramètres suivants :

◦ X: 250

◦ Y: 150

◦ Échelle: 0,03

◦ Largeur de ligne: 0.15

◦ Taille de la police: 10mm

◦ Direction: 0, -1,0

◦ Rotation: 90 °
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Notre page est maintenant prête, et nous pouvons l'exporter vers les formats SVG ou DXF ou l'imprimer. Le 
format SVG permet d'ouvrir les applications d'illustration de fichiers telles que inkscape, avec lesquelles vous 
pouvez rapidement améliorer les dessins techniques et les transformer en dessins de présentation beaucoup 
plus agréable. Il offre beaucoup plus de possibilités que le format DXF.

Téléchargements

• Le fichier produit lors de cet exercice: 
https://github.com/yorikvanhavre/FreeCADmanual/Blob/master/files/house.FCStd 

• Le fichier IFC exporté à partir du fichier ci-dessus: 
https://github.com/yorikvanhavre/FreeCADmanual/Blob/master/files/house.ifc 

• Le fichier SVG exporté à partir du fichier ci-dessus: 
https://github.com/yorikvanhavre/FreeCADmanual/Blob/master/files/house.svg 

Lire plus d'informations

• L’atelier Arch: http://www.freecadweb.org/wiki/index.php?title=Arch_Module 

• Le plan de travail: http://www.freecadweb.org/wiki/index.php?Title=Draft_SelectPlane 

• Les paramètres d'accrochage: http://www.freecadweb.org/wiki/index.php?title=Draft_Snap 

• Le système d'expressions: http://www.freecadweb.org/wiki/index.php?title=Expressions 

• Le format IFC: https://en.wikipedia.org/wiki/Industry_Foundation_Classes 

• IfcOpenShell: http://ifcopenshell.org/ 

• IfcPlusPlus: http://ifcplusplus.com/ 

• Inkscape: http://www.inkscape.org
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1-3-8 Utilisation de feuilles de calcul
FreeCAD dispose d'un autre atelier intéressant à explorer : l’atelier Feuilles de calcul (Spreadsheet 
Workbench). Cet atelier permet de créer des feuilles de calcul telles que celles réalisées avec Excel ou 
LibreOffice directement dans FreeCAD. Ces feuilles de calcul peuvent ensuite être remplies avec des données
extraites de votre modèle et peuvent également effectuer une série de calculs entre les valeurs. Les feuilles de
calcul peuvent être exportées sous forme de fichiers CSV, qui peuvent être importés dans n'importe quelle 
autre application de tableur.

Dans FreeCAD, cependant, les feuilles de calcul ont une utilité supplémentaire : leurs cellules peuvent 
recevoir un nom et peuvent être référencées par n'importe quel champ pris en charge par le moteur des 
expressions (expressions engine). Cela transforme les feuilles de calcul en puissantes structures de contrôle, 
où les valeurs insérées dans des cellules spécifiques peuvent générer des dimensions du modèle. Il n'y a 
qu'une chose à garder à l'esprit, car FreeCAD interdit les dépendances circulaires entre les objets, une même 
feuille de calcul ne peut pas être utilisée pour définir une propriété d'un objet et, en même temps, récupérer 
une valeur de propriété à partir du même objet. Cela rendrait la feuille de calcul et l'objet dépendant l’un de 
l'autre.

Dans l'exemple suivant, nous allons créer quelques objets, récupérer certaines de leurs propriétés dans une 
feuille de calcul, puis utiliser la feuille de calcul pour générer directement les propriétés d'autres objets.

1-3-8-1 Lecture des propriétés

• Commencez par passer à l’atelier Part (Part Workbench), et créez quelques objets : une boîte (  box),

un cylindre (  cylinder) et une sphère (  sphere).

• Modifiez leur propriété de Placement (ou utilisez l'outil Déplacer Draft Move) pour les séparer un 
peu, afin que nous puissions mieux observer les effets de ce que nous allons faire :

06/06/17 Manuel_Freecad.odt Page 125 / 166

https://www.freecadweb.org/wiki/Draft_Move
https://www.freecadweb.org/wiki/Part_Sphere
https://www.freecadweb.org/wiki/Part_Cylinder
https://www.freecadweb.org/wiki/Part_Box
https://www.freecadweb.org/wiki/Part_Workbench
https://www.freecadweb.org/wiki/Expressions
https://en.wikipedia.org/wiki/OpenOffice.org_Calc
https://en.wikipedia.org/wiki/Microsoft_Excel
https://www.freecadweb.org/wiki/Spreadsheet_Module
https://www.freecadweb.org/wiki/Spreadsheet_Module
https://www.freecadweb.org/wiki/File:Part_Box.png
https://www.freecadweb.org/wiki/File:Part_Cylinder.png
https://www.freecadweb.org/wiki/File:Part_Sphere.png
https://www.freecadweb.org/wiki/File:Draft_Move.png


• Maintenant, on va extraire des informations sur ces objets. Passez à l'atelier Feuille de calcul 
(Spreadsheet Workbench).

• Appuyez sur le bouton  Nouvelle feuille de calcul (  New Spreadsheet).

• Double-cliquez sur l'objet Nouvelle feuille de calcul dans l'arborescence. L'éditeur de feuille de calcul 
s'ouvre :

L'éditeur de feuilles de calcul de FreeCAD, bien qu'il ne soit pas aussi complet et puissant que les applications
de tableurs plus complètes que nous avons énumérées ci-dessus, a néanmoins la plupart des outils et des 
fonctions de base couramment utilisés, comme la possibilité de modifier l'aspect des cellules (Taille, couleur, 
alignement), joindre et diviser les cellules, utiliser des formules telles que =2+2, ou référencer d'autres cellules
avec =B1.

Dans FreeCAD, à ces comportements communs, on a ajouté une possibilité très intéressante : la possibilité 
de faire référence non seulement à d'autres cellules, mais aussi d'autres objets du document, et de récupérer 
des valeurs à partir de leurs propriétés. Par exemple, récupérons quelques propriétés des 3 objets que nous 
avons créés ci-dessus. Les propriétés sont ce que nous pouvons voir dans la fenêtre de l'éditeur de 
propriétés, sous l'onglet Données (Data ), lorsqu'un objet est sélectionné.

• Commençons par entrer quelques textes dans les cellules A1, A2 et A3, alors nous nous souvenons de
ce qui se passera plus tard, par exemple Cube Length (longueur de l’arête du cube), Cylinder Radius
(rayon du cylindre) et Sphere Radius (rayon de la sphère). Pour entrer du texte, écrivez simplement 
dans le « Conteneur » disposé au-dessus de la feuille de calcul ou double-cliquez sur une cellule.
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• Maintenant, récupérons la longueur réelle de notre cube. Dans la cellule B1, tapez =Cube.Length. 
Vous remarquerez que la feuille de calcul possède un mécanisme de remplissage automatique, qui est
en fait le même que l'éditeur d'expression que nous avons utilisé dans le chapitre précédent.

• Faites de même pour la cellule B2 (=Cylinder.Radius) et B3 (=Sphere.Radius).

• Bien que ces résultats soient exprimés avec leurs unités, les valeurs peuvent être manipulées comme 
n'importe quel nombre, essayez, par exemple, d'entrer dans la cellule C1 : =B1*2.

• Nous pouvons maintenant modifier une de ces valeurs dans l'éditeur de propriétés, et la modification 
sera immédiatement reflétée dans la feuille de calcul. Par exemple, modifions la longueur de notre 
cube à 20mm :
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La page Spreadsheet Workbench décrit plus en détail toutes les opérations et fonctions possibles que vous 
pouvez utiliser dans les feuilles de calcul.

1-3-8-2 Ecriture de propriétés
Une autre utilisation très intéressante de l’atelier Feuilles de calcul dans FreeCAD est de faire le contraire de 
ce que nous avons fait jusqu'ici : au lieu de lire les valeurs des propriétés des objets 3D, nous pouvons 
également attribuer des valeurs à ces objets. Rappelez-vous, cependant, une des règles fondamentales de 
FreeCAD : les dépendances circulaires sont interdites. Nous ne pouvons donc pas utiliser la même feuille de 
calcul pour lire et écrire des valeurs sur un objet 3D. Cela rendrait l'objet dépendant de la feuille de calcul, qui 
dépendrait également de l'objet. Au lieu de cela, nous allons créer une autre feuille de calcul.

• Nous pouvons maintenant fermer l'onglet tableur (sous la vue 3D). Ceci n'est pas obligatoire, il n'y a 
pas de problème pour ouvrir plusieurs feuilles de calcul.

• Appuyez de nouveau sur le bouton Nouvelle feuille de calcul (  New Spreadsheet).

• Modifiez le nom de la nouvelle feuille de calcul en quelque chose de plus significatif, comme Entrée 
(faites-le en cliquant avec le bouton droit de la souris sur la nouvelle feuille de calcul et en choisissant 
Renommer).

• Double-cliquez sur la feuille de calcul Entrée pour ouvrir l'éditeur du tableur.

• Dans la cellule A1, mettons un texte descriptif, par exemple: "Dimensions du cube".

• Dans la cellule B1, écrivez =5mm (en utilisant le signe = on s'assure que la valeur est interprétée 
comme une valeur numérique, pas un texte).
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• Maintenant, pour pouvoir utiliser cette valeur en dehors de la feuille de calcul, nous devons donner un 
nom ou alias à la cellule B1. Cliquez avec le bouton droit sur les cellules, cliquez sur Propriétés et 
sélectionnez l'onglet Alias. Donnez-lui un nom, tel que cubedims :

• Appuyez sur OK, puis fermez l'onglet tableur.

• Sélectionnez l'objet cube.

• Dans l'éditeur de propriétés, cliquez sur la petite icône Expression (  expression ) située sur le côté 
droit du champ Longueur. Cela ouvrira l'éditeur d'expressions (expressions editor), où vous pouvez 
écrire Spreadsheet001.cubedims. Répétez ceci pour Hauteur et Largeur :
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Vous pourriez vous demander pourquoi nous devons utiliser "Spreadsheet001" au lieu de "Input" dans 
l'expression ci-dessus. C'est parce que chaque objet, dans un document FreeCAD, a un nom interne, unique 
dans le document, et une étiquette, qui apparait dans l'arborescence. Si vous désactivez l'option appropriée 
dans les paramètres de préférences, FreeCAD vous permettra de donner la même étiquette à plus d'un objet. 
C'est pourquoi toutes les opérations qui doivent identifier un objet sans aucun doute, utiliseront le nom interne 
au lieu de l'étiquette, qui pourrait désigner plus d'un objet. Le moyen le plus simple de connaître le nom 
interne d'un objet est en gardant ouvert le panneau de sélection (Menu Edition-> Panneaux), il indiquera 
toujours le nom interne d'un objet sélectionné :
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En utilisant des alias dans les cellules dans des feuilles de calcul, nous pouvons utiliser une feuille de calcul 
pour stocker des "valeurs de base" dans un document FreeCAD. Cela peut être utilisé, par exemple, pour 
avoir certaines dimensions d'un modèle et pour stocker ces dimensions dans une feuille de calcul. Il devient 
alors très facile de produire un autre modèle avec des dimensions différentes, il s'agit simplement d'ouvrir le 
fichier et de modifier quelques dimensions dans la feuille de calcul.

Enfin, notez que les contraintes dans un croquis peuvent également recevoir la valeur d'une cellule de 
tableur :

Vous pouvez également donner des alias aux contraintes dimensionnelles (horizontales, verticales ou 
distances) dans une esquisse (vous pouvez ensuite utiliser ces valeurs à l'extérieur de l’esquisse) :
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Télécharger

• Le fichier produit dans cet exercice: 
https://github.com/yorikvanhavre/FreeCADmanual/Blob/master/files/spreadsheet.FCStd 

Lire plus d'informations

• L'atelier Feuilles de calcul: http://www.freecadweb.org/wiki/index.php?Title=Spreadsheet_Module 

• Le moteur Expressions: http://www.freecadweb.org/wiki/index.php?title=Expressions
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1-3-9 Création d'analyses FEM
FEM signifie Méthode des éléments finis (Finite Element Method). Il s'agit d'un vaste sujet mathématique, 
mais dans FreeCAD, nous pouvons résumer cela comme moyen de calculer les propagations à l'intérieur d'un 
objet 3D, en le coupant en petits morceaux et en analysant l'impact de chaque petit morceau sur ses voisins. 
Cela a plusieurs utilisations dans les domaines de l'ingénierie et de l'électromagnétisme, mais nous 
examinerons plus en profondeur une seule utilisation déjà développée dans FreeCAD, qui simule des 
déformations dans des objets soumis à des forces et à des poids.

L'obtention de cette simulation se fait dans FreeCAD avec l’atelier FEM (FEM Workbench). Cela implique 
différentes étapes : Préparer la géométrie, définir son matériau, effectuer le maillage, diviser en parties plus 
petites, comme nous l'avons fait dans le chapitre Préparer les objets pour l’impression 3D (Preparing 
objects for 3D printing), et finalement calculer la simulation.

Préparation de FreeCAD

La simulation elle-même est réalisée par un autre logiciel, utilisé par FreeCAD pour obtenir les résultats. 
Comme il existe plusieurs applications de simulation FEM intéressantes disponibles, l’atelier FEM (FEM 
Workbench) a été conçu pour pouvoir en utiliser plus d'une. Cependant, actuellement, seul CalculiX  est 
entièrement implémenté. Un autre logiciel, appelé NetGen, qui est responsable de la génération du maillage 
de subdivision, est également nécessaire. Des instructions détaillées pour installer ces deux composants sont 
fournies dans la documentation FreeCAD (FreeCAD documentation).
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Préparation de la géométrie

Nous allons commencer avec la maison que nous avons modélisée dans le chapitre de modélisation BIM (BIM
modeling). Cependant, certains changements doivent être apportés pour rendre le modèle adapté aux calculs 
FEM. Cela implique essentiellement de rejeter les objets que nous ne voulons pas inclure dans le calcul, 
comme la porte et la fenêtre, et de joindre tous les objets restants en un seul.

• Chargez le modèle de maison que nous avons modélisé précédemment.

• Supprimez ou masquez l'objet de la page, les plans de section et les dimensions, de sorte qu’il ne 
nous reste que notre modèle.

• Cachez la fenêtre, la porte et la dalle de sol.

• Masquez également les poutres métalliques du toit. Comme ce sont des objets très différents du reste 
de la maison, nous simplifierons notre calcul en ne l'incluant pas. Au lieu de cela, nous considérons 
que la dalle du toit est directement placée sur le dessus du mur.

• Maintenant, déplacez la dalle du toit vers le bas, de sorte qu'elle repose sur le mur : éditez l'objet 
Rectangle que nous avons utilisé comme base de la dalle du toit et changez son Positionnement-> 
Position-> Valeur X de 3,18 m à 3,00 m.

• Notre modèle est maintenant propre :

• L’atelier FEM peut actuellement calculer des déformations sur un seul objet. Par conséquent, nous 
devons joindre nos deux objets (le mur et la dalle). Passez à l’atelier Part (Part Workbench), 

sélectionnez les deux objets et appuyez sur Union (  Union). Nous avons maintenant obtenu un objet 
fusionné :
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Création de l'analyse

• Nous sommes maintenant prêts à commencer une analyse FEM. Passons à l’atelier FEM.

• Sélectionnez l'objet résultat de la fusion.

• Appuyez sur le bouton Nouvelle analyse (  New Analysis).

• Une nouvelle analyse sera créée et des panneaux de configuration seront ouverts. Ici, vous pouvez 
définir les paramètres de maillage à utiliser pour produire le maillage FEM. Le paramètre principal à 
éditer est la taille maximale qui définit la taille maximale (en millimètres) de chaque pièce du maillage.
Pour l'instant, nous pouvons laisser la valeur par défaut de 1000 :
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• Après avoir appuyé sur OK et quelques secondes de calcul, notre maillage FEM est maintenant prêt :
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• Nous pouvons maintenant définir le matériau à appliquer à notre maillage. Ceci est important car, en 
fonction de la force matérielle, notre objet réagira différemment aux forces qui lui sont appliquées. 

Sélectionnez l'objet d'analyse et appuyez sur le bouton Nouveau matériau (  New Material).

• Un panneau de tâches s'ouvrira pour nous permettre de choisir un matériau. Dans la liste déroulante 
Matériaux, choisissez le matériau en béton générique et appuyez sur OK.

• Nous sommes maintenant prêts à appliquer des forces. Commençons par préciser quelles faces sont 

fixées dans le sol et ne peuvent donc pas bouger. Appuyez sur le bouton Contrainte Fixe (
Constraint).

• Cliquez sur la face inférieure de notre bâtiment et appuyez sur OK. La face inférieure est maintenant 
indiquée comme inébranlable :
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• Nous allons maintenant ajouter une charge sur la face supérieure, qui pourrait représenter, par 
exemple, un poids massif sur le toit. Pour cela, nous utiliserons une contrainte de pression. Appuyez 

sur le bouton Contrainte de pression (  Constraint pressure).

• Cliquez sur la face supérieure du toit, mettez la pression sur 10 MPa (la pression est appliquée par 
millimètre carré) et cliquez sur le bouton OK. Notre force est maintenant appliquée :
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• Nous sommes maintenant prêts à commencer le calcul. Sélectionnez l'objet CalculiX dans 

l'arborescence et appuyez sur le bouton Démarrer Calcul (  Start Calculation).

• Dans le panneau de tâches qui s'ouvrira, cliquez d'abord sur le bouton Écrire le fichier .inp pour créer
le fichier d'entrée pour CalculiX, puis le bouton Exécuter CalculiX. Quelques instants après, le calcul 
sera effectué :
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• Nous pouvons maintenant regarder les résultats. Fermez le panneau des tâches et voyez qu'un nouvel
objet Résultats a été ajouté à notre analyse.

• Double-cliquez sur l'objet Résultats.

• Définissez le type de résultat que vous souhaitez voir sur le maillage, par exemple "déplacement 
absolu", cochez la case à cocher affichage sous Déplacement et déplacez le curseur à côté de celui-
ci. Vous pourrez voir la déformation augmenter lorsque vous appliquez plus de force :
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Les résultats affichés par l'atelier FEM ne sont évidemment pas suffisantes pour prendre des décisions dans la
vie réelle sur le dimensionnement des structures et les matériaux. Cependant, ils peuvent déjà donner des 
informations précieuses sur la façon dont les forces traversent une structure et quelles sont les zones faibles 
qui auront plus de stress.

Téléchargements

• Le fichier créé lors de cet exercice: https://github.com/yorikvanhavre/FreeCAD-
m  anual/blob/master/files/fem.FCStd 

Lire plus d'informations

• L’atelier FEM: http://www.freecadweb.org/wiki/index.php?title=Fem_atelier 

• Installation des composants requis de l’atelier FEM: http://www.freecadweb.org/wiki/index.php?
Title=FEM_Install 

• CalculiX: http://www.calculix.de/ 

• NetGen: https://sourceforge.net/projects/netgen-mesher/
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1-3-10 Création de rendus
Dans le langage des ordinateurs, un rendu (rendering) est un mot utilisé pour décrire une belle image produite
à partir d'une maquette 3D. Bien sûr, nous pourrions dire que ce que vous voyez dans la vue 3D FreeCAD est 
déjà sympa. Mais quiconque a vu un film récent de Hollywood sait qu'il est possible de produire des images 
avec un ordinateur qui ne se distinguent guère d'une photographie.

Bien sûr, produire de telles images photo-réalistes nécessite beaucoup de travail et une application 3D qui 
offre des outils spécifiques à cela, tels que des contrôles précis pour les matériaux et l'éclairage. FreeCAD 
étant une application plus orientée vers la modélisation technique, elle ne présente pas d’outil de rendu 
avancé.

Heureusement, le monde open-source offre de nombreuses applications pour produire des images réalistes. 
Probablement le plus célèbre est Blender, qui est très populaire et largement utilisé dans les industries du 
cinéma et du jeu. Les modèles 3D peuvent très facilement et fidèlement être exportés de FreeCAD et importés
dans Blender, où vous pouvez ajouter des matériaux et des éclairages réalistes, et produire les images finales
ou même des animations.

Certains autres outils de rendu open source sont conçus pour être utilisés dans une autre application, et 
prendront soin de faire les calculs complexes pour produire des images réalistes. À travers son atelier 
Raytracing (Raytracing Workbench), FreeCAD peut utiliser deux de ces outils de rendu : POV-Ray et 
Luxrender. POV-Ray est un projet très ancien, et est considéré comme un moteur classique de raytracing, 
tandis que Luxrender est beaucoup plus récent et est catégorisé comme un moteur de rendu impartial 
(unbiased renderer). Les deux ont leurs points forts et leurs faiblesses, selon le type d'image que l'on veut 
rendre. La meilleure façon de savoir est de regarder des exemples sur les deux sites Web des moteurs de 
rendu.

Installation

Avant d'être en mesure d'utiliser l'un de ces deux rendus dans l’atelier Raytracing dans FreeCAD, les 
applications doivent être installées sur votre système. C'est généralement très simple, les deux installateurs 
sont fournis pour de nombreuses plates-formes ou sont généralement inclus dans les référentiels logiciels de 
la plupart des distributions Linux.

Une fois que POV-Ray ou Luxrender est installé, nous devons définir le chemin d'accès à son exécutable 
principal dans les préférences de FreeCAD. Cela n'est généralement nécessaire que sur Windows et Mac. Sur
Linux FreeCAD va le choisir parmi les emplacements standard. L'emplacement des exécutables de Povray ou 
Luxrender peut être trouvé en recherchant simplement dans votre système les fichiers appelés Povray (ou 
Povray.exe sur Windows) et Luxrender (ou Luxrender.exe sur Windows).
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Dans cet écran de préférences, nous pouvons également définir la taille d'image souhaitée que nous voulons 
produire.

Rendu avec PovRay

Nous allons utiliser la table que nous avons modélisée dans le chapitre sur la modélisation traditionnelle 
(tradtional modeling) pour produire des rendus avec PovRay et Luxrender.

• Commencez par charger le fichier table.FCStd que nous avons modélisé plus tôt ou à partir du lien au 
bas de ce chapitre.

• Appuyez sur la petite flèche vers le bas à côté du bouton Nouveau projet Povray (  New Povray 
project), et choisissez le modèle RadiosityNormal.

• Un message d'avertissement peut apparaître indiquant que la vue en 3D actuelle n'est pas dans le 
mode perspective et le rendu sera donc différent. Corrigez ceci en choisissant Non, en allant dans le 
menu Affichage-> Vue en perspective et en choisissant à nouveau le modèle RadiosityNormal.

• Vous pouvez également essayer d'autres modèles après avoir créé un nouveau projet, simplement en 
éditant les Propriétés du modèle.

• Un nouveau projet a été créé :
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• Le nouveau projet a adopté le point de vue de la vue 3D comme il était au moment où nous avons 
appuyé sur le bouton. Nous pouvons modifier la vue et mettre à jour la position de vue stockée dans le 

projet Povray en tout temps, en appuyant sur le bouton Réinitialiser la caméra (  Reset camera).

• L’atelier Raytracing fonctionne de la même manière que l’atelier Drawing (Drawing Workbench) : une 
fois que le dossier de projet est créé, nous devons ajouter des vues de nos objets. Nous pouvons 
maintenant le faire en sélectionnant tous les objets qui composent la table, en appuyant sur le bouton 

Insérer une pièce (  Insert part) :

• Les vues ont pris les valeurs de couleur et de transparence à partir de leurs pièces d'origine, mais vous
pouvez modifier cela dans les propriétés de chaque vue individuelle si vous le souhaitez.

• Nous sommes maintenant prêts à produire notre premier rendu avec Povray. Appuyez sur le bouton 

Effectuer le rendu (  Render).
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• Remarque pour les utilisateurs de Windows : lors de la réception (dans povray) d'un avertissement 
indiquant que "les restrictions d'E / S interdisent l'accès en écriture ..."

◦ Ouvrez Povray.

◦ Choisissez "Options> Restrictions E / S du script" et assurez-vous qu'il est défini sur "Aucune 
restriction"

◦ Relancez  Effectuer le rendu.

• Vous devrez donner un nom de fichier et un chemin d'accès pour l'image .png qui sera enregistrée par 
Povray.

• L'application Povray se lancera et calculera alors l'image.

• Lorsque cela est fait, cliquez simplement sur l'image pour fermer la fenêtre de povray. Le résultat de 
l'image sera chargée dans FreeCAD :

Rendu avec LuxRender

• Le rendu avec Luxrender fonctionne presque de la même manière. Nous pouvons laisser notre dossier
ouvert et créer un nouveau projet Luxrender dans le même fichier, ou le recharger pour démarrer à 
partir de zéro.

• Appuyez sur la petite flèche vers le bas à côté du bouton Nouveau projet Luxrender (  New Luxrender
project) et choisissez le Modèle LuxOutdoor.

• Sélectionnez tous les composants de la table. Si vous avez toujours le projet Povray dans votre 
document, assurez-vous également de sélectionner le projet lux lui-même, de sorte que les vues 
créées dans la prochaine étape ne vont pas dans le mauvais projet par erreur.

• Appuyez sur le bouton Insérer une pièce (  Insert part).

• Sélectionnez le projet Luxrender et appuyez sur le bouton Effectuer le rendu (  Render).
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• Luxrender fonctionne différemment de Povray. Lorsque vous démarrez le rendu, l'application luxrender 
s'ouvre et commence immédiatement le calcul du rendu :

• Si vous quittez la fenêtre ouverte, Luxrender continuera à calculer et à donner le rendu définitif, en 
affinant progressivement l'image. C'est à vous de décider quand l'image atteint une qualité suffisante 
pour vos besoins et d’arrêter le calcul du rendu.

• Il existe également de nombreux contrôles à tester ou régler, sur le panneau de gauche. Tous ces 
contrôles modifient l'aspect de l'image en temps réel, sans arrêter le calcul du rendu.

• Lorsque vous estimez que la qualité est suffisante, appuyez simplement sur Calcul du Rendu-> stop, 
puis sur Fichier-> Exporter vers une image-> Gamme dynamique faible en mode toner (File-
>Export to image->Tonemapped low dynamic range ) pour enregistrer l'image rendue dans un 
fichier .Png.

Vous pouvez étendre considérablement les possibilités de rendu de FreeCAD en créant de nouveaux modèles
pour Povray ou Luxrender. Ceci est expliqué dans la documentation de l’atelier Raytracing (Raytracing 
Workbench documentation).

Téléchargements

• Le modèle de table: https://github.com/yorikvanhavre/FreeCADmanual/Blob/master/files/table.FCStd 

• Le fichier produit lors de cet exercice: 
https://github.com/yorikvanhavre/FreeCADmanual/  b  lob/master/files/render.FCStd 

Lire plus d'informations

• L’atelier Raytracing: http://www.freecadweb.org/wiki/index.php?  t  itle=Raytracing_Module 

• Blender: http://www.blender.org

• POV-Ray: http://www.povray.org 

• Luxrender: http://www.luxrender.net 
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1-4 Scripts Python

1-4-1 Une introduction douce
Python est un langage de programmation open-source largement répandu, très souvent utilisé comme 
langage de script, intégré dans les applications, comme c'est le cas avec FreeCAD. Il a également une série 
de fonctionnalités qui le rend particulièrement intéressant pour nous les utilisateurs de FreeCAD : il est très 
facile à apprendre, spécialement pour les personnes qui n'avaient jamais programmé auparavant, et il est 
intégré dans beaucoup d'autres applications, ce qui en fait un outil très précieux à apprendre, car vous pourrez
l'utiliser dans de nombreuses autres applications, telles que Blender, Inkscape ou GRASS.

FreeCAD utilise largement Python. Avec cela, vous pouvez accéder et contrôler presque toutes les 
caractéristiques de FreeCAD. Vous pouvez, par exemple, créer de nouveaux objets, modifier leur géométrie, 
analyser leur contenu, ou même créer de nouveaux contrôles d'interface, des outils et des panneaux. Certains
ateliers de FreeCAD et la plupart des ateliers supplémentaires sont entièrement programmés en python. 
FreeCAD dispose d'une console python avancée, disponible dans le menu Affichage-> Panneaux-> Console
Python. Il est souvent utile pour effectuer des opérations pour lesquelles il n'existe pas encore de barre 
d'outils, ou pour vérifier des formes pour certains problèmes, ou pour effectuer des tâches répétitives :

Mais la console python a également une autre utilisation très importante : chaque fois que vous appuyez sur 
un bouton d’une barre d'outils ou effectuez d'autres opérations dans FreeCAD, un code python est imprimé 
dans la console et exécuté. En laissant la console Python ouverte, vous pouvez voir littéralement le code 
Python se dérouler au fur et à mesure que vous travaillez, et en un rien de temps, presque sans le savoir, 
vous apprendrez quelques éléments du langage python.

FreeCAD possède également un système de macros (macros system) qui vous permet d'enregistrer les 
actions à reproduire plus tard. Ce système utilise également la console Python, en enregistrant simplement 
tout ce qui est fait.

Dans ce chapitre, nous découvrirons très généralement le langage Python. Si vous êtes interessé pour en 
apprendre davantage, le wiki de la documentation de FreeCAD contient une vaste section liée à la 
programmation Python (python programming).

1-4-1-1 Ecriture du code Python
Il existe deux façons simples d'écrire le code python dans FreeCAD : à partir de la console python (menu 
Affichage -> Panneaux -> Console Python), ou à partir de l'Éditeur Macro (menu Outils -> Macros → 
Nouveau). Dans la console, vous écrivez les commandes python une par une, qui sont exécutées lorsque 
vous appuyez sur retour, alors que les macros peuvent contenir un script plus complexe composé de plusieurs
lignes, qui n'est exécuté que lorsque la macro est lancée à partir de la même fenêtre Macros.
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Dans ce chapitre, vous pourrez utiliser les deux méthodes, mais il est fortement recommandé d'utiliser la 
Console Python, car elle vous informera immédiatement de toute erreur que vous pourrez faire lors de la 
saisie.

Si c'est la première fois que vous utilisez le codage Python, pensez à lire cette brève introduction à la 
programmation Python (introduction to Python programming) avant d'aller plus loin, cela rendra les concepts 
de base de Python plus clairs.

1-4-1-2 Manipulation d'objets FreeCAD
Commençons par créer un nouveau document vide :

Doc = FreeCAD.newDocument ()

Si vous tapez ceci dans la console python de FreeCAD, vous remarquerez que dès que vous entrez 
"FreeCAD." (le mot FreeCAD suivi d'un point), une fenêtre apparaît, permettant rapidement de compléter le 
reste de votre ligne. Encore mieux, chaque entrée dans la liste des autocomplétions a une bulle d’aide 
expliquant ce qu'elle fait. Il est donc très facile d'explorer la fonctionnalité disponible.

Avant de choisir "newDocument", regardez les autres options disponibles.

Dès que vous appuyez sur Entrée, notre nouveau document sera créé. Cela ressemble à la pression sur le 
bouton "nouveau document" dans la barre d'outils. En Python, le point sert à indiquer quelque chose qui est 
contenu dans quelque chose d'autre (newDocument est une fonction qui se trouve dans le module FreeCAD). 
La fenêtre qui s'affiche vous montre donc tout ce qui est contenu dans "FreeCAD". Si vous souhaitiez ajouter 
un point après le nouveau document, au lieu des parenthèses, cela vous montrerait tout ce qui est contenu 
dans la nouvelle fonction newDocument. Les parenthèses sont obligatoires lorsque vous appelez une fonction 
Python, comme celle-ci. Nous allons mieux illustrer cela ci-dessous.

Revenons maintenant à notre document. Voyons ce que nous pouvons faire avec ça :

doc.

Explorez les options disponibles. Habituellement, les noms qui commencent par une lettre majuscule sont des 
attributs, ils contiennent une valeur, alors que les noms commençant par une petite lettre sont des fonctions 
(également appelées méthodes), ils "font quelque chose". Les noms commençant par un trait de soulignement
sont habituellement là pour le fonctionnement interne du module, et vous ne devriez pas vous en occuper. 
Utilisons l'une des méthodes pour ajouter un nouvel objet à notre document :

box=doc.addObject("Part::Box","myBox")

Notre boîte est ajoutée dans l'arborescence, mais rien ne se passe encore dans la vue 3D, car quand on  
travaille avec Python, le document n'est jamais recalculé automatiquement. Nous devons le faire 
manuellement, chaque fois que nous avons besoin :

Doc.recompute()
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Maintenant, notre boîte est apparue dans la vue 3D. Beaucoup des boutons de la barre d'outils qui ajoutent 
des objets dans FreeCAD font en fait deux choses : ils ajoutent l'objet et recalculent. Si vous avez activé 
l’option "montrer les commandes du script dans la console python" ci-dessus, essayez maintenant d'ajouter 
une sphère avec le bouton approprié dans l’atelier Part, et vous verrez les deux lignes du code python 
exécutées l'une après l'autre.

Vous pouvez obtenir une liste de tous les types d'objets possibles, comme Part :: Box:

Doc.supportedTypes()

Voyons maintenant le contenu de notre boîte :

box.

Vous verrez immédiatement quelques choses très intéressantes telles que :

box.Hight

Cela va imprimer la hauteur actuelle de notre boîte. Maintenant, essayons de changer cela :

box.Height=5

Si vous sélectionnez votre boîte avec la souris, vous verrez cela dans le panneau des propriétés, sous l’onglet
Données, notre propriété Hauteur apparaît avec la nouvelle valeur. Toutes les propriétés d'un objet FreeCAD 
qui apparaissent dans les onglets Données et Affichage sont directement accessibles par Python aussi, par 
leur noms, comme nous l'avons fait avec la propriété Height. Les propriétés des données sont accessibles 
directement depuis l’objet lui-même, par exemple :

Box.Length

Les propriétés de vue sont stockées dans un ViewObject. Chaque objet FreeCAd possède un ViewObject, qui
stocke les propriétés de visualisation de l'objet. Lors de l'exécution de FreeCAD sans son interface graphique 
(par exemple lors du lancement par un terminal avec  l’option de ligne de commande -c, ou l'utilisation à partir 
d'un autre script Python), le ViewObject n'est pas disponible, car Il n'y a pas de visuel du tout.

Par exemple, pour accéder à la couleur de ligne de notre boîte :

Box.ViewObject.LineColor

1-4-1-3 Vecteurs et emplacements
Les vecteurs sont un concept très fondamental dans n'importe quelle application 3D. C'est une liste de 3 
nombres (x, y et z), décrivant un point ou une position dans l'espace 3D. Beaucoup de choses peuvent être 
faites avec les vecteurs, telles que des ajouts, des soustractions, des projections et bien plus encore. Dans les
vecteurs FreeCAD travaillez comme ceci :

myvec=FreeCAD.Vector(2,0,0)
print(myvec)
print(myvec.x)
print(myvec.y)
othervec=FreeCAD.Vector(0,3,0)
sumvec=myvec.add(othervec)

Une autre caractéristique commune des objets FreeCAD est leur Positionnement (placement). Comme nous 
l'avons vu dans les chapitres précédents, chaque objet a une propriété de placement, qui contient la position 
(Base) et orientation (Rotation) de l'objet. Il est facile de manipuler avec Python, par exemple pour déplacer 
notre objet :
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print(box.Placement)
print(box.Placement.Base)
box.Placement.Base=sumvec
otherpla=FreeCAD.Placement()
otherpla.Base=FreeCAD.Vector(5,5,0)
box.Placement=otherpla

Lire plus d'informations

• Python: https://www.python.org/ 

• Travailler avec les macros: http://www.freecadweb.org/wiki/index.php?title=Macros 

• Introduction au script Python: http://www.freecadweb.org/wiki/index.php?Title=Introduction_to_Python 

• Utilisation de Python dans FreeCAD: http://www.freecadweb.org/wiki/index.php?
Title=Python_scripting_tutorial 

• Le hub wiki de script Python: http://www.freecadweb.org/wiki/index.php?Title=Power_users_hub 

1-4-2 Création et manipulation de la géométrie
Dans les chapitres précédents, nous avons appris les différents ateliers de FreeCAD, et que chacun d'entre 
eux met en œuvre ses propres outils et types de géométrie. Les mêmes concepts s'appliquent lorsque vous 
travaillez à partir du code Python.

Nous avons également vu que la grande majorité des ateliers de FreeCAD dépendent d'un atelier très 
fondamental : l’atelier Part (Part Workbench). En fait, d'autres ateliers, tels que Draft ou Arch, font exactement 
ce que nous allons faire dans ce chapitre : ils utilisent le code Python pour créer et manipuler la géométrie 
Part.

Donc, la première chose que nous devons faire pour travailler avec la géométrie des pièces, c'est de faire 
l’équivalent en Python à la connexion vers l’atelier Part : importer le module Part :

import Part

Prenez une minute pour explorer le contenu du module Part, en tapant Part. Et la navigation à travers les 
différentes méthodes proposées ici. Le module Part offre plusieurs fonctions commodes telles que makeBox, 
makeCircle, etc ... qui vont créer un objet pour vous instantanément. Essayez ceci, par exemple :

Part.makeBox (3,5,7)

Lorsque vous appuyez sur Entrée après avoir tapé la ligne ci-dessus, rien n'apparaîtra dans la vue 3D, mais 
quelque chose comme ça sera imprimé dans la console Python  :

<Solid object at 0x5f43600>

C'est là qu'un concept important intervient. Ce que nous avons créé ici est une forme de pièce. Ce n'est pas 
un document objet de FreeCAD (pas encore). Dans FreeCAD, les objets et leur géométrie sont indépendants. 
Pensez à un document objet de FreeCAD en tant que conteneur, qui accueillera une forme. Les objets 
paramétriques auront également des propriétés telles que Longueur et Largeur et recalculeront leur forme à la
volée, chaque fois que l'une des propriétés change. Ce que nous avons fait ici est de calculer une forme 
manuellement.

Nous pouvons maintenant créer facilement un document objet "générique" dans le document actuel (assurez-
vous que vous avez au moins un nouveau document ouvert), et donnez-lui une forme de boîte comme nous 
venons de le faire :
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boxShape = Part.makeBox(3,5,7)
myObj = FreeCAD.ActiveDocument.addObject("Part::Feature","MyNewBox")
myObj.Shape = boxShape
FreeCAD.ActiveDocument.recompute()

Notez comment nous avons traité myObj.Shape, voyez que cela se fait exactement comme nous l'avons fait 
dans le chapitre précédent, lorsque nous avons changé d'autres propriétés d'un objet, comme 

box.Height=5. En réalité, Shape est également une propriété, tout comme Hauteur. Seulement il faut une 

forme de Part (Part Shape), pas un nombre. Au prochain chapitre, nous examinerons plus en profondeur la 
façon dont ces objets paramétriques sont construits.

Pour l'instant, explorons nos formes de pièces plus en détail. À la fin du chapitre à propos de la modélisation 
traditionnelle avec l’atelier Part nous avons montré un tableau qui explique comment les formes sont 
construites dans Part ainsi que leurs différents composants (sommets, arêtes, faces, etc.). Les mêmes 
composants existent ici et peuvent être récupérés à partir de Python. Toute forme de Part a toujours les 
attributs suivants : sommets, arêtes, lignes, faces, coquilles et solides. Tous constituent des listes, qui peuvent
contenir n'importe quel nombre d'éléments ou être vides :

print(boxShape.Vertexes)
print(boxShape.Edges)
print(boxShape.Wires)
print(boxShape.Faces)
print(boxShape.Shells)
print(boxShape.Solids)

Par exemple, découvrons la zone de chaque face de notre forme de boîte ci-dessus :

for f in boxShape.Faces:
print(f.Area)

Ou, pour chaque arête, son point de départ et son point final :

for e in boxShape.Edges:
print("New edge")
print("Start point:")
print(e.Vertexes[0].Point)
print("End point:")
print(e.Vertexes[1].Point)

Comme vous le voyez, si notre boxShape a un attribut "Vertexes", chaque Edge de la BoxShape a également 
un attribut "Vertexes". Comme nous pouvons nous y attendre, le BoxShape aura 8 sommets (Vertexes), tandis
que l’arête en aura seulement 2, qui font partie de la liste des 8.

Nous pouvons toujours vérifier quel est le type de forme :

print(boxShape.ShapeType)
print(boxShape.Faces[0].ShapeType)
print(boxShape.Vertexes[2].ShapeType)

Donc, pour reprendre tout le diagramme des Formes Part : Tout commence par Vertices (sommets). Avec un 
ou deux sommets, vous formez un Edge (arête) (les cercles complets n'ont qu'un seul sommet). Avec une ou 
plusieurs arêtes, vous formez une ligne composite (wire). Avec une ou plusieurs lignes fermées, vous formez 
une face (les lignes supplémentaires deviennent des «trous» dans la face). Avec une ou plusieurs Faces, vous
créez une coquille (Shell). Quand une coquille est entièrement fermée (étanche), vous pouvez former un 
solide. Et enfin, vous pouvez joindre n'importe quel nombre de Formes (Shapes) de tous types ensemble, ce 
qui s'appelle alors un Composé (Compound).
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Nous pouvons maintenant essayer de créer des formes complexes à partir de zéro, en construisant tous leurs 
composants un par un. Par exemple, essayons de créer un volume comme celui-ci :

Nous commencerons par créer une forme planaire comme celle-ci :

D'abord, créons les quatre points de base :

V1 = FreeCAD.Vector(0,10,0)
V2 = FreeCAD.Vector(30,10,0)
V3 = FreeCAD.Vector(30,-10,0)
V4 = FreeCAD.Vector(0,-10,0)

Ensuite, nous pouvons créer les deux segments de droites :

L1 = Part.Line(V1,V2)
L2 = Part.Line(V4,V3)

Notez-vous que nous n'avons pas eu besoin de créer Vertices ? Nous pourrions immédiatement créer 
Parts.Lines à partir des Vecteurs FreeCAD. C'est parce que nous n'avons pas encore créé Edges. 
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Un Part.Line (aussi bien que Part.Circle, Part.Arc, Part.Ellipse ou Part.BSpline) ne crée pas un Edge, mais 
plutôt une géométrie de base sur laquelle un Edge sera créé. Les arêtes (Edges) sont toujours fabriquées à 
partir d'une telle géométrie de base, qui est dénommée son attribut Curve. Donc, si vous avez un Edge, faire :

print(Edge.Curve)

vous montrera de quel type de Edge il s’agit, c'est-à-dire s'il est basé sur une ligne, un arc, etc. Mais revenons
à notre exercice et construisons les segments d'arc. Pour cela, nous aurons besoin d'un troisième point, afin 
que nous puissions utiliser le commode Part.Arc, qui prend 3 points :

VC1 = FreeCAD.Vector(-10,0,0)
C1 = Part.Arc(V1,VC1,V4)
VC2 = FreeCAD.Vector(40,0,0)
C2 = Part.Arc(V2,VC2,V3)

Maintenant, nous avons 2 lignes (L1 et L2) et 2 arcs (C1 et C2). Nous devons les transformer en arêtes 
(edges) :

E1 = Part.Edge(L1)
E2 = Part.Edge(L2)
E3 = Part.Edge(C1)
E4 = Part.Edge(C2)

Alternativement, les géométries de base ont également une fonction toShape() qui fait exactement la même 
chose :

E1 = L1.toShape()
E2 = L2.toShape()
...

Une fois que nous avons une série d’arêtes (Edges), nous pouvons maintenant former une ligne composite 
(Wire), en lui donnant une liste d’arêtes (Edges). Nous n’avons pas besoin de prendre soin de l’ordre.

OpenCasCade, le "moteur" géométrique de FreeCAD, est extraordinairement tolérant à la géométrie non 
ordonnée. Il saura ce qu'il faut faire :

W = Part.Wire([E1,E2,E3,E4])

Et nous pouvons vérifier si notre Wire (ligne composite) a été correctement compris, et qu'il est correctement 
fermé :

print( W.isClosed() )

Ce qui imprimera "True" ou "False". Pour faire une Face, nous avons besoin de lignes composites fermées 
(Wires), donc c'est toujours une bonne idée de vérifier cela avant de créer la Face. Maintenant, nous pouvons 
créer une Face, en lui donnant une seule ligne composite (Wire) (ou une liste de lignes composites si nous 
avons des trous) :

F = Part.Face(W)
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Ensuite, nous l'extrudons :

P = F.extrude(FreeCAD.Vector(0,0,10))

Notez que P est déjà un solide :

print(P.ShapeType)

Parce que lors de l'extrusion d'une seule Face, nous obtenons toujours un solide. Ce ne serait pas le cas, par 
exemple, si nous avions extrudé la ligne composite suivante (Wire) à la place :

S = W.extrude(FreeCAD.Vector(0,0,10))
print(s.ShapeType)

Ce qui, bien sûr, nous donnera une coquille creuse, les faces supérieure et inférieure manquant.

Maintenant que nous avons notre forme définitive, nous sommes impatients de la voir à l'écran ! Alors, créons 
un objet générique, et attribuons le à notre nouveau Solid :

myObj2 = FreeCAD.ActiveDocument.addObject("Part::Feature","My_Strange_Solid")
myObj2.Shape = P
FreeCAD.ActiveDocument.recompute()

Alternativement, le module Part fournit également un raccourci qui fait l'opération ci-dessus plus rapidement 
(mais vous ne pouvez pas choisir le nom de l'objet) :

Part.show(P)

Tout ce qui précède, et bien plus encore, est expliqué en détail sur la page Part Scripting, en même temps que
des exemples.

Lire plus d'informations :

L’atelier Part: http://www.freecadweb.org/wiki/index.php?title=Part_atelier 

Programmation dans Part: http://www.freecadweb.org/wiki/index.php?Title=Topological_data_scripting 
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1-4-3 Création d'objets paramétriques
Dans le chapitre précédent, nous avons vu comment créer la géométrie Part et comment l'afficher sur l’écran, 
en l'attachant à un objet de document "dumb" (non paramétrique). C'est fastidieux quand nous voulons 
changer la forme de cet objet. Nous devrions créer une nouvelle forme, puis l’attribuer à nouveau à notre 
objet.

Cependant, nous avons également vu dans tous les chapitres précédents de ce manuel comment les objets 
paramétriques sont puissants. Il suffit de changer une propriété, et la forme est recalculée à la volée.

En interne, les objets paramétriques ne font rien de différent de ce que nous venons de faire : ils recalculent le
contenu de leur propriété Shape, à plusieurs reprises, chaque fois qu'une autre propriété a été modifiée.

FreeCAD fournit un système très pratique pour créer de tels objets paramétriques complètement en Python. 
Ils consistent en une classe Python simple, qui définit toutes les propriétés dont l'objet a besoin, et ce qui se 
passera quand une de ces propriétés changera. La structure de l'objet paramétrique est aussi simple que 
ceci :

class myParametricObject:
def __init__(self,obj):

obj.Proxy = self
obj.addProperty("App::PropertyFloat","MyLength")
...

def execute(self,obj):
print ("Recalculating the shape...")
print ("The value of MyLength is:")
print (obj.MyLength)
...

Toutes les classes Python ont généralement une méthode d'initialisation (__init__ method). Ce qui est à 
l'intérieur de cette méthode est exécuté lorsque cette classe est instanciée (ce qui signifie, en argot de 
programmation, qu'un objet Python est créé à partir de cette classe. Comprenez une classe comme un 
"modèle" pour en créer des copies en direct). Ici dans notre fonction d'initialisation (__init__ function), nous 
faisons deux choses importantes : 1- stocker notre classe elle-même dans l'attribut "Proxy" de notre document
objet FreeCAD, c'est-à-dire que le document objet de FreeCAD portera ce code en lui-même, et 2- créer 
toutes les propriétés dont notre objet a besoin. Il existe de nombreux types de propriétés disponibles, vous 
pouvez obtenir la liste complète en tapant ce code :

FreeCAD.ActiveDocument.addObject("Part::FeaturePython","dummy").supportedProperties()

Ensuite, la deuxième partie importante est la méthode d'exécution. Tout code dans cette méthode sera 
exécuté lorsque l'objet est marqué pour être recalculé, ce qui se produira lorsqu'une propriété a été modifiée. 
C'est tout ce qu'il y a à faire. Dans l'exécution, vous devez faire tout ce qui doit être fait, c'est-à-dire calculer 

une nouvelle forme, et attribuer à l'objet lui-même quelque chose comme obj.Shape = myNewShape. C'est 

pourquoi la méthode d'exécution prend un argument "obj" qui sera l'objet du document FreeCAD lui-même, 
afin que nous puissions le manipuler dans notre code python.

Une dernière chose est importante à retenir : lorsque vous créez de tels objets paramétriques dans un 
document FreeCAD, lorsque vous enregistrez le fichier, le code python ci-dessus n'est pas stocké dans le 
fichier. C'est pour des raisons de sécurité, si un fichier FreeCAD contenait un code, n’importe qui pourrait 
distribuer des fichiers FreeCAD contenant des codes malveillants qui pourraient nuire à d'autres personnes les
utilisant sur leurs ordinateurs. Donc, si vous distribuez un fichier contenant des objets fabriqués avec ce qui 
précède, ce code doit également être présent sur l'ordinateur qui ouvrira le fichier. La manière la plus simple 
de faire est généralement de sauvegarder le code ci-dessus dans une macro et de distribuer la macro avec 
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votre fichier FreeCAD ou de partager votre macro sur le dépôt de macros FreeCAD (FreeCAD macros 
repository) où n'importe qui peut la télécharger.

Ci-dessous, nous ferons un petit exercice, en construisant un objet paramétrique qui est une simple Face 
rectangulaire paramétrique. Des exemples plus complexes sont disponibles sur Exemple d'objet paramétrique 
(parametric object example) et dans le code source de FreeCAD lui-même (FreeCAD source code).

Nous allons donner à notre objet deux propriétés : Longueur et Largeur, que nous utiliserons pour construire 
un rectangle. Puis, puisque notre objet aura déjà une propriété de placement prédéfinie (tout objet 
géométrique en a une par défaut, il n'est pas nécessaire de l'ajouter nous-mêmes), nous décalerons notre 
rectangle à l'emplacement / orientation définis dans le Placement, de sorte que l'utilisateur pourra déplacer le 
rectangle n'importe où en éditant la propriété Placement.
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class ParametricRectangle:
def __init__(self,obj):

obj.Proxy = self
obj.addProperty("App::PropertyFloat","Length")
obj.addProperty("App::PropertyFloat","Width")

def execute(self,obj):
# we need to import the FreeCAD module here too, because we might be 

running out of the Console
# (in a macro, for example) where the FreeCAD module has not been imported 
automatically

import Part,FreeCAD
# first we need to make sure the values of Length and Width are not 0
# otherwise the Part.Line will complain that both points are equal
if (obj.Length == 0) or (obj.Width == 0):

# if yes, exit this method without doing anything
return

# we create 4 points for the 4 corners
v1 = FreeCAD.Vector(0,0,0)
v2 = FreeCAD.Vector(obj.Length,0,0)
v3 = FreeCAD.Vector(obj.Length,obj.Width,0)
v4 = FreeCAD.Vector(0,obj.Width,0)

# we create 4 edges
e1 = Part.Line(v1,v2).toShape()
e2 = Part.Line(v2,v3).toShape()
e3 = Part.Line(v3,v4).toShape()
e4 = Part.Line(v4,v1).toShape()

# we create a wire
w = Part.Wire([e1,e2,e3,e4])

# we create a face
f = Part.Face(w)

# All shapes have a Placement too. We give our shape the value of the 
placement

# set by the user. This will move/rotate the face automatically.
f.Placement = obj.Placement
# all done, we can attribute our shape to the object!
obj.Shape = f

Au lieu de coller le code ci-dessus dans la console Python, nous devrions plutôt l'enregistrer quelque part, 
alors nous pourrons le réutiliser et le modifier ultérieurement. Par exemple dans une nouvelle macro (menu 
Outils -> Macros → Créer). Nommez-le, par exemple, "ParamRectangle". Cependant, les macros FreeCAD 
sont enregistrées avec une extension .FCMro, que Python ne reconnaît pas lors de l'importation. Donc, avant 
d’utiliser le code ci-dessus, nous devrons renommer le fichier ParamRectangle.FCMacro en 
ParamRectangle.py. Cela se fait simplement à partir de votre explorateur de fichiers, en naviguant vers le 
dossier Macros indiqué dans le menu Outils -> Macros.

Une fois cela fait, nous pouvons maintenant l’utiliser dans la console Python :

import ParamRectangle

En explorant le contenu de ParamRectangle, nous pouvons vérifier qu'il contient notre Classe 
ParametricRectangle.
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Pour créer un nouvel objet paramétrique à l'aide de notre classe ParametricRectangle, nous utiliserons le 
code suivant. Observez que nous utilisons Part::FeaturePython au lieu de Part::Feature que nous avons utilisé
dans les chapitres précédents (la version Python permet de définir notre propre comportement paramétrique):

myObj = FreeCAD.ActiveDocument.addObject("Part::FeaturePython","Rectangle")
ParamRectangle.ParametricRectangle(myObj)
myObj.ViewObject.Proxy = 0 # this is mandatory unless we code the ViewProvider too
FreeCAD.ActiveDocument.recompute()

Rien ne s'affiche encore à l'écran, car les propriétés Longueur et Largeur sont à 0, ce qui déclenchera notre 
condition de "ne rien faire" à l'intérieur de l'exécution. Nous devons juste changer les valeurs de Longueur et 
Largeur, et notre objet apparaîtra magiquement et sera recalculé à la volée.

Bien sûr, il serait fastidieux de devoir taper ces 4 lignes de code Python chaque fois que nous voulons créer 
un nouveau rectangle paramétrique. Une façon très simple de résoudre ceci est de placer les 4 lignes ci-
dessus dans notre fichier ParamRectangle.py, à la fin, après la fin de la classe ParametricRectange (nous 
pouvons le faire à partir de l'éditeur Macro).

Maintenant, lorsque nous tapons import ParamRectangle, un nouveau rectangle paramétrique sera 
automatiquement créé. Encore mieux, nous pouvons ajouter un bouton de barre d'outils qui fera exactement 
cela :

• Ouvrir le menu Outils -> Personnaliser

• Sous l'onglet "Macros", sélectionnez notre macro ParamRectangle.py, complétez les détails au fur et à 
mesure que vous le souhaitez, et appuyez sur "Ajouter":

• Sous l'onglet Barres d'outils, créez une nouvelle barre d'outils personnalisée dans l'atelier de votre 
choix (ou globalement), sélectionnez votre macro et ajoutez-la à la barre d'outils :
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• Nous avons maintenant un nouveau bouton de barre d'outils qui, lorsqu'il sera cliqué, créera un 
rectangle paramétrique.

Rappelez-vous, si vous souhaitez distribuer des fichiers créés avec ce nouvel outil à d'autres personnes, ils 
doivent avoir également installé la macro ParamRectangle.py sur leur ordinateur.

Lire plus d'informations

• Le dépôt de macros FreeCAD: http://www.freecadweb.org/wiki/index.php?Title=Macros_recipes 

• Exemple d'objet paramétrique: http://www.freecadweb.org/wiki/index.php?Title=Scripted_objects 

• Plus d'exemples dans le code FreeCAD: 
Https://github.com/FreeCAD/FreeCAD/blob/master/src/Mod/TemplatePyMod/FeaturePyt  h  on.py 
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1-4-4 Création d'outils d'interface
Dans les deux derniers chapitres, nous avons vu comment créer la géométrie Part et créer des objets 
paramétriques. Une dernière pièce manque pour avoir un contrôle total sur FreeCAD : Créer des outils qui 
interagiront avec l'utilisateur.

Dans de nombreuses situations, il n'est pas très convivial de construire un objet avec des valeurs nulles, 
comme nous avons fait avec le rectangle dans le chapitre précédent, puis de demander à l'utilisateur de 
remplir la hauteur et la largeur dans le panneau Propriétés. Cela fonctionne pour un très petit nombre d'objets,
mais devient très fastidieux si vous avez beaucoup de rectangles à réaliser. Une meilleure façon serait d'être 
capable de donner déjà la hauteur et la largeur lors de la création du rectangle.

Python offre un outil de base permettant à l'utilisateur de saisir du texte à l'écran :

text = raw_input("Height of the rectangle?")
print("The entered height is ",text)

Cependant, cela nécessite une console Python en cours d'exécution et, lors de l'exécution de notre code à 
partir d'une macro, nous ne sommes pas toujours sûrs que la console Python sera activée sur la machine de 
l'utilisateur.

L'interface utilisateur graphique (Graphical User Interface), ou GUI, c'est-à-dire toute la partie de FreeCAD qui 
s'affiche sur votre écran (le menu, les barres d'outils, la vue 3D, etc.) est tout à cette fin : interagir avec 
l’utilisateur. L'interface de FreeCAD est construite avec Qt, une trousse d'outils GUI open source très 
commune qui qffre une large gamme d'outils tels que les boîtes de dialogue, les boutons, les étiquettes, les 
boîtes de saisie de texte ou les menus déroulants (tout cela est généralement appelé "widgets").

Les outils Qt sont très faciles à utiliser depuis Python, grâce à un module Python appelé Pyside (Il existe aussi
plusieurs autres modules Python pour communiquer avec Qt depuis Python). Ce module vous permet de créer
et d'interagir avec des widgets, lire ce que l'utilisateur a fait avec eux (ce qui a été rempli dans des zones de 
texte) ou faire des choses quand, par exemple, un bouton a été pressé.

Qt fournit également un autre outil intéressant appelé Qt Designer, aujourd'hui incorporé à l'intérieur d’une 
plus grande application appelée Qt Creator. Il permet de concevoir des boîtes de dialogue et des panneaux 
d'interface graphiquement, au lieu d'avoir à les coder manuellement. Dans ce chapitre, nous utiliserons Qt 
Creator pour dessiner un widget de panneau que nous utiliserons dans le panneau des tâches de FreeCAD. 
Donc, vous devrez télécharger et installer Qt Creator à partir de sa page officielle si vous êtes sur Windows ou
Mac (sur Linux, il sera généralement disponible auprès de votre application de gestionnaire de logiciels).

Dans l'exercice suivant, nous allons d'abord créer un panneau avec Qt Creator qui demande les valeurs de 
longueur, de largeur et de hauteur, alors nous allons créer une classe Python autour de lui, qui lira les valeurs 
entrées par l'utilisateur à partir du panneau, et créer une boîte avec les dimensions données. Cette classe 
Python sera ensuite utilisée par FreeCAD pour afficher et contrôler le panneau des tâches :
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Commençons par créer le widget. Démarrez Qt Creator, puis menu Fichier -> Nouveau fichier ou projet 
->Fichiers et classes -> Qt -> Formulaire Qt Designer -> Boîte de dialogue sans boutons. Cliquez sur 
Suivant, donnez lui un nom de fichier pour l’enregistrer, cliquez sur Suivant, laissez tous les champs de projet
à leur valeur par défaut ("") et Créer. Le système de tâches de FreeCAD ajoutera automatiquement les 
boutons OK / Annuler, c'est pourquoi nous avons choisi ici une boîte de dialogue sans boutons.

• Trouvez le Label (étiquette) dans la liste du panneau de gauche et faites-le glisser sur le canevas de 
notre widget. Double-cliquez sur l'étiquette récemment placée, et modifiez son texte en Longueur.

• Cliquez avec le bouton droit de la souris sur la toile du widget, puis choisissez Lay out-> Lay out in a 
Grid. Cela mettra notre widget dans une grille avec actuellement une seule cellule, occupée par notre 
première étiquette. Nous pouvons maintenant ajouter les éléments suivants à gauche, à droite, en haut
ou en bas de notre première étiquette, et la grille s’étendra automatiquement.

• Ajoutez deux autres étiquettes en dessous de la première et modifiez leur texte en Largeur et Hauteur :
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• Maintenant, placez 3 widgets Double Spin Box à côté de nos étiquettes Longueur, Largeur et 
Hauteur. Pour chacun d'entre eux, dans le panneau inférieur gauche, qui affiche tous les paramètres 
disponibles pour le Widget sélectionné, localisez Suffix et définissez leur suffixe en mm. FreeCAD a 
un Widget plus avancé, qui peut gérer différentes unités, mais cela n'est pas disponible dans Qt 
Creator par défaut (mais peut être compilé (compiled)), alors, pour l'instant, nous utiliserons une 
Double Spin Box standard, et nous ajouterons le suffixe "mm" pour nous assurer que l'utilisateur sait 
dans quelle unité ils fonctionnent :

• Maintenant, notre widget est terminé, il suffit de nous assurer d'une dernière chose. Étant donné que 
FreeCAD devra accéder à ce widget et lire les valeurs Longueur, Largeur et Hauteur, nous devons 
donner les noms appropriés à ces widgets, afin que nous puissions les récupérer facilement dans 
FreeCAD. Cliquez sur chacune des boîtes Double Spin, et dans la fenêtre supérieure droite, double-
cliquez sur leur nom d'objet, et modifiez-les par quelque chose de facile à retenir, par exemple : 
BoxLength, BoxWidth et BoxHeight :
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• Enregistrez le fichier, vous pouvez maintenant fermer Qt Creator, le reste se fera dans Python.

• Ouvrez FreeCAD et créez une nouvelle macro dans le menu Macro -> Macros -> Créer

• Collez le code suivant. Assurez-vous de modifier le chemin du fichier pour correspondre à l'endroit où 
vous avez enregistré le fichier .ui créé dans QtCreator :

import FreeCAD,FreeCADGui,Part

# CHANGE THE LINE BELOW
path_to_ui = "C:\Users\yorik\Documents\dialog.ui"

class BoxTaskPanel:
def __init__(self):

# this will create a Qt widget from our ui file
self.form = FreeCADGui.PySideUic.loadUi(path_to_ui)

def accept(self):
length = self.form.BoxLength.value()
width = self.form.BoxWidth.value()
height = self.form.BoxHeight.value()
if (length == 0) or (width == 0) or (height == 0):

print("Error! None of the values can be 0!")
# we bail out without doing anything
return

box = Part.makeBox(length,width,height)
Part.show(box)
FreeCADGui.Control.closeDialog()

panel = BoxTaskPanel()
FreeCADGui.Control.showDialog(panel)

Dans le code ci-dessus, nous avons utilisé une fonction commode (PySideUic.loadUi) à partir du module 
FreeCADGui. Cette fonction charge un fichier .ui, crée un widget Qt à partir de celui-ci et écrit les noms, afin 
que nous puissions accéder facilement au sous-espace par leurs noms (ex: self.form.BoxLength).
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La fonction "accepter" est également une commodité offerte par Qt. Lorsqu'il existe un bouton "OK" dans une 
boîte de dialogue (ce qui est le cas par défaut lors de l'utilisation du panneau des Tâches FreeCAD), toute 
fonction appelée "accepter" sera automatiquement exécutée lorsque vous appuyez sur le bouton "OK". De 
même, vous pouvez également ajouter une fonction de "rejet" qui s'exécute lorsque vous appuyez sur le 
bouton "Annuler". Dans notre cas, nous avons supprimé cette fonction, alors appuyer sur "Annuler" 
provoquera le comportement par défaut (ne rien faire et fermer la boîte de dialogue).

Si nous implémentons une des fonctions d'acceptation ou de rejet, leur comportement par défaut (ne rien faire 
et fermer) ne se produira plus. Nous devons donc fermer le panneau de tâches nous-mêmes. Cela se fait 
avec :

FreeCADGui.Control.closeDialog()

Une fois que nous avons notre BoxTaskPanel qui a 1) un widget appelé "self.form" et 2) si nécessaire, les 
fonctions Accepter et Rejeter, nous pouvons ouvrir le panneau de tâches avec lui, ce qui est fait avec ces deux
dernières lignes :

panel = BoxTaskPanel()
FreeCADGui.Control.showDialog(panel)

Notez que le widget créé par PySideUic.loadUi n'est pas spécifique à FreeCAD, c'est un widget Qt standard 
qui peut être utilisé avec d'autres outils Qt. Par exemple, nous aurions pu afficher une boîte de dialogue 
distincte. Essayez ceci dans la console Python de FreeCAD (en utilisant le chemin correct pour votre fichier .ui
bien sûr) :

from PySide import QtGui
w = FreeCADGui.PySideUic.loadUi("C:\Users\yorik\Documents\dialog.ui")
w.show()

Bien sûr, nous n'avons ajouté aucun bouton "OK" ou "Annuler" à notre boîte de dialogue, car il a été fait pour 
être utilisé à partir du panneau de tâches FreeCAD, qui fournit déjà de tels boutons. Il n'y a donc aucun moyen
de fermer la boîte de dialogue (autrement que de presser son bouton Fermer la fenêtre). Mais la fonction 
show () crée une boîte de dialogue non modale, ce qui signifie qu'elle ne bloque pas le reste de l'interface. 
Ainsi, alors que notre dialogue est toujours ouvert, nous pouvons lire les valeurs des champs :

w.BoxHeight.value()

Ceci est très utile pour les tests.

Enfin, n'oubliez pas qu'il existe beaucoup plus de documentation sur l'utilisation des widgets Qt dans le Wiki 
FreeCAD, dans la section Python Scripting, qui contient un didacticiel de création de dialogue (dialog creation 
tutorial), un tutoriel spécial en 3 parties de PySide (PySide tutorial) qui couvre le sujet en profondeur.

Lire plus d'informations

• Qt Creator: https://en.wikipedia.org/wiki/Qt_Creator 

• Installation de Qt Creator: https://www.qt.io/ide/

• Documentation sur la programmation Python: http://www.freecadweb.org/wiki/index.php?
Title=Power_users_hub 

• Didacticiel de création de boîte de dialogue: http://www.freecadweb.org/wiki/index.php?
t  itle=Dialog_creation 

• Didacticiels PySide: http://www.freecadweb.org/wiki/index.php?title=PySide 

• Documentation PySide: http://srinikom.github.io/pyside-docs/index.html
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1-5 La communauté
Aucun manuel concernant les logiciels gratuits et open-source ne serait complet sans un chapitre sur la 
communauté. Comme la grande majorité des logiciels gratuits et open source, FreeCAD est créé par une 
communauté et maintenu par cette communauté. Au lieu de l'entreprise opaque, inconnue, impersonnelle et 
inaccessible qui est plus que souvent trouvée derrière les logiciels commerciaux, les communautés de 
logiciels libres et open-source sont des espaces ouverts, où vous en tant qu'utilisateur êtes le bienvenu et où 
vous pouvez obtenir des réponses très rapidement et même vous exprimer dans le développement du logiciel 
lui-même. Vous êtes également plus que bienvenu pour nous aider, il existe des tâches pour tous.

La communauté est un groupe croissant et éclectique de toutes sortes de personnes unies par leur passion 
pour FreeCAD. Tous travaillent sur FreeCAD volontairement, pendant leur temps libre (bien que parfois des 
entreprises ou des individus se rassemblent pour payer quelques heures de programmation à un développeur 
pour mettre en œuvre une fonction spécifique). Certains sont des programmeurs professionnels, certains sont 
des utilisateurs de FreeCAD de longue date (certains d'entre eux sont de vrais gourous FreeCAD, qui 
connaissent presque tout, et beaucoup d'entre eux finissent par connaître beaucoup de programmation 
FreeCAD) et beaucoup sont de nouveaux utilisateurs de FreeCAD.

Il n'y a rien à faire pour faire partie de la communauté. Utilisez simplement FreeCAD !

Le principal endroit où la communauté se rencontre et discute est le forum FreeCAD. Tout ce que vous devez 
faire pour participer aux discussions est d'enregistrer un compte sur le forum (votre premier post devra être 
approuvé par un modérateur avant de poster plus, afin d'éviter tout spam). Le forum est un excellent endroit 
pour poser des questions lorsque vous êtes nouveau sur FreeCAD. Si vous avez posé une bonne question 
(assurez-vous de lire les règles du forum car elles contiennent des informations utiles pour transformer votre 
question en une bonne question), vous recevrez habituellement plusieurs réponses dans la même heure. Si 
vous pensez que quelqu'un a déjà posé votre question, n'oubliez pas de rechercher, votre réponse pourrait 
déjà être là.

Le forum est également un excellent endroit pour montrer ce que vous avez réalisé avec FreeCAD, pour aider 
les nouveaux arrivants lorsque vous avez plus d'expérience et pour suivre vos opinions dans des discussions 
plus techniques sur le développement. Tout le développement de FreeCAD (FreeCAD development) est 
discuté sur le forum, et n'importe qui est libre de lire ou de participer.

Il existe également des communautés FreeCAD qui se forment en dehors du forum FreeCAD, par exemple 
sur Facebook ou Google+.

Si vous devenez aussi enthousiaste à propos de FreeCAD que nous le sommes, vous voudrez peut-être aider
le projet. Cela peut se faire de différentes façons, et il existe des tâches pour tous, les programmeurs et les 
non-programmeurs, par exemple :

• Aidez à diffuser le mot : Beaucoup de gens bénéficieraient énormément de l'utilisation d'un modeleur 
3D open source gratuit, comme FreeCAD, mais ne connaissent tout simplement pas son existence. 
Publiez le travail que vous faites avec FreeCAD, parlez-en sur les réseaux sociaux, etc. ... aidez ces 
personnes à découvrir FreeCAD.

• Aidez les nouveaux arrivants : la grande majorité des discussions sur le forum sont des questions 
posées par les nouveaux utilisateurs. Vous pourriez connaître de bonnes réponses à leur donner.

• Aidez à signaler les bugs : la stabilité de FreeCAD provient en grande partie de la correction de 
bogues. Étant donné qu'il n'est pas possible pour les développeurs de FreeCAD de tester tous les cas 
d'utilisation possibles, il est important que les utilisateurs signalent des problèmes lorsqu'ils les 

06/06/17 Manuel_Freecad.odt Page 165 / 166

https://plus.google.com/u/0/communities/103183769032333474646
https://www.facebook.com/FreeCAD
http://forum.freecadweb.org/
http://forum.freecadweb.org/viewforum.php?f=6
http://forum.freecadweb.org/viewtopic.php?f=3&t=2264
http://forum.freecadweb.org/


détectent. Assurez-vous de lire les directives (guidelines) si vous pensez avoir trouvé un bug, puis 
écrivez un rapport sur le suivi des bugs (bug tracker).

• Aidez-nous à écrire de la documentation : Le wiki de la documentation FreeCAD (FreeCAD 
documentation wiki) est également écrit par les membres de la communauté. Certaines sections sont 
encore incomplètes, ou leurs informations sont incorrectes ou obsolètes. Vous pourriez peut-être aider 
à résoudre ce problème. Pour pouvoir travailler sur le wiki, vous devrez vous familiariser avec l'édition 
wiki (wiki editing), et demander la permission (ask permission) de modifier le wiki FreeCAD sur le 
forum.

• Aidez-nous à traduire FreeCAD : la traduction de FreeCAD est effectuée en ligne par les membres de 
la communauté, sur crowdin. Si vous ne voyez pas votre langue, demandez à l'un des administrateurs 
de l'ajouter.

• Aidez-nous à traduire la documentation wiki : chaque page du wiki est traductible et nécessite très peu 
de connaissances sur la syntaxe wiki. Aider à la traduction est également un excellent moyen 
d'apprendre FreeCAD.

• Écrire des scripts et des macros : FreeCAD a une liste croissante de Macros. Si vous avez écrit des 
fonctionnalités intéressantes, envisagez de le partager.

• Programmation : pour cela, vous devez savoir comment programmer en Python ou C ++ et avoir une 
bonne connaissance de FreeCAD lui-même.

Le code source de FreeCAD est situé sur le compte Github du projet FreeCAD. Toute personne peut 
télécharger, utiliser et modifier le code. Vous pouvez publier vos modifications (sur Github ou tout autre service
d'hébergement Git). Si vous avez apporté des modifications intéressantes, que vous souhaitez voir incluses 
dans le code source FreeCAD, vous devez demander à la communauté de les inclure. Cela peut être fait en 
utilisant le mécanisme de requêtes du Github, mais la meilleure façon est de discuter de ce que vous avez 
l'intention de faire d'abord sur le forum, puis de poster une demande officielle dans la section des requêtes 
(Pull requests) du forum lorsque votre code est prêt. Cela évite que vous travailliez sur quelque chose sur 
lequel quelqu'un d'autre travaille déjà, et assurez-vous que les autres sont d'accord avec votre façon de faire, 
de sorte qu'il n'y ait aucun risque que votre travail soit refusé pour une raison que vous ne prévoyiez pas.

Nous espérons que nous avons réussi à vous donner un bon aperçu de FreeCAD dans ce manuel, et vous 
êtes déjà notre plus récent membre de la communauté. Bienvenue !

Lire plus d’informations

• Le forum FreeCAD: http://forum.freecadweb.org

• Le code source de FreeCAD: https://github.com/FreeCAD/FreeCAD 

• La communauté Facebook FreeCAD: https://www.facebook.com/FreeCAD 

• La communauté Google + FreeCAD: 
Https://plus.google.com/u/0/communities/103183769032333474646 

• Le wiki de documentation FreeCAD: http://www.freecadweb.org/wiki 

• Traduction de FreeCAD sur crowdin: https://crowdin.com/project/freecad 

• Le tracker des bugs FreeCAD: http://www.freecadweb.org/tracker 
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